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Technical Support
Symantec Technical Support maintains support centers globally. Technical Support’s
primary role is to respond to specific queries about product features and functionality.
The Technical Support group also creates content for our online Knowledge Base.
The Technical Support group works collaboratively with the other functional areas
within Symantec to answer your questions in a timely fashion. For example, the
Technical Support group works with Product Engineering and Symantec Security
Response to provide alerting services and virus definition updates.

Symantec’s support offerings include the following:

■ A range of support options that give you the flexibility to select the right amount
of service for any size organization

■ Telephone and/or Web-based support that provides rapid response and
up-to-the-minute information

■ Upgrade assurance that delivers software upgrades

■ Global support purchased on a regional business hours or 24 hours a day, 7
days a week basis

■ Premium service offerings that include Account Management Services

For information about Symantec’s support offerings, you can visit our website at
the following URL:

www.symantec.com/business/support/

All support services will be delivered in accordance with your support agreement
and the then-current enterprise technical support policy.

Contacting Technical Support
Customers with a current support agreement may access Technical Support
information at the following URL:

www.symantec.com/business/support/

Before contacting Technical Support, make sure you have satisfied the system
requirements that are listed in your product documentation. Also, you should be at
the computer on which the problem occurred, in case it is necessary to replicate
the problem.

When you contact Technical Support, please have the following information
available:

■ Product release level

■ Hardware information



■ Available memory, disk space, and NIC information

■ Operating system

■ Version and patch level

■ Network topology

■ Router, gateway, and IP address information

■ Problem description:

■ Error messages and log files

■ Troubleshooting that was performed before contacting Symantec

■ Recent software configuration changes and network changes

Licensing and registration
If your Symantec product requires registration or a license key, access our technical
support Web page at the following URL:

www.symantec.com/business/support/

Customer service
Customer service information is available at the following URL:

www.symantec.com/business/support/

Customer Service is available to assist with non-technical questions, such as the
following types of issues:

■ Questions regarding product licensing or serialization

■ Product registration updates, such as address or name changes

■ General product information (features, language availability, local dealers)

■ Latest information about product updates and upgrades

■ Information about upgrade assurance and support contracts

■ Information about the Symantec Buying Programs

■ Advice about Symantec's technical support options

■ Nontechnical presales questions

■ Issues that are related to CD-ROMs, DVDs, or manuals



Support agreement resources
If you want to contact Symantec regarding an existing support agreement, please
contact the support agreement administration team for your region as follows:

customercare_apj@symantec.comAsia-Pacific and Japan

semea@symantec.comEurope, Middle-East, and Africa

supportsolutions@symantec.comNorth America and Latin America
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Symantec DeployCenter 1

Introduction

What is Symantec DeployCenter?

Symantec™ DeployCenter helps you deploy an exact image of a hard disk and manage 
multiple workstation images. Small to enterprise organizations use DeployCenter to:   

• Deploy or upgrade Windows workstations

• Create a standard, customized work environment for faster deployment of new 
computers 

• Easily introduce new systems to the network 

What’s on the DeployCenter CD?

• ImageCenter—Lets you create and restore image files and copy information from an 
existing disk to a new one during a hardware upgrade. The executable is 
PQIMGCTR.EXE. See Chapters 2, 4, 5, 11, and 12.

• Boot Disk Builder—Wizard interface that allows you to create boot disks, including 
virtual floppy disks, for connecting to a network, PowerCast server, or Unicast server, 
or to run ImageCenter without network connectivity. The executable is 
PQBDB32.EXE (in the Bdbuild folder). See Chapter 3.

• PowerCasting—Lets you deploy an image to multiple machines simultaneously. 
There are executables for DOS and Windows PowerCast servers and a DOS 
PowerCast client. See Chapter 6.

• Unicasting—Establishes a Unicast server to which workstations can connect as a 
point-to-point Unicast client to create and deploy images. Unicasting differs from 
multicasting in that it uses a point-to-point transport connection and a specific IP 
address on both the server and client sides instead of sending data using a multicast 
(limited broadcast) IP address. Use Boot Disk Builder to create Unicast client boot 
disks. Unicast Server is only available under Windows NT, Windows 2000, and 
Windows XP. See Chapter 7. 

• PXE Server—Allows assignment of unique PXE boot environments to individual 
clients. Use PXE Configuration Utility on the Start menu to set up the PXE server. 
PXE Server is only available under Windows NT, Windows 2000, and Windows XP. 
See Chapter 9. 
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• ImageExplorer—Lets you create and copy image files, copy partitions within image 
files, compress/uncompress partitions, and restore individual files from images. The 
executable is PQIEXP32.EXE. See Chapter 8 of this user guide and the 
ImageExplorer online help.

• DeployPrep—Aids in the use of Microsoft SysPrep for deploying images with 
Windows 2000 or Windows XP. It automates the testing of a SysPrep configuration. 
It also adds additional configuration options to Microsoft SysPrep. The executable is 
PQPREP32.EXE. See Appendix A.

• Symantec VF Editor—Enables you to modify virtual floppy files used by 
ImageCenter. See Chapter 6 or Symantec VF Editor online help.

• PARTINFO—Generates a diagnostic report that includes information about your 
hard disk. See Appendix C.

What’s new in Symantec DeployCenter

Symantec DeployCenter has limited Vista support, as follows:

• Symantec DeployCenter Library tools run on WinPE 2.0. Symantec DeployCenter 
Library cannot be installed on Vista, and the tools will not run on Vista. 

• Symantec DeployCenter Library tools can handle the disk layouts as seen by Vista 
disk manager. 

• System restore points that are captured during image creation are removed upon 
image deployment. 

• If a disk signature does not already exist on a target disk, Symantec DeployCenter 
Library tools create a new disk signature for the cloned disk and patch it into the 
registry of mounted devices in Vista. 

• Symantec DeployCenter Library tools support new Vista boot manager configuration 
updates. 

• Symantec DeployCenter Library tools work with non-cylinder aligned partitions. In 
restore operations an image file is restored with the same partition alignment as was 
captured. 

• PQDisk can resize and move Vista partitions. 

• When dealing with transactional NTFS, Symantec DeployCenter Library tools trigger 
the resource manager to reset itself to eliminate all unresolved transactions, if any, 
upon next boot. 
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• Symantec DeployCenter Library tools do not support BitLocker. 

• A Virtual Floppy can be executed on Vista. 

About This Guide

This user guide can help you set up and use Symantec DeployCenter. Symantec 
recommends that you have Adobe® Acrobat® version 4.0 or later for best viewing quality. 
You can download the current version of Acrobat for free from the Adobe web site, 
www.adobe.com. You can click cross-references (including page numbers in the table of 
contents and index) to jump to the relevant material. You can also click references to web 
sites to start your browser and go to the web site. The hand pointer in Acrobat changes to a 
pointing finger when it is located over text that is linked to other material. 

http://www.adobe.com
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Symantec DeployCenter System Requirements

The following are the system requirements for ImageCenter and the supporting 
applications included on the DeployCenter CD. 

*Only ImageCenter and DOS utilities are supported under DOS.

DeployPrep is only supported under Windows 2000 Professional and Windows XP.

Installing DeployCenter

The DeployCenter CD includes installation programs for DeployCenter (including 
ImageCenter, ImageExplorer, and Boot Disk Builder). 

1 Insert the CD into your CD drive.

If CD auto-run is enabled, the installation program automatically launches when you 
place the DeployCenter CD in your CD drive.

2 If the CD auto-run is not enabled, insert the CD, click Start > Run, then type 
drive:\autorun (where drive is the drive letter of your CD drive), then click 
OK. 

3 Click Tools.

4 Click DeployCenter, and follow the on-screen installation instructions.

Hardware/Software Requirement

Processor Pentium or above

RAM 32 MB (Working with large hard disks or partitions may 
require significantly more memory.) 

Diskette drive None; 3.5-inch diskette drive recommended

CD drive Any speed; MMC-2 compliant IDE or SCSI CD-R or 
CD-R/W required for creating images directly to CD

Hard disk free space 52 MB

Operating system Windows 98, Windows NT 4.0, Windows 2000, Windows 
XP, Windows 2003, DOS*

Monitor VGA; SVGA recommended

Pointing device None required; Microsoft mouse recommended
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Installing Removable Device Drivers

During the DeployCenter install, you can install drivers for Iomega and Magneto-Optical 
removable media storage devices.

• To install Iomega drivers, select Iomega drivers during installation.

• To install Magneto-Optical drivers, select Fujitsu ATAPI or SCSI MO drivers.

For specific information on individual device drivers, contact the manufacturer directly. 
For more information on setting up Iomega and Magneto-Optical drivers, see “Setting Up 
Removable Storage Devices” on page 213.

You can also access a document, “Using Drive Image with Iomega Removable Drivers,” 
at the Symantec support web site. Go to http://service.symantec.com, and search for 
“Iomega.” This document is available in English only.

Using Parallel Port Devices with a Network Client

Loading a parallel port device driver with a network client installed may cause the system 
to hang. To successfully load the device driver for a parallel port drive, you must reboot 
the system without loading the network client. You can use the boot diskette set created by 
the install program to do this. For more information on resolving this problem, contact 
your network administrator.

Getting Online Help

1 Click Help > Contents to display general instructions for using ImageCenter Help, or 
press <F1> at any time to access the Help Index.

The Windows applications included with DeployCenter (ImageExplorer, Boot Disk 
Builder, VF Editor, and PowerCast Server) include help systems you can access from the 
Help menu.

Uninstalling DeployCenter

1 Click Start > Settings > Control Panel > Add/Remove Programs > DeployCenter 
5.7.

2 Follow the instructions on the screen.
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Overview

Symantec Boot Disk Builder is a Windows application that automates and simplifies the 
creation of five types of DOS boot disks: 

• PowerCast 
• Unicast
• Novell NetWare Client 
• Microsoft TCP/IP 
• Standalone

Network boot disks are necessary for creating or restoring image files on a network drive. 
To access the network, you must create a network boot disk in addition to the ImageCenter 
rescue diskettes. Then boot your computer from the network boot disk and run 
ImageCenter from the second rescue diskette. When you follow this process, you can 
create and restore images on a network drive as you can on a local drive. Peer-to-peer 
networking is not supported.

You can also use Boot Disk Builder to create a QuickBoot executable, a “virtual floppy” 
that you can send to end users or package as an MSI file. 

Boot Disk Builder has been enhanced to generate a random computer name for each 
computer to use when it is booted to DOS, so multiple DOS computers ca be on the 
network at the same time. 

When you create a boot disk with Boot Disk Builder, the time zone is set to match the 
value of the time zone for the machine that is running Boot Disk Builder. 

For information about creating PowerCast boot disks, see “Building PowerCast DOS Boot 
Disks” on page 74. For information about creating Unicast boot disks, see “Creating 
Unicast Client Boot Disks” on page 86. 

Installing Microsoft Client Files

For the following types of boot disks, Microsoft Client files must be installed on the Boot 
Disk Builder computer before creating a boot disk:

• Unicast with a TCP/IP driver
• Microsoft TCP/IP 

To install Microsoft Client files, you must be logged onto the computer as an 
Administrator and connected to the Internet. You can run the batch file Getmslan.bat to 
automatically download the Microsoft Client files and install them on your computer. 
Getmslan.bat is installed in the installation location of the Boot Disk Builder. 
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Starting Boot Disk Builder

Boot Disk Builder is installed during the DeployCenter installation. To run Boot Disk 
Builder, click Start > Programs > Symantec DeployCenter 5.7 > DeployCenter 5.7 
Tools > Boot Disk Builder.

IMPORTANT! Before you start, note that to add a network driver, you will need either the 
.INF file for the driver and a .COM or .EXE for NetWare and/or an .EXE 
or .DOS file for Microsoft, or you will need to specify the network adapter 
ID. 

Creating DOS Boot Disks for NetWare

To create or restore images on a network drive, you must boot your computer from boot 
disks that include the network drivers. 

1 From the Boot Disk Builder main menu, select Novell NetWare Client Boot Disks, 
then click Next.

2 Enter the Novell NetWare client settings, then click Next.

a. Enter the User name that will be used to log in to the network.

If this boot disk is part of a task, the designated user must have the necessary 
rights to perform the network-based tasks.

b. If the boot disk needs to run “hands-off,” that is, without user input, mark Login 
automatically and enter the user's password in the Password and Confirm 
password fields.

c. Indicate the network's first mapped drive in the First network drive drop-down 
list.

d. In the Preferred server field, enter the full NDS context name for the server that 
the user typically logs in to (the server that has the user's network files and 
directories). The preferred server is the same as the NDS tree.

e. In the Name context field, enter the NDS context for the user's NDS User object. 
(For example, docs.dev.acmecorp.)

f. If you want to automatically map a network drive at boot up, mark Map a 
network drive. 

This requires that you designate the drive letter to be mapped and the UNC path it 
is mapped to. For example, Q:\ might be mapped to \\SERVER\Volume.
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3 Specify the location and parameters for ImageCenter, and click Next.

The Novell NetWare Client boot disk automatically boots a network workstation to 
ImageCenter. Therefore, you must indicate where it can find the ImageCenter 
program files. Parameters for ImageCenter are optional.

a. Select Boot Disk to launch ImageCenter from the boot disk.

If you are writing the boot file to a floppy diskette, copying ImageCenter to the 
boot disk may require two diskettes. You will be prompted if a second diskette is 
needed.

If you are writing the boot file to a folder or virtual boot disk, all files (including 
ImageCenter) are copied to the designated location.

b. To run ImageCenter from the network or workstation, select Specified location 
and enter the path to the ImageCenter program files. 

The path to ImageCenter must use 8.3 format instead of long filenames. For 
example, if you have ImageCenter installed to C:\Program Files\Symantec\ 
DeployCenter 5 that path needs to be entered as C:\Progra~1\PowerQ~1\ 
Deploy~1\pqimgctr.exe. You can type in the short path, or you can click the 
browse button, browse to the correct location for pqimgctr.exe, and have Boot 
Disk Builder convert the path to the short format for you. This must be the path 
where ImageCenter can be found when the user boots from the floppy disk.

c. Select Do not run ImageCenter if you do not want to launch ImageCenter at 
boot up.

d. (Optional) In the Command line parameters field, specify any switches you 
would like to be run when launching ImageCenter. 

4 Select your network adapter or multiple adapters, then click Next.

You can select multiple NICs. All of the files for those NICs will be copied to the 
boot disk. (There must be enough space on the first disk for all the selected NICs.) At 
boot time, the list of NICs copied is compared to the NIC in the computer. If one 
matches, that driver is loaded and the system is configured for it. Selecting multiple 
NICs for the boot disk enables the disk to be used on computers with different NICs.

If you select “Run from laptop,” you can only select one network adapter from the 
list, and the NIC detect feature will not run at boot time.

If your network adapter is not listed, add it to the list of network adapters. See 
“Adding a NIC to the Network Adapter List” on page 19. Mark this page, so you can 
return to these steps after adding the NIC you need to the list and selecting it .

5 Specify your client network properties, then click Next.
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a. Click Obtain an IP address from a DHCP server if a DHCP server is used to 
assign client IP addresses. On a DHCP server, the IP address is leased out 
temporarily on a first-come, first-served basis and increments automatically. The 
DHCP server also provides the subnet mask.

b. Click Specify an IP address if there is no DHCP server and you need to use 
TCP/IP on the network. In this case, you must enter a static IP address and subnet 
mask. 

c. Select your network's communication protocol from the Frame type drop-down 
list.

Token Ring is included as an option in the Frame type drop-down list. If you are 
running NetWare on an IBM Token Ring network, select Token Ring in the 
Frame type list.

6 Select the type of boot disk to build. 

Option Description

Floppy Disk If you are creating a DOS boot disk, click Floppy Disk, 
then choose the drive letter where your floppy disk is 
located. 

Boot Disk Builder can only write to a formatted disk. 
Any existing information on the disk will be lost. 

The network and ImageCenter files may require two 
disks. You will be prompted if a second disk is needed.

Copy boot disk 
contents to a folder

Click Copy boot disk contents to a folder if you want 
to temporarily store the boot file in a folder.

This option is practical when you want to electronically 
distribute the boot file to other administrators or users. 
Though the file is stored in a folder and can be 
electronically transferred, it must be copied to a floppy 
disk or burned to CD before it can be used. 

You can use this option to create a bootable CD-ROM 
for ImageCenter.
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By default, Boot Disk Builder uses the operating system's DOS files to build boot 
disk files on Windows 95, 98, or Windows Me systems. On Windows NT or 2000 
systems, Boot Disk Builder builds boot disks using the Caldera DOS files included 
with Boot Disk Builder.

7 If you want to use a specific set of DOS files in building your boot diskette, complete 
the following:

a. Insert a boot diskette that boots to the version of DOS want to use in building your 
boot disk file.

b. From the Boot Disk Builder menu bar, click Tools > Load DOS Reference 
Diskette > From A:.

The files from your boot disk will be copied to the REFDISK directory where 
Boot Disk Builder is installed. 

If there are too many files to fit on a single floppy diskette, you can delete 
everything except CONFIG.SYS, any drivers started within the CONFIG.SYS 
file, COMMAND.COM, HIMEM.SYS, BR.DAT, and the system commands for 
the version of DOS you use (for IBMDOS: IBMBIO.COM and IBMDOS.COM; 
for MS-DOS: IO.SYS and MSDOS.SYS).

If you use a reference disk for DOS files, you must include HIMEM.SYS and load 
it from your CONFIG.SYS file, or the virtual floppy will not work properly.

c. Mark Use Reference Disk for DOS files at the bottom of the dialog. 

Virtual Boot Disk file Click Virtual Boot Disk file to write a fully active boot 
file to a location other than a floppy disk. 

A virtual boot disk file does not need to be launched 
from a floppy disk. Rather, computers can reference this 
file from any directory location upon reboot as if it were 
using a floppy. 

Virtual boot disk files are used by ImageCenter to boot to 
DOS. 

Be aware that some rare instances NICs are deinitialized 
when you reboot with a virtual floppy. You can work 
around this problem by using the NIC’s diagnostic utility 
in the AUTOEXEC.BAT file to initialize the NIC.

Option Description
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d. If you are writing your boot disk file to disk, remove your original boot disk and 
insert a formatted diskette. 

If you do not remove your original disk, Boot Disk Builder will overwrite the files 
on it.

8 If you want to save your choices for later use, click File > Save Configuration from 
the menu bar. Name and save the file.

9 Click Back to make any changes, or click Finish to build the boot disk.

In building the boot disk file, Boot Disk Builder copies the DOS system files and the boot 
information to the designated location. Any existing information on the floppy diskette or 
in the designated folder is erased. 

When you boot a computer from these diskettes, ImageCenter will start in graphical user 
interface (GUI) mode. You can then select any operations.

Creating Additional Boot Disks

After the boot disk file has been created, you are asked if you want to create another boot 
diskette. If you click Yes, Boot Disk Builder creates another boot disk file using the 
current configuration. 

If the current configuration uses a static IP address and if you are creating the file on 
floppy diskettes, Boot Disk Builder auto-increments the assigned IP address on each boot 
diskette. 

Creating DOS Boot Disks for Microsoft TCP/IP

This option is disabled if you do not have the Microsoft Client files installed. See 
“Installing Microsoft Client Files” on page 10.. 

1 From the Boot Disk Builder main menu, select Microsoft TCP/IP Boot Disks, then 
click Next.

2 Enter the Microsoft TCP/IP settings, then click Next.

a. Enter the User name that will be used to log in to the network.

If this boot disk is part of a task, the designated user must have the necessary 
rights to perform the network-based tasks.
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b. If the boot disk needs to run “hands-off” (without user input), mark Login 
automatically and enter the user’s password in the Password and Confirm 
password fields. Note that you should not have a password on a shared volume if 
you are going to access it with a boot disk; the password you enter will only allow 
access to the domain, not the domain and a shared volume.

c. Click Login to workgroup to log the user into a workgroup, or click Login to 
domain to log the user into a domain.

d. Designate the network drive letter to be mapped at boot up and the UNC path it is 
mapped to.

3 Specify the location and parameters (optional) for ImageCenter, then click Next.

The Microsoft TCP/IP Boot Disk automatically boots a network workstation to 
ImageCenter. Therefore, you must indicate where it can find the ImageCenter 
program files.

a. Mark Boot Disk to launch ImageCenter from the boot disk.

If you are writing the boot file to a floppy diskette, copying ImageCenter to the 
boot disk may require two diskettes. You will be prompted if a second diskette is 
needed.

If you are writing the boot file to a folder or virtual boot disk, all files (including 
ImageCenter) are copied to the designated location.

b. To run ImageCenter from the network or workstation, mark Specified location 
and enter the path to the ImageCenter program files. 

The path to ImageCenter must use 8.3 format instead of long filenames. For 
example, if you have ImageCenter installed to C:\Program Files\Symantec\ 
DeployCenter 5, that path needs to be entered as C:\Progra~1\PowerQ~1\ 
Deploy~1\pqimgctr.exe. You can type in the short path, or you can click the 
browse button, browse to the correct location for pqimgctr.exe, and have Boot 
Disk Builder convert the path to the short format for you. This must be the path 
where ImageCenter can be found when the user boots from the floppy disk.

c. (Optional) In the Command line parameters field, specify any switches you 
would like to be run when launching ImageCenter. 

4 Select your network adapter or multiple adapters, and click Next.
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You can select multiple NICs. All of the files for those NICs will be copied to the 
boot disk. (There must be enough space on the first disk for all the selected NICs.) At 
boot time, the list of NICs copied is compared to the NIC in the computer. If one 
matches, that driver is loaded and the system is configured for it. Selecting multiple 
NICs for the boot disk enables the disk to be used on computers with different NICs.

If your network adapter is not listed, add it to the list of network adapters. See 
“Adding a NIC to the Network Adapter List” on page 19. Mark this page, so you can 
return to these steps after adding the NIC you need to the list and selecting it.

5 Specify your client network properties, and click Next.

Boot Disk Builder does not support token ring NICs on Microsoft TCP/IP networks.

a. Click Obtain an IP address from a DHCP server if a DHCP server is used to 
assign client IP addresses. On a DHCP server, the IP address is leased out 
temporarily on a first-come, first-served basis and increments automatically. The 
DHCP server also provides the subnet mask.

b. Click Specify an IP address if there is no DHCP server and you need to use 
TCP/IP on the network. In this case, you must enter a static IP address and subnet 
mask. 

6 Select the type of boot disk to build.

Option Description

Floppy Disk If you are creating a DOS boot disk, select Floppy Disk and 
choose the drive letter where your floppy disk is located. 

Boot Disk Builder can only write to formatted disk. Any 
existing information on the disk will be lost.

The network and ImageCenter files may require two disks. 
You will be prompted if a second disk is needed.

Copy boot disk 
contents to a 
folder

Click Copy boot disk contents to a folder if you want to 
temporarily store the boot file in a folder. You can use this 
option to create a bootable CD-ROM for ImageCenter.

This option is practical when you want to electronically 
distribute the boot file to other administrators or users. 
Though the file is stored in a folder and can be electronically 
transferred, it must be copied to a floppy disk or burned to CD 
before it can be used.
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7 By default, Boot Disk Builder uses the operating system’s DOS files to build boot 
disk files on Windows 95, 98, or Me systems. On Windows NT or 2000 systems, Boot 
Disk Builder builds boot disk files using the Caldera DOS files included with Boot 
Disk Builder.

If you want to use a specific set of DOS files in building your boot diskette, complete 
the following:

a. Insert a boot diskette that boots to the version of DOS want to use in building your 
boot disk file.

b. From the Boot Disk Builder menu bar, click Tools > Load DOS Reference 
Diskette > From A:.

The files from your boot disk will be copied to the REFDISK directory where 
Boot Disk Builder is installed. 

If there are too many files to fit on a single floppy diskette, you can delete 
everything but CONFIG.SYS, any drivers started within the CONFIG.SYS file, 
COMMAND.COM, HIMEM.SYS, and the system commands for the version of 
DOS you use (for IBMDOS: IBMBIO.COM and IBMDOS.COM; for MS-DOS: 
IO.SYS and MSDOS.SYS).

If you use a reference disk for DOS files, you must include HIMEM.SYS and load 
it from your CONFIG.SYS file, or the virtual floppy will not work properly.

c. Mark Use Reference Disk for DOS files at the bottom of the dialog. 

d. If you are writing your boot disk file to disk, remove your original boot disk and 
insert a formatted diskette. 

Virtual Boot 
Disk file

Click Virtual Boot Disk file to write a fully active boot file to 
a location other than a floppy disk. 

A virtual boot disk file does not need to be launched from a 
floppy disk. Rather, computers can reference this file from 
any directory location upon reboot as if it were using a floppy. 

ImageCenter uses a virtual boot disk to boot to DOS. 

Be aware that some rare instances NICs are deinitialized 
when you reboot with a virtual floppy. You can work around 
this problem by using the NIC’s diagnostic utility in the 
AUTOEXEC.BAT file to initialize the NIC.

Option Description
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If you do not remove your original disk, Boot Disk Builder will overwrite the files 
on it.

8 If you want to save your choices for later use, click File > Save Configuration from 
the menu bar. Name and save the file.

9 Click Back to make any changes, or click Finish to build the boot disk.

In building the boot disk file, ImageCenter copies the DOS system files and the boot 
information to the designated location. Any existing information on the floppy 
diskette or in the designated folder is erased. 

When you boot a computer from these diskettes, ImageCenter will start in graphical user 
interface (GUI) mode. You can then select any operations.

Creating Additional Boot Disks

After the boot disk file has been created, you are asked if you want to create another boot 
diskette. If you click Yes, Boot Disk Builder creates another boot disk file using the 
current configuration. 

If the current configuration uses a static IP address and if you are creating the file on 
floppy diskettes, Boot Disk Builder auto-increments the assigned IP address on each boot 
diskette. 

Microsoft Networking Files

You can obtain the Microsoft Network 3.0 Client for MS-DOS files used to support NDIS 
drivers from a Windows NT Server 4.0 CD. To automate this process, insert the Windows 
NT Server CD into your CD-ROM drive, open a DOS box, and run the GETMSLAN.BAT 
file in the C:\Program Files\Symantec\DeployCenter 5\BDBuild directory (or in the 
BDBuild directory wherever ImageCenter was installed). Pass in as a parameter the drive 
letter for the CD drive. Example: GETMSLAN E:. The batch file will copy the required 
files from the CD to the Boot Disk Builder directories. You can also get the Microsoft 
Network 3.0 Client MS-DOS file from Microsoft’s web site.

Adding a NIC to the Network Adapter List

If your NIC is not listed by default in the Boot Disk Builder network adapter list, you can 
add it. 

1 From the Select network adapters screen, click Add. 
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2 Under Select driver types to add, specify whether you want to add Microsoft and 
NetWare drivers or just one type of driver, then click Next. 

If you are creating a Microsoft TCP/IP boot disk, the Microsoft option is selected by 
default and dimmed so you cannot deselect it. If you are creating a Novell NetWare 
IPX or PowerCast boot disk, the Novell NetWare IPX/PowerCast option is selected 
by default and dimmed so you cannot deselect it. 

3 Under Enter driver information, specify where Boot Disk Builder can get 
information about the driver. 

4 To proceed with creating a boot disk, select the network adapter you just added from 
the bottom of the list box, and click Next. Return to the steps you were using before 
you were referred to this section of the documentation. 

Location of 
information Procedure

Driver file Specify the location of the driver file (*.INF) for your 
network adapter. You can click the browse button to browse 
the directory tree for the driver file. 

Choose one more adapters from the list, then click Next.

Select the network drivers, and click Finish.

Enter manually In the Add Network Drivers dialog, specify whether you 
want the boot disk to support multiple NICs.

Specify the network adapter ID and a descriptive name for 
the network adapter. The name you type will display in the 
adapter list in Boot Disk Builder. If you deselected the option 
to support multi-driver boot disks, you do not need to specify 
the network adapter ID. 

Specify the location of the Microsoft and NetWare DOS 
driver files as prompted. You can click the browse button to 
browse for the appropriate files. 

Click Finish.
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Consolidating NICs in the Network Adapter List

If the list of network adapters in Boot Disk Builder is too long to manage, you can 
consolidate the list. 

The .INI file includes strings that control the list of adapters. For example:

[2]
PCI\VEN_10b7&DEV_9058=3C90X,3c90x.com

The string is broken down into three parts: 

• Part one (PCI\VEN_10b7&DEV_9058=) is the driver ID.
• Part two (3C90X) is added to NET.CFG.
• Part three (3c90x.com) is added to AUTOEXEC.BAT. This is the NIC filename.

Understanding the parts of a string will help you consolidate a list by allowing you to 
create descriptive strings that include all the adapters in one simplified string. For 
example, if your list contained 10 3c905 3Com drivers, you could combine the list into 
one inclusive description as follows:

1=3Com EtherLink 10/100 PCI NIC (3C905x/3C920x/3C900x)

To consolidate a NIC list,

1 Combine all similar drivers into one tagged group.

For example, in the following .INI example, similar driver ID strings are combined 
under [1].

[NICList]

1=3Com EtherLink 10/100 PCI NIC (3C905x/3C920x/3C900x)

[1]
PCI\VEN_10b7&DEV_9200&SUBSYS_100010B7=3C90X,3c90x.com
PCI\VEN_10b7&DEV_9058=3C90X,3c90x.com
PCI\VEN_10b7&DEV_905A=3C90X,3c90x.com
PCI\VEN_10b7&DEV_9055&SUBSYS_905510b7=3C90X,3c90x.com
PCI\VEN_10b7&DEV_900A=3C90X,3c90x.com
PCI\VEN_10b7&DEV_9004=3C90X,3c90x.com
PCI\VEN_10b7&DEV_9005=3C90X,3c90x.com
PCI\VEN_10b7&DEV_9006=3C90X,3c90x.com
PCI\VEN_10b7&DEV_9200=3C90X,3c90x.com
PCI\VEN_10b7&DEV_9055=3C90X,3c90x.com

2 Edit the driver ID by removing the exclusive parts. 
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For example, in the driver ID string used above ([2] PCI\VEN_10b7&DEV_9058= 
3C90X,3c90x.com), you can remove the string after 905 but before the = sign to 
make a new string (PCI\VEN_10b7&DEV_905=). This edit creates an inclusive 
string that covers the range of 3C905x drivers (3C905A, 3C905B, 3C905C, 3C9058, 
and so forth) and allows Boot Disk Builder to load any of these drivers.

In this next example, the driver ID string (PCI\VEN_10b7&DEV_9200&SUBSYS_ 
100010B7=3C90X,3c90x.com) has 0&SUBSYS removed just after 920. The new 
string would now appear as PCI\VEN_10b7&DEV_920=3C90X,3c90x.com and is 
capable of loading any 3C920x drivers.

Continuing with the .INI example, the driver IDs are made inclusive so they appear as 
follows:

[NICList]

1=3Com EtherLink 10/100 PCI NIC (3C905x/3C920x/3C900x)

[1]
PCI\VEN_10b7&DEV_920=3C90X,3c90x.com
PCI\VEN_10b7&DEV_905=3C90X,3c90x.com
PCI\VEN_10b7&DEV_905=3C90X,3c90x.com
PCI\VEN_10b7&DEV_905=3C90X,3c90x.com
PCI\VEN_10b7&DEV_900=3C90X,3c90x.com
PCI\VEN_10b7&DEV_900=3C90X,3c90x.com
PCI\VEN_10b7&DEV_900=3C90X,3c90x.com
PCI\VEN_10b7&DEV_900=3C90X,3c90x.com
PCI\VEN_10b7&DEV_920=3C90X,3c90x.com
PCI\VEN_10b7&DEV_905=3C90X,3c90x.com

In the image above, there are numerous identical strings (combined into one tagged 
group). Therefore, the list can easily be reorganized and any redundant strings 
removed to create the final list below.

[NICList]

1=3Com EtherLink 10/100 PCI NIC (3C905x/3C920x/3C900x)

[1]
PCI\VEN_10b7&DEV_905=3C90X,3c90x.com
PCI\VEN_10b7&DEV_900=3C90X,3c90x.com
PCI\VEN_10b7&DEV_920=3C90X,3c90x.com
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Deleting Adapters from the List

1 Open the files DRIVERN.INI, DRIVERM.INI and DRIVERIP.INI.

They are usually located in the DRIVERS subfolder, within the BDBUILD folder. 

2 Delete the descriptive string of the NICs (Network Interface Card) you want to delete, 
within the [NICList] section of the .INI file.

3 Delete the driver ID/NIC filename tag section near the bottom of the file. 

For example, in the example .INI below, suppose you want to delete the following 
drivers:
9=3Com 3C920 Integrated Fast Ethernet Controller (3C905C-TX 
Compatible)

10=3Com 3C918 Integrated Fast Ethernet Controller (3C905B-TX 
Compatible)

You would delete the 9 and 10 lines from the [NICList] section of the .INI file, then 
you would delete the following two sections near the bottom of the file:

[9]
PCI\VEN_10b7&DEV_9200=3C90X,3c90x.com

[10]
PCI\VEN_10b7&DEV_9055=3C90X,3c90x.com

4 Save the files.

Creating a QuickBoot Executable

You can easily create a QuickBoot executable program that extracts a virtual boot disk file 
to the Windows temporary folder, and then uses the file to reboot the user's computer.

After you create the QuickBoot executable, you can send it to users via e-mail or package 
it in an MSI file. Users then run the QuickBoot executable on their computers just like a 
traditional executable (.EXE) program.

IMPORTANT! Before you can build a QuickBoot executable, you must have created a 
virtual boot disk using Boot Disk Builder. You cannot create a QuickBoot 
executable if a virtual floppy does not exist.
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1 From the Boot Disk Builder pull-down menu, click Tools > Build a QuickBoot 
Executable. 

2 Specify the name of an existing virtual boot disk configuration file (*.VFD) in the 
Virtual Boot Disk file text field. Click the browse button to navigate to the file's 
location.

3 Specify the filename of the QuickBoot executable you want to build in the 
QuickBoot executable to build text field. Click the browse button to navigate to the 
location where you want to save the executable.

4 (Optional) Type a brief description of the executable and what it does in the 
QuickBoot description text field.

Users will be able to read the description only when they run the executable with the 
/PROMPT option selected. If you want users to always see the description, select the 
option Prompt the user before rebooting as described in step 5.

5 (Optional) If you want to prompt a user before rebooting their computer, select 
Prompt the user before rebooting.

6 Click OK.
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Creating DOS Standalone Boot Disks

1 From the Boot Disk Builder main menu, select Standalone Boot Disks, then click 
Next.

2 Specify the location and parameters (optional) for ImageCenter, then click Next.

A standalone boot disk automatically boots the computer to ImageCenter. Therefore, 
you must indicate where it can find the ImageCenter program files.

a. Select Boot Disk to launch ImageCenter from the boot disk, or select Specified 
location and enter the path to the ImageCenter program files to run from a local 
drive (typically the hard disk).

The path to ImageCenter must use 8.3 format instead of long filenames. For 
example, if you have ImageCenter installed to C:\Program Files\Symantec\ 
DeployCenter 5, that path needs to be entered as C:\Progra~1\PowerQ~1\ 
Deploy~1\pqimgctr.exe. You can type in the short path, or you can click the 
browse button, browse to the correct location for pqimgctr.exe, and have Boot 
Disk Builder convert the path to the short format for you. This must be the path 
where ImageCenter can be found when the user boots from the floppy disk.

If you are writing the boot file to a floppy disk, copying ImageCenter to the boot 
disk may require two disks. You will be prompted if a second disk is needed.

If you are writing the boot file to a folder or virtual boot disk, all files (including 
ImageCenter) are copied to the designated location.

b. (Optional) In the Command line parameters text box, specify any switches that 
you want to run when launching ImageCenter.

3 Select the type of boot disk to build. 

Option Description

Floppy Disk If you are creating a DOS boot disk, click Floppy Disk, then 
choose the drive letter where your floppy disk is located. 

Boot Disk Builder can only write to a formatted disk. Any 
existing information on the disk will be lost. For information 
on formatting a disk using Boot Disk Builder, click See Also 
on the Help toolbar, then click To format disks using Boot 
Disk Builder.

The network and ImageCenter files may require two disks. 
You will be prompted if a second disk is needed.
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4 By default, Boot Disk Builder uses the operating system’s DOS files to build boot 
disk files on Windows 95, 98, or Windows Me systems. On Windows NT or 2000 
systems, Boot Disk Builder builds boot disk files using the Caldera DOS files 
included with Boot Disk Builder.

If you want to use a specific set of DOS files in building your boot diskette, complete 
the following:

a. Insert a boot diskette that boots to the version of DOS you want to use in building 
your boot disk file.

b. From the Boot Disk Builder menu bar, click Tools > Load DOS Reference 
Diskette > From A:.

The files from your boot disk will be copied to the REFDISK directory where 
Boot Disk Builder is installed. 

Copy boot disk 
contents to a 
folder

Click Copy boot disk contents to a folder if you want to 
temporarily store the boot file in a folder.

This option is practical when you want to electronically 
distribute the boot file to other administrators or users. 
Though the file is stored in a folder and can be electronically 
transferred, it must be copied to a floppy disk or burned to CD 
before it can be used. 

You can use this option to create a bootable CD-ROM for 
ImageCenter.

Virtual Boot 
Disk file

Click Virtual Boot Disk file to write a fully active boot file to 
a location other than a floppy disk. 

A virtual boot disk file does not need to be launched from a 
floppy disk. Rather, computers can reference this file from 
any directory location upon reboot as if it were using a floppy. 

Virtual boot disk files are used by ImageCenter to boot to 
DOS. 

Be aware that some rare instances NICs are deinitialized 
when you reboot with a virtual floppy. You can work around 
this problem by using the NIC’s diagnostic utility in the 
AUTOEXEC.BAT file to initialize the NIC.

Option Description
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If there are too many files to fit on a single floppy diskette, you can delete 
everything but CONFIG.SYS, any drivers started within the CONFIG.SYS file, 
COMMAND.COM, HIMEM.SYS, and the system commands for the version of 
DOS you use (for IBMDOS: IBMBIO.COM and IBMDOS.COM; for MS-DOS: 
IO.SYS and MSDOS.SYS).

If you use a reference disk for DOS files, you must include HIMEM.SYS and load 
it from your CONFIG.SYS file, or the virtual floppy will not work properly.

c. Mark Use Reference Disk for DOS files at the bottom of the dialog. 

d. If you are writing your boot disk file to disk, remove your original boot disk and 
insert a formatted diskette. 

If you do not remove your original disk, Boot Disk Builder will overwrite the files 
on it.

5 (Optional) To save your choices to a configuration file (*.BDC) for later use, click 
File > Save Configuration, type the filename for the configuration file, then click 
Save.

6 Click Back to make any changes, or click Finish to build the boot disk.

In building the boot disk file, ImageCenter copies the DOS system files and the boot 
information to the designated location. Any existing information on the floppy disk or 
in the designated folder is erased. 

Creating Additional Boot Disks

After the boot disk file has been created, you are asked if you want to create another boot 
disk. If you click Yes, Boot Disk Builder creates another boot disk file using the current 
configuration. 

If the current configuration uses a static IP address and if you are creating the file on 
floppy disks, Boot Disk Builder auto-increments the assigned IP address on each boot 
disk.

Integrating a Boot Disk with the MS RIS Boot Menu

The Microsoft RIS Integration option on the Tools menu is specific to Windows 2000 RIS 
(Remote Installation Services). RIS is a Microsoft technology that enables PCs with a 
boot-from-network-enabled card to boot to a network menu where users can run 
automated tasks for system maintenance.
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Boot Disk Builder's Microsoft RIS Integration tool lets you add tasks to your network's 
RIS menu.

1 Create a virtual boot disk in Boot Disk Builder.

The virtual boot disk file can be created as a PowerCast, Novell NetWare, Microsoft 
TCP/IP, or Standalone boot disk.

2 Edit the virtual boot disk file using the Symantec VF Editor utility that ships with 
DeployCenter.

See “Editing Virtual Boot Disks” on page 204.

3 Add any commands you want to execute. You can add any command line function; 
however, typically, you will use the virtual boot disk to launch a task. 

4 Re-save the virtual boot disk file.

5 Open Boot Disk Builder.

6 Click Tools > Microsoft RIS Integration. 

7 In the Virtual Boot Disk file text box, type the file name of virtual boot disk file that 
you want to add to the RIS menu. Click the browse button to browse the directory 
tree.

ImageCenter ships with PQVF.VFD, a virtual boot disk file that automatically 
launches ImageCenter.

8 Type a menu name for the virtual boot disk file (for example, “Restore Windows 2000 
Configuration”).

The name you type is what actually appears on the RIS menu. 

9 Type a description for the menu option.

The description is intended to help users identify what the menu option will do.

10 In the Remote install folder text box, identify the root folder where the RIS menu 
files are located.

The default location is \\servername\REMOTEINSTALL. Click the browse button to 
browse the directory tree for the folder location.

Once you have specified a folder, the Language drop-down list is populated with the 
languages installed on the RIS server.

11 Select a language for the current menu option.
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For example, if the current menu option runs a German version of ImageCenter, you 
would select German as the language. (You would also want to indicate the language 
in the menu name or description.)

12 Click OK to add the current option to the RIS menu.

After the option is added to the RIS menu, you can add additional options to the RIS 
menu. 

Formatting Diskettes with Boot Disk Builder

1 Click Tools > Format > drive letter.

2 Select the capacity of your floppy disk from the Capacity drop-down list.

3 Click a format type.

4 Type the disk label in the Label text box, or select No Label.

5 By default, Display summary when finished is selected. This gives you a summary 
of the disk format for troubleshooting purposes. 

If you do not want to have a format summary, deselect this option. 

6 Select Copy system files to copy the DOS system files while formatting the disk.

This option is only relevant for the Quick (erase) and Full format types.

Quick (erase) Click Quick (erase) to erase existing information on a 
currently formatted disk.

Full Click Full to completely format the disk.

Copy system 
files only

Select Copy system files only to copy DOS system files to a 
previously formatted disk.

Boot Disk Builder automatically copies the system files to the 
floppy disk when building the boot disk.
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Creating Rescue Diskettes under Windows

There are three ways to create ImageCenter rescue diskettes under Windows 95 or later. 
All methods create a set of two diskettes for ImageCenter. The first is a DOS boot diskette. 
The second includes the ImageCenter program. If you experience a hard disk failure or are 
unable to access Windows, you can run ImageCenter from the rescue diskettes.

• On the installation CD, navigate to \DeployCenter Library\Rescue Disk, and run 
Setup.exe.

• Run the Boot Disk Builder program that is included with DeployCenter. At the Boot 
Disk Builder main screen, click Standalone Boot Disks, then follow the on-screen 
prompts. For more information about the Boot Disk Builder, refer to “Creating Boot 
Disks” on page 9.

• If you selected the Rescue Diskettes option during the DeployCenter installation, you 
can create ImageCenter rescue diskettes by clicking Start > Programs > Symantec 
DeployCenter 5.7 > DeployCenter 5.7 Tools > Create Rescue Diskettes.

Drive Letter Assignments

Be aware that NTFS partitions will not be assigned drive letters when you run 
ImageCenter from the rescue diskettes. In some cases, partitions that cross or exist past the 
1024 cylinder boundary (including partitions that reside in an extended partition that 
crosses or exists past the 1024 cylinder boundary) are not assigned drive letters.

You can save image files to a partition that does not have a drive letter. At the Name 
Image File screen, click Browse instead of typing a path and filename in the Image File 
field. The New Image File dialog appears. Display the drop-down list under the Drives 
field. Partitions that have not been assigned a drive letter display as follows:

\\.\diskn.partm NAME

where n is the number of the disk, m is the number of the partition on that disk, and NAME 
is the volume label assigned to that partition (if applicable). Choose the partition where 
you want to save the image, type a filename in the File Name field, and click OK.
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Before Running ImageCenter

Before running any of the applications on the DeployCenter CD, you must run a disk 
utility (such as a thorough ScanDisk or CHKDSK /F) on each partition of the source 
drives to check for file system errors. After you check for file system errors, Symantec 
recommends that you create ImageCenter rescue disks. See “Creating Rescue Diskettes 
under Windows” on page 32.

Any discussion of deployment, including hard disk imaging, assumes that all software, 
including the operating system, is being copied in accordance with the license agreements 
from the software manufacturer.

Running ImageCenter

With ImageCenter, you can create and restore an image file of an entire hard disk or 
individual partitions of a hard disk on a local drive, a network, or on removable media 
device. You can run ImageCenter from a floppy diskette or from the hard disk. The 
following two procedures describe how to run ImageCenter in interactive mode. To run 
ImageCenter from a batch file or using scripts, see “Command Line Switches and 
Scripting Commands” on page 123.

Running ImageCenter from a Hard Disk

1 Click Start > Programs > Symantec DeployCenter 5.7 > ImageCenter.

If you encounter problems under Windows 95a, run ImageCenter from the rescue 
diskettes.

Loading EMM386 before running ImageCenter limits the memory available and could 
dramatically increase the time required to create and restore image files. EMM386 is not 
loaded by default.

Running ImageCenter from Rescue Diskettes

1 Insert a bootable diskette (such as Diskette 1 of the ImageCenter floppy set).

To create a boot diskette and an ImageCenter floppy (rescue diskettes), see “Creating 
Rescue Diskettes under Windows” on page 32.

2 Reboot your machine.

DOS loads and displays an A: prompt.
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3 Insert the ImageCenter program floppy (the second rescue disk), and press any key to 
continue.

ImageCenter (PQIMGCTR.EXE) runs automatically.

Be aware that ImageCenter has some limitations when you run from the rescue diskettes. 
Aside from these limitations, the features in ImageCenter running from the rescue 
diskettes are the same as those running it from a hard disk. See “Drive Letter 
Assignments” on page 32.

An image must be saved to a FAT, FAT32, or NTFS partition if you are going to restore it 
when running from the ImageCenter rescue disks.

Navigating ImageCenter without a Mouse

If you cannot use your mouse while running ImageCenter (only the case if, for some 
reason, the mouse driver is not loaded), you can use ImageCenter with the keyboard.

Press the Alt key to use mnemonics (for example, <Alt + N> for Next). Use the arrow 
keys to highlight different drives or partitions. Press <Tab> or <Shift + Tab> to move from 
one field to another. Press the space bar to select or deselect a highlighted checkbox or 
option within a dialog. In the Open File dialog, press <Alt + down arrow> to display the 
list of drives available; then use the arrow keys to select the drive you want.

Accessing Network Drives from ImageCenter

If you start ImageCenter from Windows or from the standard ImageCenter rescue 
diskettes, you cannot access network drives. However, you can create a network boot disk 
that will make network directories accessible for creating or restoring image files.

1 Create a set of ImageCenter rescue diskettes.

You will run ImageCenter from the second rescue diskette.

2 Create a network boot diskette, so your network directories will be available under 
DOS.

You can use Boot Disk Builder to create the boot disk. For information about Boot 
Disk Builder, see “Overview” on page 10.

IMPORTANT! ImageCenter does not support peer-to-peer networks.

3 Boot from the network boot disk.
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4 Run PQIMGCTR from the second ImageCenter rescue diskette.

Using ImageCenter on Servers

Before you use ImageCenter on a server, you should be familiar with the guidelines and 
restrictions outlined in this section. ImageCenter includes limited support for use with 
Windows 2000 Server, Windows 2000 Advanced Server, Windows NT Server, Windows 
XP Server, and Linux servers.

If you require NetWare support, you should use Symantec® ServerMagic™ for NetWare.® 
Microsoft Exchange 2000, Microsoft SQL Server 2000, and Microsoft Windows 2000 
DataCenter Servers are not supported.

Deploying Windows Servers

You can use ImageCenter to deploy Windows 2000 Server, Windows 2000 Advanced 
Server, Windows XP Server, and Windows NT Server machines.

1 Follow the setup instructions to install Windows 2000 Server to the computer.

2 Use Microsoft’s SysPrep to remove machine-specific entries to allow deployment to 
several identical computers.

Refer to your SysPrep documentation for information about using SysPrep.

You must ensure that the image will be restored on a machine with identical 
hardware.

Symantec only supports the imaging of a Windows 2000 Server that has not had its 
server responsibilities (Active Directory, dynamic disks, indexing services, etc.) set. 
If SysPrep has been applied to the system before the image is taken, then the image 
can be restored to other identical computers.

Be aware that when you run SysPrep, you are subject to Microsoft’s technical 
restrictions on using SysPrep. For example, imaging to machines with different 
hardware is not directly supported by Microsoft.

3 Reboot the computer using the ImageCenter rescue diskettes.

You may need to create and use your own boot floppy that will enable access to a data 
storage region large enough to store the image of the Windows 2000 Server system.

4 Image the Windows server.

5 Restore the image on the target computer.
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When you reboot the imaged computer, SysPrep runs according to the settings you 
specified in the answer file to prepare the server for use.

Restoring Primary Domain Controllers (Windows NT)

Exercise caution when restoring an imaged Primary Domain Controller. ImageCenter will 
automatically convert a PDC (Primary Domain Controller) to a BDC (Backup Domain 
Controller) when you restore the image file. If you want the restored image to be the PDC, 
you must promote a BDC to a PDC before restoring the image. Then restore the image, 
and promote the restored image server to become the PDC.

Running ImageCenter with Linux

If you run ImageCenter with Linux, be aware of the following limitations:

• ImageCenter is not a native Linux application. To use it on a Linux machine, you 
must run it from DOS disks (such as the ImageCenter rescue disks).

• You cannot save a Linux image or an image of any other partition type to a local 
Linux partition.

• To restore an image on a Linux machine, you must have at least as much free space 
(space not assigned to any partition) as the size of the original partition. After you 
have restored the image, you can resize it down to the size of the data that resides on 
the partition using a tool such as Norton™ PartitionMagic®.

Running ImageCenter on Dell Computers

ImageCenter protects the diagnostic, fifth partition on Dell personal computers. You 
cannot image, delete, or boot to that partition. If you look at the partition map in 
ImageCenter, the diagnostic partition is shown as unused space on the hard disk. 
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Overview

You can use ImageCenter to create image files on any physical or logical drive that DOS 
has assigned a drive letter, including floppy drives, secondary hard drives, network drives, 
and removable media storage devices such as Jaz, Zip, and Magneto-Optical drives.

You can also create image files on hidden NTFS, FAT, and FAT32 partitions and standard, 
MMC2-compliant IDE or SCSI CD-R or CD-RW drives that have not been assigned drive 
letters.

If you are unsure whether a drive is available to save an image file, click Browse and all of 
the available drives will display. See step 6 on page 41 for more information.

The master boot record (MBR) is always included in image files you create. If you want to 
restore the MBR when you restore an image, start ImageCenter with the /MBR switch. 
See page 128 for information about the /MBR switch.

Image Files and Hardware Configurations

Because of operating system conflicts that can result from different hardware 
configurations, ImageCenter was not intended to copy or image a hard drive that will be 
used in a system with different hardware configurations.

If you create an image on one machine and restore the image on a machine with a different 
configuration (for example, a different motherboard or video card), the operating system 
may not boot correctly. Therefore, we recommend imaging and restoring only to machines 
with identical hardware configurations.

Be aware that your hard drive jumpers must be set up so that you have a master drive and 
a slave drive. DeployCenter will report incorrect drive information if the jumpers are set 
up in a cable select configuration.

Any discussion of deployment, including hard-disk imaging, assumes that the software, 
including the operating system, is being copied in accordance with the license agreement 
with the software manufacturer.

ImageCenter and Windows NT/2000/XP

There are some special considerations if you are using ImageCenter to copy Windows NT, 
Windows 2000, or Window XP partitions or to clone Windows NT/2000/XP machines.
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Copying Windows NT Partitions

If you are using ImageCenter to copy Windows NT, Windows 2000, or Windows XP 
partitions (where Windows is installed), you may experience problems related to the 
BOOT.INI file. The BOOT.INI file includes information about the boot options for 
Windows’ loader and the order of the Windows partition. If you have used ImageCenter to 
copy a Windows partition, and the partition order has changed from the original order, 
then the BOOT.INI file may not be updated to reflect the new order of the Windows 
NT/2000 operating system files. Therefore, you will be unable to boot your Windows 
partition.

Cloning Windows NT/2000/XP Machines

If you use ImageCenter to clone Windows NT/2000/XP for installation on other machines, 
you must consider the Security Identifier (SID). Improperly cloning a Windows 
NT/2000/XP workstation will result in your having another machine with the same SID, 
which causes an NT/2000/XP server conflict. You can use the Microsoft System 
Preparation Tool (SysPrep) to resolve SID conflicts. Refer to your Microsoft SysPrep 
documentation for information about SysPrep.

Preparation

1 Before creating an image with ImageCenter, use a disk utility program such as a 
thorough ScanDisk or Norton’s Disk Doctor to identify and repair any errors on your 
hard disk.

Under Windows NT, Windows 2000, or Windows XP, run CHKDSK /F.

2 You may also choose to run a disk defragmenting utility to further optimize your hard 
drive.

If you are running under Windows 98 or Windows NT Workstation, refer to the 
Microsoft documentation on running the Microsoft Windows 98 Preparation Tool or 
the Windows System Preparation Tool (SysPrep).

3 You should disable virus detection in the BIOS before creating an image file.

If virus protection is enabled, ImageCenter may hang after you click Finish or 
incorrectly report a virus when you reboot.

4 Check to ensure that the drive where you want to create an image is available under 
DOS. You can see the available drives by clicking Browse at the Name Image File 
screen. (See step 6 on page 41 for additional information.) You may need to set up 
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removable media or create boot disks to access network drives before you can create 
an image. See “Overview” on page 10 for information about using Boot Disk Builder 
to create boot disks to access network drives.

Creating Image Files on CD-R or CD-RW

ImageCenter enables you to create image files directly on CD media. However, you must 
meet the following requirements, or your CD-R/CD-RW drive will not be available as a 
destination for an image file.

• You must have an MMC2-compliant IDE or SCSI CD-R or CD-RW drive. USB and 
FireWire CD-R/W drives are not supported, and drives connected via a parallel port 
are not supported.

• Load HIMEM.SYS in your CONFIG.SYS file.

• Do not load EMM386.EXE in your CONFIG.SYS file.

• CD-RW media must be blank but not formatted. You cannot save more than one 
image file to a single CD or create an image on a CD that already contains other data. 
If you reuse CD-RW media, you must perform a Full Erase, not a Quick Erase, before 
saving image files to the media. CD-RW media that has been quick erased may cause 
ImageCenter to return errors when creating the image file.

Be aware that sometimes when you create image files on CDs, ImageCenter cannot write 
data fast enough to keep the CD burner working continually. Consequently, ImageCenter 
may create many image files. If this happens, you will see files ending with .PQI, .002, 
.003, and so forth. The image will still work as designed to back up your data. If the image 
spans more than one CD, you may wish to browse them after the image is created and note 
which files are on each CD. Then during the restore, when ImageCenter prompts you to 
insert “PQI.012” (for example), you will know which CD that file resides on and insert the 
proper CD to continue the restore process.

If you experience slow burning speeds (20MB/minute or slower), you may wish to switch 
to Gold media. Gold media may increase burning speeds from 2x to 4x.

When you create an image file directly to a CD, the CD is bootable. You can use the CD to 
recover your system if your computer becomes unbootable.

Creating an Image File 

1 Run a thorough ScanDisk on your drives before imaging them.

2 At the ImageCenter main screen, click Create Image.
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The Select Source Drive screen appears.

3 Select the disks that include the partitions you want to include in the image file.

You can click All Disks to select partitions from every hard disk on your machine.

The Select Source Partitions screen appears. It displays all the partitions on the disks 
that you selected. The partition map near the top of the screen is a graphic display of 
your hard disk. It includes a blue indicator for the 2 GB boot code boundary and a 
black indicator for the 1024 cylinder limit. The indicators can be useful when you are 
creating partitions that need to be bootable, since many operating systems require that 
boot code be located somewhere within the first 2 GB of the disk. 

4 Select the partitions you wish to include in the image file (the source partitions) from 
the partition list, or click Select All to automatically select all partitions.

You may need to scroll to view all the partitions on your machine. Note that if you 
have more than one hard disk on your machine, the first column in the partition list 
shows the physical hard disk where the partition is located.

To deselect partitions, click again on a partition or click Select None to deselect all 
partitions at once.

5 Click Next.

6 Type the desired path and image filename in the Image File field (for example, 
D:\MYIMAGE.PQI).

You must save your image file to a partition that you are not including in your image 
file. You can click Browse to find the directory where you want to save the image 
file. You should click Browse to select a CD-R or CD-RW drive because you cannot 
just type the CD-R drive letter to save an image to CD. CD drives will appear in the 
list as \\.\pqcdx\name of drive, where x is the number of the CD drive.

An image must be saved to a FAT, FAT32, or NTFS partition if you are going to 
restore it when running from the ImageCenter rescue diskettes.

You can save an image to a hidden FAT partition or to an NTFS or FAT32 partition 
that has not been assigned a drive letter by choosing it from the New Image File 
dialog box that appears when you click Browse. A hidden FAT partition or an NTFS 
or FAT32 partition will appear in the Drives list as \\.\Diskn.Partm, where n is the 
number of the disk and m is the number of the partition on that disk. For example, if 
an NTFS partition were the third partition on the first disk, it would appear as 
\\.\Disk1.Part3. To further identify the partition, the volume label will display, if 
available.
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IMPORTANT! Do not include spaces or extended characters in the filename, or you 
may not be able to access the image file from ImageCenter, DOS, or 
ImageExplorer.

IMPORTANT! If you are creating an image on CD-RW media, the media must be 
empty but not formatted. You cannot save more than one image file to 
a single CD or create images on CDs that already contain other data.

You may need to create DOS boot diskettes to access network drives while running 
ImageCenter. See “Creating DOS Boot Disks for NetWare” on page 11 or “Creating 
DOS Boot Disks for Microsoft TCP/IP” on page 15 for additional information.

You cannot save images to local Linux partitions.

Make sure there is no existing file with the same name, unless you want the existing 
file to be overwritten. ImageCenter uses .PQI as the default image filename 
extension.

If an image is split because it exceeds 2 GB in size or to span media, the first segment 
of the image file will have the name you specify. Subsequent segments will have 
.002, .003, etc. extensions.

7 (Optional) Type brief comments about your image file in the Image File Comments 
field.

Image file comments cannot exceed 232 characters. ImageCenter will automatically 
insert information about the drive, partition, and label in the image file properties.

8 Click Next.

9 Select the desired compression level.

ImageCenter estimates the size of the image file for each level of compression. If you 
are creating an image file on removable media, ImageCenter also estimates the 
number of media that will be required to save the image file. The numbers displayed 
are only estimates; the actual size for compressed images will vary according to how 
well the data on the disk compresses.

Be aware that if you create an image file that is larger than 2 GB, it will automatically 
be split into multiple files (segments).

• No Compression is usually the fastest method for creating an image file and is 
useful if storage space is not an issue. However, if you are saving your image file 
to a busy network drive or to a relatively slow removable media device, high 
compression may be faster than no compression since there is less data to write to 
the file. ImageCenter selects No Compression by default.
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• Low compression offers a 40% average compression ratio.

• High compression offers a 50% average compression ratio.

You cannot read compressed ImageCenter images with Symantec Drive Image or 
Drive Image Pro.

10 Click Next.

ImageCenter displays all the information you have entered to this point. 

To modify any settings, click Back.

11 (Optional) Click Advanced Options to split an image file into multiple files (for 
removable media), to disable file system error-checking or SmartSector copying, to 
password protect your image file, to verify the integrity of the image file after it is 
created, or to verify disk writes.

See “Advanced Options” on page 44 for additional information.

12 Click Finish to begin creating the image file.

If you entered a name of a current file (step 6), ImageCenter displays a message that 
<path and filename> already exists. You can replace the existing file or choose a new 
filename. If you click Replace, the existing image file will be deleted immediately.

If ImageCenter detects that you are saving your image file to a floppy drive or 
removable media, it enables a media-spanning feature that spreads the image file over 
a series of disks. You must have at least 128K of available space on each disk in the 
series. If you use the media-spanning feature, be sure to number the disks in order, 
since you must insert them in sequence when restoring the image file.

The Creating the Image dialog appears.

Upon completion, the following message appears: “Image was copied successfully to 
file: <image filename>.”

If you created the image on CD media, the CD is bootable. If you experience a system 
crash that renders your computer unbootable, you can boot from the image CD and 
restore the image file to fix your system.

13 Click OK to return to the ImageCenter main screen.

IMPORTANT! Because operating system conflicts can result from different hardware 
configurations, you should not restore the image you just created on a 
system with different hardware.
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Advanced Options

The Create Image Advanced Options dialog appears when you click Advanced 
Options at the Ready To Create Image File screen.

Select this: To do this:

Check for File System 
Errors

Clear the Check for File System Errors check box if you 
want to disable error checking.

If you have already used a disk utility program such as 
ScanDisk to check your hard disk for errors, it is not 
necessary to have ImageCenter check for file system errors. 
Clearing Check for File System Errors saves time in 
copying the partitions.

If you did not run a disk utility program before loading 
ImageCenter, leave the Check for File System Errors 
check box selected. Be aware that ScanDisk finds more 
errors than the Check feature in ImageCenter.

Disable SmartSector 
Copying

ImageCenter’s SmartSector technology speeds up the 
copying process by only copying clusters and sectors that 
contain data. However, in some cases, such as high-security 
environments, it may be desirable to copy all clusters and 
sectors in their original layout, whether or not they contain 
data.

If you wish to copy both used and unused clusters and 
sectors, click Disable SmartSector Copying. Disabling 
SmartSector Copying increases processing time and image 
file size.

Verify Disk Writes Select this option if you want ImageCenter to verify that 
data is being written to disk. Verifying disk writes is not 
necessary and can slow image file creation substantially.

If you are creating an image file to CD-R/W, this option is 
selected by default and performs a different function. After 
burning the image file to a CD, ImageCenter will check to 
see that the image file can be read from the CD. If there is a 
problem with the image, you will have an opportunity to 
recreate it. Having this option selected for CD-R/W does not 
affect the speed of image file creation or the size of the 
image file.
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Verify Image Contents If you select this option, ImageCenter:

• Checks to see that all of the files in the image are 
available for you to open.

• Checks to see that the internal data structures in the 
image file match the data that is available.

• Checks to see that the image file can be uncompressed 
and create the expected amount of data.

• Checks that the data in the image file you created 
matches the contents of the disk that was just imaged.

ImageCenter reports whether the image file passes or fails 
the integrity check.

Password Protect 
Image File

To password-protect your image file, click Password 
Protect Image File and type a password in the Password 
field. Passwords are case-sensitive. To change or undo a 
password, use ImageExplorer. For more information, see 
“Adding a Password to an Image” on page 98.

IMPORTANT! Store image file passwords in a safe place. If 
you forget the password, you cannot restore 
the file.

Split Image File Into 
Multiple Files

If you plan to copy an image file to removable media after 
creating it, you can force ImageCenter to split a large image 
file into smaller files. To do so, click Split Image File Into 
Multiple Files and enter the maximum byte size for each 
file in the File Size (bytes) field. To save the files to CDs, 
specify a file size of 670,000,000 bytes (approximately 650 
MB) or less. The minimum is 10 MB.

Select this: To do this:
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Overview

This chapter describes restoring an ImageCenter file to a different drive or partition. 

IMPORTANT! If you create an image on one machine and restore the image on a machine 
with a different configuration (for example, a different motherboard or 
video card), the operating system may not boot correctly. Therefore, we 
recommend restoring only to machines with similar hardware 
configurations. If you created an image for use on multiple machines, be 
aware that you must run SysPrep before creating the image on the source 
machine. Then when you restore the image, SysPrep will run according to 
the settings you specified in the answer file.

Related Tasks
• To restore selected files from a compressed or spanned image file, see “Restoring 

Individual Files or Partitions” on page 101.

• If you are restoring an image file to set up a new hard drive on a machine with a BIOS 
older than 1994, see “Using ImageCenter with Drive Overlay Software” on page 205.

• If you want to restore images to multiple machines simultaneously across an Ethernet 
or Token Ring network, see “PowerCasting” on page 59.

Restoring Primary Domain Controllers

Exercise caution when restoring an imaged Primary Domain Controller. ImageCenter will 
automatically convert a PDC (Primary Domain Controller) to a BDC (Backup Domain 
Controller) when you restore the image file. If you want the restored image to be the PDC, 
you must promote a BDC to a PDC before restoring the image. Then restore the image. 
The image will be restored as a BDC. Next, promote the restored image server to become 
the PDC; when you do so, the previously promoted PDC will be demoted back to a BDC.

Restoring Images from CD Drives

If you created an image file directly to CD media, the CD containing the image is 
bootable. (For spanned images, any CD in the series is bootable.) If your system becomes 
unbootable, you can boot from the image CD and restore the image to fix the system 
problem. If you created an image on a hard disk and then copied the image to CD media, 
the CD media is not bootable.
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When you click Browse at the Select Image File screen, your CD drive will display as 
\\.\pqcdx, where x is the number of the CD drive. Select the drive, and the image file will 
display so you can restore it.

Your CD drives may also display with drive letters. However, you should not choose the 
drive letter. Instead choose the \\.\pqcdx designation.

Be aware that sometimes when you create image files on CDs, ImageCenter may break the 
image into many segments. If this happens, your CD will include image files ending with 
.PQI, .002, .003, and so forth. The image will still work as designed to back up your data. 
If the image spans more than one CD, you may wish to browse them after the image is 
created and note which files are on each CD. Then during the restore, when ImageCenter 
prompts you to insert “IMAGE.012” (for example), you will know which CD that file 
resides on and insert the proper CD to continue the restore process.

Bootable Partitions

Before restoring a bootable partition, you should understand the information outlined in 
the following table. A bootable partition must begin below the boot code boundary 
specified in the table below for the operating system to boot. The boot code boundary is a 
boundary on the disk, not a restriction on partition size. For additional information about 
operating system requirements, contact the operating system manufacturer.

Operating System Boots from 
Supported 
Partition Types

Boot Code 
Boundary

Minimum 
Space

DOS 6.22 and 
earlier

Primary FAT 2 GB 8 MB

Windows 95 Primary FAT, FAT32* 8 GB 90 MB

Windows 98 Primary FAT, FAT32 >8 GB 175 MB

Windows Me Primary FAT, FAT32 >8GB 295 MB

Windows NT Primary** FAT, NTFS 2 GB*** 125 MB

Windows 2000 Primary** FAT, FAT32, 
NTFS

>8 GB 1 GB

Windows XP Primary** FAT, FAT32, 
NTFS

>8 1 GB
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* A FAT32 partition is only accessible from Windows 95 if you have a version OSR2 
(4.00.950B) or above.

**Windows NT, Windows 2000, and Windows XP must boot from a primary partition on 
the first drive. However, only a few Windows NT/Windows 2000 files must reside on that 
partition; the remaining files can reside on a logical partition, which can be located on the 
first or a subsequent drive. The Windows NT/Windows 2000 boot partition can be shared 
with another operating system.

***Microsoft recommends putting the Windows NT partition within the first 2 GB of the 
drive, ending before the 1024 cylinder limit (about 7.8 GB).

Restoring an Image File

1 Disable virus detection in the BIOS.

If virus protection is enabled, ImageCenter may hang after you click Finish or 
incorrectly report a virus when you reboot.

2 At the ImageCenter main screen, click Restore Image.

If you booted your computer from a CD containing the image, the main screen does 
not display, so you begin with step 3.

3 In the Image File field, enter the path and filename of the image file you want to 
restore, or click Browse to select the path and image file.

If you assigned a password to the image file when you created it, the Get Image File 
Password dialog appears. You must enter the password to restore the image file. 
Symantec does not maintain image file passwords or have a workaround for restoring 
password-protected images without the password.

If you are restoring a Primary Domain Controller, refer to “Restoring Primary 
Domain Controllers” on page 48. If you are restoring an image from a CD, refer to 
“Restoring Images from CD Drives” on page 48.

You need to run ImageCenter from DOS network boot diskettes to access network 
drives while running ImageCenter. See “Creating DOS Boot Disks for NetWare” on 
page 11 or “Creating DOS Boot Disks for Microsoft TCP/IP” on page 15.

Linux (LILO) Either Linux Ext2 8 GB 250 MB

Operating System Boots from 
Supported 
Partition Types

Boot Code 
Boundary

Minimum 
Space
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You can restore an image from a hidden NTFS, FAT, or FAT32 partition by choosing 
it from the Open Image File dialog box that appears when you click Browse. A 
hidden NTFS partition will appear in the Drives list as \\.\Diskn.Partm, where n is the 
number of the disk and m is the number of the partition on that disk. To further 
identify the hidden partition, the volume label will display, if available.

If you click Browse and select an image file, you will have an option to verify the 
integrity of an image file before you attempt to restore it. Click Verify, and 
ImageCenter will check to see that all of the files in the image are available for you to 
open, the internal data structures in the image file match the data that is available, and 
the image file can be uncompressed and create the expected amount of data. 
ImageCenter reports whether the image file passes or fails the integrity check.

If you are running ImageCenter from rescue diskettes, you can restore image files 
from FAT, FAT32, or NTFS partitions.

4 Click Next.

At any point prior to actual image file restore, you can click Back to return to the 
previous step and change your settings.

5 From the Select Destination Drive dialog, select the disk that includes the 
unallocated space or partitions where you want to restore the image file.

If you only have one hard disk, this step is omitted.

6 If you have more than one partition, you can select the partitions you want to restore. 
(If you have only one partition, this step is omitted.) Click partitions to select them 
individually, or click Select All.
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To deselect partitions, click again on a partition or click Select None.

7 Click Next.

8 Select an existing partition or unallocated space where you want to restore the image.

The partition list includes all the partitions on your machine. If you have more than 
one hard disk, the first column in the partition list shows the disk on which a partition 
is located.

Drag column 
borders to resize 
columns.
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When you restore an image to unallocated space, ImageCenter creates a new partition 
for the image. The unallocated space where you restore an image must be at least as 
large as the used space required by the image. For example, if you created an image of 
a 500 MB FAT32 partition that included 300 MB of data, the unallocated space where 
you restore the image must be at least 300 MB. In addition, if you are restoring an 
NTFS partition, it cannot be resized below the master file table (MFT), regardless of 
how much data is included in the partition. The MFT is generally near the midpoint of 
the partition.

If the destination partition or unallocated space is not large enough to accommodate 
the partitions you wish to restore, or if you are restoring the image file to a larger 
drive and want to set a specific size for partitions rather than use the proportional 
resize option, you may want to resize the partitions.

If you do not want to resize the partitions, go to step 13.

9 Click Resize Source Partitions.

The Resize Partitions window displays, and the Selected Source Partitions group 
box displays the partitions you selected to restore.

10 Click Resize.

The Resize Partition window appears. 

11 In the New Size field, enter the size for the new partition (in MB), then click OK.
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The size you enter must be equal to or larger than the Minimum Size and less than or 
equal to the Maximum Size displayed in the dialog. Since partitions must end on a 
cylinder boundary, ImageCenter rounds the new size up to the next cylinder 
boundary.

12 Click Accept.

When you restore the image file, ImageCenter will resize the partition.

13 Click Next.

If you selected an existing partition as the destination, ImageCenter will display a dialog 
telling you that the existing partition will be deleted before your image file is restored. 
ImageCenter does not delete the partition until you click Finish on the Ready to 
Restore Image File screen.

If the unallocated space on the destination drive is greater than the space required to 
restore the selected partitions, the Resize Options dialog appears. For more 
information, see “Resize Options” on page 57.

ImageCenter displays all the information you have entered to this point. To change 
any settings, click Back. 

14 (Optional) To enable bad-sector checking, turn on DOS disk-write verification, check 
for file system errors, or hide partitions after restore, click Advanced Options. For 
more information, see “Advanced Options” on page 58.

IMPORTANT! Restoring partitions can cause the drive letters of subsequent partitions 
to change. This may make the computer unbootable or cause 
applications to fail.

IMPORTANT! If you are restoring a primary partition that contains an operating 
system, and it will not replace your existing primary partition, you 
must click Advanced Options and choose to hide the partition after 
restoring it. Otherwise, data corruption could occur.

15 Click Finish to begin restoring the image file.

If ImageCenter detects that you are restoring your image file from removable media, 
it enables a media-spanning feature that is capable of reading the image file from a 
series of disks. As ImageCenter prompts you for each media, be careful to insert them 
sequentially.

The Restoring the Image dialog appears, tracking the progress of the image restore. 
Upon completion, the following message appears: “Image was restored successfully.”

16 Click OK to return to the ImageCenter main screen.
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Recovering a Local System Automatically

You can use DeployCenter to create a CD (or set of CDs) for recovering your computer in 
the event of a failure. This is an especially useful process for laptop computers, which may 
need to be recovered when the user is away from the office and needs to have his system 
up and running again quickly. 

Prerequisites
• Access to a partition (other than the partition you are imaging) that is large enough to 

hold the image file you are going to create

• DOS boot diskette created under Windows 98

• CD burning software

• ImageCenter rescue diskettes

Preparing and Creating the Recovery CD

1 Run a disk-checking utility to ensure that your hard disk does not have any file system 
errors.

2 Use ImageCenter to create an image of your system partition. If necessary, split the 
image file into segments, so it will fit on CDs. It is recommended that you split the 
file into segments of 620,000,000 bytes to allow space on the CDs to store additional 
program and boot files that automate the restore process. 

3 Copy the contents of the second ImageCenter rescue disk (the program disk) to a 
folder on your hard disk. 

4 Modify the autoexec.bat file on the Windows 98 boot diskette as follows:

• Locate any lines that contain MSCDEX.EXE, and change the /L: parameter (if 
it exists) on those lines to /L:Z. If the /L parameter is not present on those lines, 
add it. The new parameter assigns a static drive letter to the CD drive, so 
ImageCenter can automatically locate the image files on the auto-recovery CD.

• Add the following lines to the end of the autoexec.bat file (where “Imgctr” is the 
folder where you copied the contents of the ImageCenter program diskette and 
“myimage.pqi” is the name of your image file):
Z:
cd\Imgctr
PQIMGCTR /img=Z:\myimage.pqi /cmd=restore_all
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An autoexec.bat file with the /cmd=restore_all switch restores all the partitions 
within the specified image file, sizing them proportionally to fit on the hard disk. If 
you want more control over the restore operation, you could use the 
/cmd=a:\script.txt switch instead, then create a script file to specify what 
actions to take and save the script file on the Windows 98 boot diskette. See 
“Scripting Commands” on page 156 for information about ImageCenter scripting 
commands.

5 With your CD burning software, create a bootable data CD with a ISO9660 file 
system. You will be prompted for a bootable floppy; use the Windows 98 boot 
diskette. The CD burning software will create a boot image with two files: 
BOOTIMG.BIN and BOOTCAT.BIN and display them in the CD layout pane.

6 Drag the image file (or the first segment of the image file) into the CD layout pane.

7 Drag the folder containing the files from the second ImageCenter rescue diskette into 
the CD layout pane. The following is an example of what the layout might look like if 
you use Roxio’s Easy CD Creator and the ImageCenter files were saved in a folder 
named IMGCTR. 

8 Create the CD.
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9 If your image file includes multiple segments, create an additional CD for each 
segment of the image. Be sure to label each CD in order of its creation. 

Recovering the System with the CD

With the recovery CD (or set of CDs), a user can insert the first CD in the computer and 
reboot. The computer boots to the CD, loads the CD drivers, runs ImageCenter, and 
restores the image. If the image spans multiple CDs, the user will be prompted to insert 
each CD as it is needed.

Resize Options

If the unallocated space on the destination drive is greater than the space required by the 
partitions you are restoring, you have three options for how to handle the extra space.

Click this option: To do this:

Automatically resize 
partitions proportionally to 
fit 

Allow ImageCenter to automatically expand the 
partitions in equal proportions to occupy the destination 
drive’s remaining free space.

Leave remaining unused 
space

Leave any remaining free space unused (unpartitioned) 
on the destination drive after the partitions are restored. 
This option will retain the original partition size.

Resize partitions manually 
to fit

Display the Resize Partition window where you can 
manually set the size of the partitions to fit in the 
destination drive’s remaining free space.

For more information on resizing partitions, see step 9 of 
“Restoring an Image File” on page 50 (beginning of 
steps).
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Advanced Options

At the Ready To Restore Image File screen, click Advanced Options to access the 
following: 

Option: Description:

Check for File 
System Errors

Clear the Check for File System Errors check box to disable 
error checking.

If you leave this option selected, ImageCenter will check your 
disk for errors after restoring the image file.

Skip Bad Sector 
Check

This is selected by default to save time in restoring the image 
file.

Although most drives do not have bad sectors, the potential for 
problems increases during the lifetime of the hard drive. If you 
have an older hard drive, it is wise to enable bad-sector 
checking by clearing the Skip Bad Sector Check box.

Verify Disk Writes Click Verify Disk Writes if you want to enable DOS disk 
write verification. Disk write verification is not critical to 
safely restore image files. Enabling disk write verification can 
slow the image restore process significantly.

Hide Partition After 
Restore

Restoring multiple logical partitions can cause the drive letters 
of subsequent partitions to change. This may make the 
computer unbootable or cause applications to fail.

Most operating systems only allow one primary partition to be 
visible (bootable) at a time. If you are restoring an image of a 
primary partition, and you do not want to make that partition 
your visible (bootable) partition, click Hide Partition After 
Restore. Failing to do so could cause data corruption.

For example, if you are using your secondary hard drive as a 
complete backup of your primary drive, clicking Hide 
Partition After Copy preserves all the secondary drive 
information without changing any drive letters. When the 
computer boots up, a drive letter will not be assigned to the 
hidden partition. For more information about hiding partitions, 
see “Hiding Partitions” on page 196.
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Overview

ImageCenter combines SmartSector imaging technology together with Ethernet or Token 
Ring multicasting to provide a fast and robust method for deploying workstations. 
PowerCasting sends an image file to one or more Symantec PowerCast clients 
simultaneously. The image file is sent only once by the server to all the client computers, 
rather than separately to each client. This decreases network traffic by eliminating 
duplicate restore processes when preparing multiple workstations and when performing 
computer rollouts and migrations.

IMPORTANT! If you have a Token Ring network and an IBM 16/4 ISA Token Ring card, 
you must use the NIC driver for the IBM 16/4 ISA Token Ring network 
cards that is included on the DeployCenter CD. If you use a newer version 
of the driver, the PowerCast Server will lock up when any workstation 
attaches to or is removed from the ring, regardless of whether that 
computer is set up as a PowerCast Client.

IMPORTANT! ImageCenter PowerCasting does not currently support bus networks 
(broadcast networks, based on a single length of cable) or peer-to-peer 
networks.

ImageCenter contains both the PowerCast Server and Client. You can access 
PowerCasting by creating a PowerCast DOS boot disk and running PQPCAST.EXE from 
that disk. 

The PowerCast Server reads the PQI image file and then PowerCasts the image file to the 
PowerCast Client computers. 

If you PowerCast from DOS, the image to be PowerCast should reside on the PowerCast 
Server. If the image file is on the PowerCast Server’s hard disk, the PowerCast Server 
does not need access to the Novell or Microsoft server to PowerCast. The PowerCast 
server can be the same machine as the Novell or Microsoft server, but it does not have to 

Microsoft or Novell Server

PowerCast PowerCast Workstation not
associated with
PowerCasting

Server Client
PowerCast

Client
PowerCast

Client
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be the same machine. (To access an image on a Novell server, the server must be downed 
and booted to DOS.) You can also choose to resize the image file to fit various disk sizes 
on different PowerCast Clients.

The client computers receive and write the image file to the client disks. You must boot 
PowerCast Clients from boot disks that establish them as PowerCast Clients looking for a 
PowerCast session. PowerCast Clients do not have access to the Novell or Microsoft 
server when they are in PowerCast Client mode. Workstations that are on the same 
network but have not been booted as PowerCast Clients do not receive the PowerCast 
image file. See “Building PowerCast DOS Boot Disks” on page 74 for additional 
information.

Using the Windows 32-bit PowerCast Server, you can access image files that reside on a 
Novell or Microsoft server for PowerCasting. However, this may decrease the speed of the 
PowerCast because the PowerCast Server must read and PowerCast the image over the 
same wire, doubling the bandwidth needed.

PowerCasting through Routers

ImageCenter supports PowerCasting through routers. To PowerCast through a router, the 
router must support forwarding of multicast packets.

To set up router support for ImageCenter, each computer involved in the PowerCast 
session (the PowerCast server and all of the clients) must be configured correctly. Each 
boot disk must have a WATTCP.CFG file with the following line:

MCTTL=n 

where n is the number of routers the multicast packet is allowed to pass through.

With the Windows PowerCast Server, you can set the MCTTL in the Advanced Options 
dialog instead of through the WATTCP.CFG file. See “Windows PowerCast Server 
Advanced Options” on page 72.

This MCTTL number should equal the number of routers + 1. MCTTL refers to Multicast 
Time To Live. This is a value stored in the multicast packet that tells the router whether or 
not to forward the packet. When the multicast packet reaches the router, the router will 
subtract 1 from the value. If the MCTTL value is greater than one, the packet will be 
forwarded; if it is one, the router will drop the packet. Therefore, if the multicast packet 
has a TTL set to 1, the first router it reaches will drop the packet. If the TTL is set to 2, the 
packet will pass the first router, and the second router will drop the packet.
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The WATTCP.CFG file must also include a line specifying either a static IP address or 
DHCP. If a static IP address is specified, it must be unique for each computer participating 
in the PowerCast, including the server.

The WATTCP.CFG is an ASCII text file that can be created and copied to a disk. The disk 
can then be duplicated using Diskcopy or can be added to the boot disk during disk 
creation using Boot Disk Builder. To create a boot disk with router support in Boot Disk 
Builder, enter a value in the PowerCast TTL field to specify the number of routers the 
packet can pass through. This will automatically create the WATTCP.CFG file with the 
correct information.

The following is a sample WATTCP.CFG file that will have ImageCenter obtain an IP 
address from a DHCP server and allow the multicast packet past one router:

IP=DHCP
MCTTL=2

NOTE: To support PowerCasting through a router with NetWare, you must have 
Netware 3.12 or later, have TCP/IP support loaded, and load the module 
PIM.NLM (Protocol Independent Multicasting).

NOTE: Windows NT (through Service Pack 6) cannot forward multicast packets.

NOTE: Hardware routers must also be configured to allow multicast packet forwarding. 
Check the manual that came with the router or contact the router manufacturer to 
determine the configuration settings for multicast support.

Assigning IP Addresses

For the ImageCenter PowerCast Server to communicate with each of the client computers 
on the network, the server and each client computer must have a unique IP address. The 
PowerCast Server or Client will request an IP address from a DHCP or BOOTP server, or 
use the IP address specified in the optional WATTCP.CFG file. 

When you start a PowerCast Server or Client, it first looks for a WATTCP.CFG file for its 
IP address.

If there is no WATTCP.CFG file, the PowerCast Server or Client looks for a DHCP server. 
The DHCP server method of assigning IP addresses is preferred because it saves time and 
is more versatile. For example, say you have 100 computers to configure. If you use the 
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WATTCP.CFG method, you will need to build 100 different boot diskettes, each with its 
own IP address in the WATTCP.CFG file. But with DHCP, all the boot disks can be 
identical. Then when each computer boots up, it gets its IP address from the DHCP server.

When you use the Windows PowerCast Server, you must have a DHCP server available. 
The Windows PowerCast Server does not have a BOOTP server.

The PowerCast DOS Server contains a built-in BOOTP server for use where no DHCP 
server is available. The IP address range used by the built-in BOOTP server is specified in 
the PowerCast Server Advanced Options window. Symantec recommends you use 
addresses in the range of 192.168.0.0 through 192.168.255.255 or 172.16.0.0 through 
172.31.255.255. See “DOS PowerCast Server Advanced Options” on page 71 or 
“Windows PowerCast Server Advanced Options” on page 72 for more details.

Valid local subnet IP addresses are specified by the subnet mask. It is common to use a 
mask of 255.255.255.0 to specify that IP addresses in the range 0 through 255 are in the 
subnet and are accessible. For example: if a computer’s IP address is 192.168.2.4 and the 
subnet mask is 255.255.255.0, then all IP addresses from 192.168.2.0 through 
192.168.2.255 are in the same local subnet and are accessible. Any IP addresses outside 
this range are not accessible from this computer.

If the client fails to get an IP address, it will display error #1876 and disable the 
PowerCasting features.

Running the PowerCast Server from DOS

The server operation includes selecting a client mode, naming the session, and selecting 
the image file and partitions to be made available to PowerCast clients. While it is not 
mandatory, you will have better performance with a PowerCast session if you boot the 
PowerCast Server before the PowerCast Clients.

1 Boot your computer from a PowerCast boot diskette that includes the drivers 
necessary for PowerCasting.

See “Building PowerCast DOS Boot Disks” on page 74 for more information.

2 Boot from the PowerCasting boot disk.

The Select PowerCast Mode dialog appears.

3 Click Server then click Next.
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If the driver for your network interface card (NIC) is not properly loaded and 
configured, you will receive error #1864. This error can be caused by ImageCenter 
not having the NIC driver loaded or by invalid configuration settings such as the line 
FRAME ETHERNET_II (for IP PowerCasting) or FRAME TOKEN-RING (for 
Token Ring PowerCasting) missing from the configuration files.

You can see more information about error #1864 on the Symantec web site 
http://service.symantec.com. Search for “1864.” This information is available in 
English only.

4 Select a client mode.

• Click Express if you want to eliminate a decision step on the client side and have 
the image file replace the entire contents of the drive chosen by the client. The 
client does not have to choose a destination partition or free space. This option will 
replace the contents of the entire hard disk, not just a single partition.

• Click Custom if you want to allow the client to choose the destination (partition or 
free space) and partition resize values. 

5 Click Next.

6 Type the name you have chosen for the PowerCast session (for example, SESSION1), 
then click Next.

This name will be used by the clients to select a session to join.

7 Specify the location and name of the image file to be PowerCast during this session, 
then click Next.

You can click Browse to locate the drive and image file. Note that you cannot 
PowerCast images spanned across multiple removable media.

8 If the image file contains more than one partition, the partitions are displayed.

Use one of the following methods to select the part of the image file you want to 
PowerCast: 

• Click the partitions you want to include.
• Click Select All to include the entire image file.
• Click Select None to clear the selections.

After selecting partitions, click Next. The Resize Options dialog appears.

9 Specify how you want to configure the remaining free space on the client computers.

• Click Automatically resize partitions proportionally to fit, if you want the 
selected image file to fill all available space.
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• Click Leave remaining free space, if you want the selected image file to occupy 
equal space and leave the remaining space free.

10 Click OK.

11 You can review your selections. If you want to disable file system checking, enable 
bad-sector checking, turn on DOS disk write verification, hide partitions after restore, 
or specify an IP address range, click Advanced Options.

For more details about options, see “DOS PowerCast Server Advanced Options” on 
page 71.

12 After reviewing selections, click Finish.

The Symantec PowerCast Server dialog appears. You can see how many clients 
have connected to the session and control when you want the session to start. 

13 To begin the restore process when a specified number of clients join the session, 
specify an Autostart client count. To begin the session without waiting for a 
specified number to join, click Start.

Once started, ImageCenter displays the client status, server status, and PowerCast 
image transmission progress.

If ImageCenter returns error 1810, the PowerCast Server and PowerCast Clients 
cannot see each other. The following situations could cause this problem.
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• The TTL value is set incorrectly, so the PowerCast packet is not passing through 
the required number of routers.

• There is a gateway between the PowerCast Server and PowerCast Clients. 
PowerCast packets cannot pass through gateways.

• There are routers set to kill the multicast signal as it passes through a router.

Running the PowerCast Server from Windows

If you have a Token Ring network, you must run the PowerCast Server from DOS. See 
“Running the PowerCast Server from DOS” on page 63. While it is not mandatory, you 
will have better performance with a PowerCast session if you run the PowerCast Server 
before the PowerCast Clients. Also, you can run the PowerCast Server from a server, but 
you will probably have better performance if the PowerCast Server is a client machine.

1 From the Windows Start menu, click Programs > Symantec DeployCenter 5.7 > 
DeployCenter 5.7 Tools > PowerCast Server.

If you are concerned that your PowerCast session will use too much network 
bandwidth, you can start PowerCasting from a command line prompt with the 
/PCTHR switch. See page 134 for details.
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You must run the Windows PowerCast Server on a network with a DHCP server. The 
Windows PowerCast Server does not support the PowerCast BOOTP server. If you 
do not have a DHCP server, you can run the PowerCast server from DOS.

To run the Windows PowerCast Server from Windows 95, you must have WinSock2 
installed. If the version of Windows 95 you are running does not include WinSock2, 
you should go to www.microsoft.com and download the updated software.

2 Type the name you have chosen for the PowerCast session (for example, SESSION1) 
in the Session Name text box.

The session name will be used by the clients to select a session to join.

3 Specify the full path and image filename to be PowerCast during this session. If 
necessary, click the browse button to locate the image file you want.

Note that you cannot PowerCast images spanned across multiple removable media. 

4 If the image file contains more than one partition, each partition is displayed in the list 
box.

Use one of the following methods to select the part of the image file you want to 
PowerCast: 

• In the partitions list box, select the partitions you want to include.
• Click Select All to include all partitions in the image file.
• Click Select None to clear the selections.

5 In the Resize Options group box, specify how you want to configure the remaining 
free space on the client computers.  

6 Select the Client Mode option you want.

If you want the image file to: Click:

Fill all available space Automatically resize partitions proportionally 
to fit

Occupy equal space and leave 
the remaining space free

Leave remaining free space

Express Eliminate a decision step on the client side and have the image file 
replace the entire contents of the hard disk chosen by the client. The 
client does not have to choose a destination partition or free space. Do 
not choose this option unless you are confident you can replace the 
entire contents of the hard disk.

http://www.microsoft.com
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If you are finished setting PowerCast Server options, you can either set advanced options 
before launching the PowerCast session, or you can launch the PowerCast session.

Running the DOS PowerCast Client

The client operation includes logging into a PowerCast session and selecting restore 
options. While it is not mandatory, you will have better performance with a PowerCast 
session if you run the PowerCast Server before the PowerCast Clients.

To run the PowerCast Client from the command line, see “Command Line Operation” on 
page 73.

1 Boot your computer from a PowerCast boot disk.

See “Creating PowerCast Boot Diskettes Manually” on page 77 for information about 
creating boot disks that will work with the graphical user interface (as shown in these 
steps).

If you build a PowerCast boot disk with Boot Disk Builder, the PowerCast Client will 
run from the command line (without the full user interface).

2 At the PowerCasting main screen, click PowerCast.

3 Click Client and then click Next.

The active PowerCast session names are listed in the Available PowerCast Sessions 
box.

If the driver for your network interface card (NIC) is not properly loaded and 
configured, you will receive error #1864. This error can be caused by ImageCenter 
not being able to find an IP address or by invalid configuration settings such as the 
line FRAME ETHERNET_II or FRAME TOKEN-RING missing from the 
configuration files.

4 Select the PowerCast session you want to join. The comments attached to the image 
file are displayed in the Image File Comments window. Click Next.

Custom Let the client choose the destination (partition or free space) and 
partition resize values.
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5 If the session prompts you to select a destination drive, select the physical drive 
where you want to restore the image file, then click Next.

If ImageCenter was not able to get the NIC or NIC driver into multicast mode 
correctly, you will see error #1810. ImageCenter may not be able to PowerCast. 
Check with the NIC manufacturer for multicasting support information.

If you selected Custom on the server and if the drive you have selected contains more 
than one partition or free space, the following dialog appears.

If you did not select Custom on the server, go to step 8.
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6 Select the partition or unallocated space where you want to restore the image file. You 
can also select from the following two options to alter partitions:

• Resize Source Partitions: Lets you specify new sizes for the partitions in the 
received image file. The partitions will be restored to the destination disk and then 
resized to the selected sizes.

• Delete Disk Partitions: Lets you delete partitions on the destination disk.

Review your selections or change them by clicking Back. 

7 When done selecting partitions and options, click Next.

8 To complete the client setup, click Finish.

The Receiving PowerCast Image dialog appears which displays progress of the 
PowerCast session.

9 After the PowerCast session is complete, click Exit.
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DOS PowerCast Server Advanced Options

At the Ready To PowerCast Image File screen, click Advanced Options. 

Select this: To do this:

Check for File System 
Errors

Clear the Check for File System Errors check box if you 
want to ignore file system errors. This may allow a partition 
with file system errors to be PowerCast. However, you 
cannot restore a partition with partition table errors.

Skip Bad Sector Check This is selected by default to save time in restoring the 
image file.

Although most drives do not have bad sectors, the potential 
for problems increases during the lifetime of the hard drive. 
If you have an older hard drive, it is wise to enable 
bad-sector checking by clearing the Skip Bad Sector Check 
box.

Verify Disk Writes Click Verify Disk Writes if you want to enable DOS disk 
write verification.

Disk write verification is not critical to safely restore image 
files. Enabling disk write verification can slow the image 
restore process dramatically.

Hide Partitions After 
Restore

Restoring multiple logical partitions can cause the drive 
letters of subsequent partitions to change. This may make 
the computer unbootable or cause applications to fail.

Most operating systems only allow one primary partition to 
be visible (bootable) at a time. If you are restoring an image 
of a primary partition, and you do not want to make that 
partition your visible (bootable) partition, click Hide 
Partition After Restore. 

For example, if you are using your secondary hard drive as a 
complete backup of your primary drive, clicking Hide 
Partition After Restore preserves all the secondary drive 
information without changing any drive letters. When the 
computer boots up, a drive letter will not be assigned to the 
hidden hard drive.
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Windows PowerCast Server Advanced Options

The Windows PowerCast Server includes several advanced options in addition to the 
options available with the DOS PowerCast Server. 

PowerCast Server 
Options (Server only)

When a network DHCP server or WATTCP.CFG file cannot 
be found, ImageCenter acts as a BOOTP server. These 
options let you specify the IP address range used. You can 
enter a range or use the defaults.

• Start IP Address: Enter the first IP address to be leased 
out to a client (lowest number).

• End IP Address: Enter the last IP address to be leased 
out to a client (highest number).

Option: Description:

PowerCast Maximum 
TTL

Determines how many routers a PowerCast packet can pass 
through before it is killed. The PowerCast TTL field is 
equivalent to the MCTTL value you specify in your 
WATTCP.CFG file if you use the DOS PowerCast Server.

Select this: To do this:
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Command Line Operation

Both the DOS PowerCast Server and PowerCast Client operate from either the graphical 
user interface or from the command line.

PowerCast Server

To start the DOS PowerCast Server from the command line specify:

PQPCAST.EXE /MSN=”session name” /IMG=”image filename”

This will start PowerCasting in server mode and display the server progress screen, wait 
for the specified number of clients to attach, and PowerCast the specified image file. Upon 
completion, the server will wait for additional clients to attach until Close is selected.

PowerCast Client

To start the DOS PowerCast client from the command line specify:

PQPCAST.EXE /MSN=”session name” /DSK=n

This will start PowerCasting in client mode, display the PowerCast client progress screen, 
attach to the specified PowerCast session, delete all partitions on the specified disk, and 
restore the partitions from the image file received from the PowerCast server. Upon 
completion, the computer will reboot.

PowerCast Client boot disks created by Boot Disk Builder execute the commands shown 
above automatically.

Additional command line switches may also be specified to modify the behavior of 
PowerCasting. See“Command Line Switches for PowerCasting (DOS)” on page 135.

Seconds until full 
speed

Determines number of seconds a PowerCast session should 
transmit at reduced speed to allow for proper network 
pruning. The default value is zero (no delay). The value you 
choose will be preserved for future PowerCast sessions.

Network adapter IP 
address

Determines which network adapter will be used during the 
PowerCast session. You can also set this value using the /IP 
switch at startup. See “Command Line Switches for 
PowerCasting (Windows)” on page 132.

Option: Description:
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Building PowerCast DOS Boot Disks

PowerCast client machines must have the necessary NIC drivers and network 
configuration files to receive PowerCast sessions. You can create boot disks for 
PowerCast clients with Boot Disk Builder or manually. Symantec recommends using Boot 
Disk Builder. 

Using Boot Disk Builder to Create PowerCast Boot Diskettes

1 From the Boot Disk Builder main menu, select PowerCast Boot Disks, then click 
Next.

2 Click the start-up mode for ImageCenter, then click Next.

3 Select your network adapter or multiple adapters, and click Next.

You can select multiple NICs. All of the files for those NICs will be copied to the 
boot disk. (There must be enough space on the first disk for all the selected NICs.) At 
boot time, the list of NICs copied is compared to the NIC in the computer. If one 
matches, that driver is loaded and the system is configured for it. Selecting multiple 
NICs for the boot disk enables the disk to be used on computers with different NICs.

Client The Client is the workstation receiving the PowerCast session. If you 
click Client, you must indicate the session name and the hard disk 
number the client will use for PowerCasting.

When a client computer is booted from a PowerCast Client boot disk, 
ImageCenter starts in PowerCast Client mode, connects to the 
designated PowerCast session, and restores the image to the specified 
hard disk. Any existing information on the client hard disk is 
completely erased.

Server The Server is the computer PowerCasting the image to the client 
workstations. When a PowerCast Server is booted from a PowerCast 
Server boot disk, the diskette launches ImageCenter in PowerCast 
Server mode, displays the server progress screen, waits for the 
specified number of clients to attach, and PowerCasts the specified 
image file. When it is finished, the server waits for additional clients 
to attach until you click Close.

You can have the server start automatically by checking this option 
and specifying a session name, image file path and filename, and 
autostart client count.
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You cannot use this method to deploy to laptops because there are incompatibilities 
with the PCBUS or PCMCIA NIC cards.

If your network adapter is not listed, do the following to add it to the list of network 
adapters.

a. Click Add.

b. Enter the location of the driver file (*.INF) for your network adapter. Click the 
browse button to browse the directory tree for the driver file.

The driver .INF file contains information that allows detection of the NIC at boot 
time from a list of multiple selected NICs. Some disks contain multiple .INF files 
(some may be subfolders on the disk). You may have to try selecting different 
.INF files until Boot Disk Builder finds the one with the information it needs. 

c. Select the driver types you need to add: Novell NetWare / PowerCast and/or 
Microsoft TCP/IP, then click Next.

d. Choose one or more adapters from the list, then click Next.

e. Select the NetWare and/or Microsoft TCP/IP drivers.

f. Click Finish.

g. Select the network adapter you are using from the list box, then click Next.

4 Specify your client network properties, then click Next.

5 Select the type of boot disk to build.

Option Description

Obtain an IP 
address from a 
DHCP server

Click Obtain an IP address from a DHCP server if a DHCP 
server is used to assign client IP addresses. On a DHCP server, 
the IP address is leased out temporarily on a first-come, 
first-served basis and increments automatically. The DHCP 
server also provides the subnet mask.

Specify an IP 
address

Click Specify an IP address if there is no DHCP server and you 
need to use TCP/IP on the network. In this case, you must enter a 
static IP address and subnet mask.

Token Ring Select Token Ring if the PowerCast client or server has a token 
ring NIC.

In the PowerCast Maximum TTL text box, specify the number of routers a 
packet can pass through. See “PowerCasting through Routers” on page 61.
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Boot Disk Builder can only write to formatted diskettes. Any existing information on 
the diskette will be lost.

6 By default, Boot Disk Builder uses the operating system's DOS files to build boot 
disk files on Windows 95, 98, or Windows Me systems. On Windows NT or 2000 
systems, Boot Disk Builder builds boot disk files using the Caldera DOS files 
included with Boot Disk Builder.

If you do not want to use Caldera DOS files on your boot disk, do the following:

a. Insert a boot disk that boots to the version of DOS you want to use in building 
your boot disk file.

b. Click Tools > Load DOS Reference Diskette >From A:.

The files from your boot disk will be copied to the REFDISK directory where 
Boot Disk Builder is installed.

If there are too many files to fit on a single floppy disk, you can delete everything 
but CONFIG.SYS and any drivers that are started within the CONFIG.SYS file.

Option Description

Floppy Disk Creates a DOS boot diskette. Choose the drive letter 
where your floppy drive is located. The network and 
PowerCast files may require two diskettes. You will be 
prompted if a second disk is needed

Copy boot disk 
contents to a folder

Temporarily stores the boot files in a folder. This option 
is practical when you want to electronically distribute 
the boot file to other administrators or users. Though the 
file is stored in a folder and can be electronically 
transferred, it must be copied to a floppy disk or burned 
to CD before it can be used. You can use this option to 
create a bootable CD for PowerCast.

Virtual Boot Disk File Writes a fully active boot file to a location other than a 
floppy disk. A virtual boot disk file does not need to be 
launched from a floppy disk. Rather, computers can 
reference this file from any directory location upon 
reboot as if it were using a floppy. 

Virtual boot disk files are used by ImageCenter to boot 
to DOS.
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c. Select Use Reference Disk for DOS files at the bottom of the Boot Disk Builder 
dialog box. 

d. If you are writing your boot disk file to disk, remove your original boot disk and 
insert a formatted disk.

If you do not remove your original disk, Boot Disk Builder will overwrite the files 
on it.

7 (Optional) To save your choices to a configuration file (*.BDC) for later use, click 
File > Save Configuration, type the filename for the configuration file, then click 
Save.

8 Click Back to make any changes, or click Finish to build the boot disk.

In building the boot disk file, Boot Disk Builder copies the DOS system files and the 
boot information to the designated location. Any existing information on the floppy 
diskette or in the designated folder is erased. 

After the boot disk file has been created, you are asked if you want to create another boot 
disk. If you click Yes, Boot Disk Builder creates another boot disk file using the current 
configuration. If the current configuration uses a static IP address, and if you are creating 
the file on floppy disks, Boot Disk Builder auto-increments the assigned IP address on 
each boot disk.

Creating PowerCast Boot Diskettes Manually

The Symantec Boot Disk Builder will not create boot disks that allow simultaneous 
PowerCasting and network connectivity. To simultaneously PowerCast and connect to a 
NetWare server, the network client software must also be properly configured on the boot 
disk. Because of wide variations in interface cards and network configurations, this 
process may vary from the documented steps. You will need to obtain additional help from 
your network administrator. Symantec does not support this process.

You can obtain the NIC drivers from the driver diskette that came with your network card, 
from your network administrator or from the card manufacturer’s web site. The other 
required network client software pieces can be obtained from your network administrator.

NDIS 2.01 NIC Driver

You can create a ImageCenter PowerCast DOS boot disk with your network interface 
card's NDIS 2.01 NIC driver. 
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The following steps outline how to add the network drivers to the ImageCenter 
PowerCasting boot diskette. You need to alter the example configuration and system files 
for use with different network interface cards.

1 Create a ImageCenter PowerCasting boot disk using Boot Disk Builder.

2 Copy the NDIS 2.01 NIC driver from your network interface card diskette to the boot 
diskette.

For example, the 3Com 3x905 NIC driver is found on disk #1 in subdirectory 
\NDIS2\DOS and is named “EL90X.DOS.”

3 Copy the DIS_PKT.DOS and the PROTOCOL.INI files to the boot diskette. These 
files are located on the DeployCenter CD in the ENGLISH\RESCUEME\OS2DOS 
subdirectory.

4 Change the “drivername=” line in the PROTOCOL.INI file [NIC_CARD] section to 
match your NIC's driver name. The following sample is for the EL90X.DOS driver.

Sample PROTOCOL.INI file contents:

[PROTMAN]
drivername = PROTMAN$

[PKTDRV]
drivername = PKTDRV$
bindings = NIC_CARD
intvec = 0x60
chainvec =0x66

[NIC_CARD]
drivername = EL90X$

5 Copy the PROTMAN.DOS, PROTMAN.EXE and NETBIND.COM programs to the 
boot diskette. You can obtain these files from the Windows NT Server 4.0 CD in the 
CLIENTS\MSCLIENT\NETSETUP directory or at the Microsoft FTP site at: 
ftp://ftp.microsoft.com/msclient/

6 Modify the CONFIG.SYS file to look as follows:

DEVICE=HIMEM.SYS
DEVICE=PROTMAN.DOS /I:A:\
DEVICE=DIS_PKT.DOS
DEVICE=xxxxx.(Change to match your NIC driver)
LASTDRIVE=Z 
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7 Add the NETBIND line to the AUTOEXEC.BAT file.

@ECHO OFF
PROMPT $P$G
NETBIND

The following files should now be on the boot diskette.

• Hidden DOS system files: IO.SYS and MSDOS.SYS
• COMMAND.COM
• HIMEM.SYS
• CONFIG.SYS
• AUTOEXEC.BAT
• xxxxxx.DOS (NDIS network card NIC driver, must match your card.)
• DIS_PKT.DOS
• PROTMAN.DOS
• PROTMAN.EXE
• NETBIND.COM
• PROTOCOL.INI

8 On the ImageCenter PowerCasting diskette, you can create a PQPCAST.BAT file to 
start ImageCenter PowerCasting and, optionally, specify command line switches.

To start ImageCenter PowerCasting in user interface mode, type PQPCAST, then use 
the interface to select Server mode and options.

To start ImageCenter in PowerCast Client mode, you must specify the disk number 
and the PowerCast session name. Specify the disk number with the /DSK=n 
command line switch. Warning! The entire disk will be erased. Specify the 
PowerCast session name with the /MSN=nnnnn command line switch. The session 
name specified must match the name used by the server. For example:

PQPCAST /DSK=1 /MSN=SESSION 

9 Skip this step if a DHCP server is available on the network segment that will be used 
for PowerCasting or if you don’t want to use the ImageCenter BOOTP server.

If no DHCP server is available on the network segment, create a WATTCP.CFG file 
on the boot diskette to specify the IP address for this computer to use.

WATTCP.CFG file should contain:

IP = 192.168.1.xxx
NETMASK = 255.255.255.0

IP is the workstation's unique IP address. NETMASK is the proper network mask.
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The second diskette should now contain the following files:

10 Use the first diskette to boot DOS. Then insert the second diskette, and type 
PQPCAST at the command prompt to start PowerCasting. 

If all the files will fit on one diskette, you can copy the files from disk #2 to disk #1 
and edit the AUTOEXEC.BAT file to automatically start PowerCasting.

ODI/MLID NIC Driver

This section explains how to create a ImageCenter PowerCast DOS boot disk with your 
network interface card's ODI/MLID NIC driver.

Use Boot Disk Builder to create an ImageCenter PowerCasting boot disk. The following 
steps outline how to add the network drivers to the boot diskette. You need to alter the 
example configuration and system files for use with different network interface cards.

1 Copy the ODI/MLID NIC driver from your network interface diskette to the boot 
diskette.

For example, the 3Com 3x905B NIC driver is found on disk #1 in subdirectory 
\NWCLIENT and is named 3C90X.COM.

2 Copy the LSL.COM program to the boot diskette.

LSL.COM can be obtained from your network administrator, information systems 
technician, or from the Novell Web site at: www.novell.com/download

Get the Novell® Client™ v2.6 for DOS and Windows 3.1x, unzip the DW26EN.ZIP 
file, and copy the LSL.COM file from the \NIOS subdirectory.

3 Modify the CONFIG.SYS file to look as follows:

DEVICE=HIMEM.SYS
LASTDRIVE=Z

4 Modify the AUTOEXEC.BAT file to look as follows: 

@ECHO OFF
PROMPT $P$G
LSL (Loads LSL program)
3C90X (Loads ODI driver)

• MOUSE.COM
• PQPCAST.EXE
• PQPCAST.OVL

• PQDPLCTR.RTC
• PQPCAST.BAT (Optional)
• WATTCP.CFG (Optional)
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5 Create a NET.CFG file with the following contents: 

LINK SUPPORT
BUFFERS 6 1600 (Ethernet) or BUFFERS 4 4200 (Token Ring)
LINK DRIVER 3C90X (Change to match your network card driver.)
FRAME ETHERNET_802.2 (Ethernet only)
FRAME ETHERNET_II (Ethernet) or FRAME TOKEN-RING (Token Ring)

The FRAME ETHERNET_II or FRAME TOKEN-RING line is required for 
PowerCasting.

The following files should now be on the boot diskette:

• Hidden DOS system files: IO.SYS and MSDOS.SYS
• COMMAND.COM
• HIMEM.SYS
• CONFIG.SYS
• AUTOEXEC.BAT
• 3C90X.COM (ODI/MLID network card NIC driver, must match your card.)
• LSL.COM
• NET.CFG

6 On the ImageCenter PowerCasting boot disk, you can create a PQPCAST.BAT file to 
start ImageCenter PowerCasting and, optionally, specify command line switches.

To start ImageCenter PowerCasting in user interface mode, type PQPCAST then use 
the interface to select Server mode and options.

To start ImageCenter PowerCasting in Client mode, specify both the disk number and 
the PowerCast session name. Specify the disk number with the /DSK=n command 
line switch. Warning! The entire disk will be erased. Specify the PowerCast 
session name with the /MSN=nnnnn command line switch. The session name 
specified must match the name used by the server. For example:

PQPCAST /DSK=1 /MSN=SESSION1

7 Skip this step if a DHCP server is available on the network segment that will be used 
for PowerCasting or if you don’t want to use the ImageCenter BOOTP server.

If no DHCP server is available on the network segment, create a WATTCP.CFG file 
on the boot diskette to specify the IP address for this computer to use.

WATTCP.CFG file contents:

IP = 192.168.1.xxx
NETMASK = 255.255.255.0

IP is the workstation's unique IP address. NETMASK is the proper network mask.
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The second diskette should now contain the following files: MOUSE.COM, 
PQPCAST.EXE, PQPCAST.OVL, PQDPLCTR.RTC, PQPCAST.BAT (Optional), 
WATTCP.CFG (Optional).

8 Use the first diskette to boot DOS. Then insert the second diskette, and type 
PQPCAST at the command prompt to start PowerCasting.

If all the files will fit on one diskette, you can copy the files from disk #2 to disk #1 
and edit the AUTOEXEC.BAT file to automatically start ImageCenter.

Booting With PowerCast Boot Diskettes

When a client computer is booted from a PowerCast Client boot diskette, ImageCenter 
will start in PowerCast Client mode, connect to the PowerCast session you named, and 
restore the image to the hard drive you specified. This will completely erase any existing 
information on the affected hard drive.

When a PowerCast Server is booted from a PowerCast Server boot diskette, ImageCenter 
will start in PowerCast Server mode and display the server progress screen, wait for the 
specified number of clients to attach, and PowerCast the specified image file. Upon 
completion, the server will wait for additional clients to attach until you click Close. 
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Overview

The Unicast feature lets you create and restore images using a network drive without 
mapping the drive. It consists of a Unicast server and a Unicast client, which reside on 
separate machines. You can specify all Unicast parameters on the command line of either 
the server or the client. Unicast operations are all point-to-point and use TCP/IP protocols.

The Unicast server must be started prior to running the Unicast client or before trying to 
PXE-boot a client machine. Once the server has been started, you do not need to tend to it. 
You start all Unicast operations from the client by using a standard script file or the 
ImageCenter interface. 

Running the Unicast Server

The Unicast server is a standalone program that runs on Windows as a Windows NT 
service or as an executable in the background. It does not have to run on a Windows 
server; it can run on a workstation. It is an image server, meaning that it provides a server 
interface for images and lets images be created and restored.

The command line switches you specify determine the mode of the server (whether the 
server runs as an executable or as a service). The parameters vary depending on the mode 
of the server.

Running the Unicast Server as an Executable

You run the Unicast server from its current location by typing the command line below at 
a DOS prompt. You can assign any of the optional switches. Command line switches can 
be specified in any order and can begin with a slash (/) or a dash (-).

Syntax
Ucservice.exe /port <port number> /imagedir <image server 
path> /logfile <logfile path> /logsize <logfile size> 

Command 
Line Switch Description

/port Specifies the port the server Ucservice.exe is to monitor. This must be 
a valid TCP/IP port number. This defaults to port 50137. 

Example
Ucservice.exe /port 50137



Symantec DeployCenter 85

Running the Unicast Server as a Service

To run the Unicast server as a service, copy the executable (Ucservice.exe) to the desired 
install folder and execute it using the service switches listed below, followed by any 
desired execution parameters. To run this service, you must be logged in and have 
administrative privileges. 

/imagedir Specifies the path name to the image server top-level directory. This 
lets the Unicast client supply a relative path name rather than a 
complete path name when identifying the image location on the 
Unicast server.

This parameter can specify a partial path to the final subdirectory of the 
image file. If the parameter specifies the complete path to the image 
directory, the client only needs to supply the .PQI filename. If the path 
includes a long filename with spaces, quotes must be placed around the 
path.

Example
Ucservice.exe /imagedir D:\PQI

/logfile Specifies the path (including the filename) of the logfile, if you want 
logging. A logfile is a text file that contains log entries of events that 
occur as the code executes, and are mainly used for debugging.

Example
Ucservice.exe /logfile D:\Temp\Logfile.txt

/logsize Specifies the size of the logfile in bytes. You can use K (or k) notation 
or the M (or m) notation to specify “X 1024” (kilobytes) or “X 1024 X 
1024” (megabytes) respectively. The default logfile size is 128K, but 
for the default size to be used, the /logfile parameter must be specified 
and be valid.

Example
Ucservice.exe /logfile D:\Temp\Logfile.txt 
/logsize 1M

Command 
Line Switch Description
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Syntax
Ucservice.exe /service /startup [auto|demand] /user 
[account] /password [password] <execution parameters> 

The execution parameters are described under “Running the Unicast Server as an 
Executable” on page 84. The parameters you specify are saved in the registry and used 
when the service actually starts. 

Unregistering the Unicast Server as a Service

1 From a DOS box, navigate to the install location.

2 Type UcService /unregserver.

This parameter unregisters the service and cleans up the registry.

Creating Unicast Client Boot Disks

You can create Unicast client boot disks for connecting to a Unicast image server. Unicast 
boot disks are recommended for PXE applications. When you create the boot disks, you 
can specify the Unicast server to connect to and the driver to use (UNDI or Microsoft 
TCP/IP NDIS). 

IMPORTANT! When you create disks with Boot Disk Builder, start with a clean, 
formatted disk.

Command 
Line Switch Description

/service Registers the Unicast server as a service. If the service has already 
been installed and is executed again with /service, it first uninstalls 
the previous settings and then reinstalls itself.

/startup Registers the Unicast server as service to either start automatically 
(auto) at boot time or manually on demand (via Services). The 
default startup mode is on demand (manual). 

/user When used with /password parameter, /user runs the service as 
something other than LocalSystem (default). 

/password When used with the /user parameter, /password runs the service as 
something other than LocalSystem (default).
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Before creating Unicast boot disks, you must have the Microsoft Client files installed. See 
“Installing Microsoft Client Files” on page 10. 

1 From the Boot Disk Builder main menu, click Unicast Boot Disks, then click Next. 

2 Click By Name and specify the name of the Unicast Image server, or click By IP 
Address and specify the IP address of the Unicast Image server, then click Next.

3 Select a network adapter type. 

Option Description

UNDI Driver (PXE) Click UNDI Driver (Universal Network Driver Interface) 
if you intend to boot the client computer from a PXE 
server. Then click Next. 

A virtual floppy disk file (.VFD) is created which you can 
then place on the PXE server. Use the Symantec PXE 
Configuration Utility to add the virtual floppy to the user’s 
PXE boot menu.

Microsoft TCP/IP Click Microsoft TCP/IP, then click Next. Then select the 
Microsoft NDIS (Network Driver Interface Specification) 
driver you need. 

If your network adapter is not listed, see “Adding a NIC to 
the Network Adapter List” on page 19. 
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4 Specify the location and any optional command line parameters for ImageCenter.

The Microsoft TCP/IP Boot Disk automatically boots a network workstation to 
ImageCenter. Therefore, you must indicate where it can find the ImageCenter 
program files. 

5 Click Next.

6 Specify the client network properties, then click Next.

Boot Disk Builder does not support token ring NICs on Microsoft TCP/IP networks. 

7 Select the type of boot disk to build. 

Option Description

Obtain an IP address from a 
DHCP server

Click Obtain an IP address from a DHCP server 
if a DHCP server is used to assign client IP 
addresses. On a DHCP server, the IP address is 
leased out temporarily on a first-come, first-served 
basis and increments automatically. The DHCP 
server also provides the subnet mask.

Specify an IP address Click Specify an IP address if there is no DHCP 
server and you need to use TCP/IP on the network. 
In this case, you must enter a static IP address and 
subnet mask.

Option Description

Floppy Disk If you are creating a DOS boot disk, click Floppy Disk, 
then choose the drive letter where your floppy disk is 
located. 

This option is not available if you chose UNDI Driver 
(PXE) as the network adapter type. 

Boot Disk Builder can only write to a formatted disk. 
Any existing information on the disk will be lost. 

The network and ImageCenter files may require two 
disks. You will be prompted if a second disk is needed.
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8 By default, Boot Disk Builder uses the operating system’s DOS files to build boot 
disk files on Windows 95/98/Me systems. On Windows NT/2000/XP systems, Boot 
Disk Builder builds boot disk files using the Caldera DOS files included with Boot 
Disk Builder.

If you want to use a specific set of DOS files in building your boot disk, see steps 7a - 
7d on page 14.

Copy boot disk 
contents to a folder

Click Copy boot disk contents to a folder if you want 
to temporarily store the boot file in a folder.

This option is practical when you want to electronically 
distribute the boot file to other administrators or users. 
Though the file is stored in a folder and can be 
electronically transferred, it must be copied to a floppy 
disk or burned to CD before it can be used. 

This option is not available if you chose UNDI Driver 
(PXE) as the network adapter type.

You can use this option to create a bootable CD-ROM 
for ImageCenter.

Virtual Boot Disk file Click Virtual Boot Disk file to write a fully active boot 
file to a location other than a floppy disk. 

A virtual boot disk file does not need to be launched 
from a floppy disk. Rather, computers can reference this 
file from any directory location upon reboot as if it were 
using a floppy. 

This option is selected by default if you chose UNDI 
Driver (PXE) as the network adapter type.

Virtual boot disk files are used by ImageCenter to boot to 
DOS. 

Be aware that some rare instances NICs are deinitialized 
when you reboot with a virtual floppy. You can work 
around this problem by using the NIC’s diagnostic utility 
in the AUTOEXEC.BAT file to initialize the NIC.

Option Description
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9 (Optional) To save your choices to a configuration file (*.BDC) for later use, click 
File > Save Configuration, type the filename for the configuration file, then click 
Save.

10 Click Back to make any changes, or click Finish to build the boot disk.

In building the boot disk file, Boot Disk Builder copies the DOS system files and the boot 
information to the designated location. Any existing information on the floppy disk or in 
the designated folder is erased. 

Running the Unicast Client 

The Unicast client runs on DOS from a client machine. It can also be PXE-booted onto a 
client machine as part of a virtual floppy image and then executed to pull down a PQI 
image from the Unicast server. The Unicast client command line is simply the 
ImageCenter command line. 

To access the Unicast client features from within ImageCenter, the runtime configuration 
file, PQImgCtr.rtc, must be present in the directory from which PQImgCtr is run.

Syntax
PQImgCtr.exe {/img=<image location and filename> 
/cmd=<script path name>} [/upn=51225] [/uis=dev-PC12]

Unicast Client Command Line Switches  

Command Line 
Switch Description

/IMG Identifies the image location and filename. It consists of three 
parts: 1) the name of the Unicast name space within PQImgCtr, 
that is, "\\.\imgsrv", 2) the Unicast server machine name or IP 
address, and 3) the remote path name. If the Unicast server 
command line specified the “imagedir” execution parameter, the 
“remote path name” part (part 3) specifies the rest of the path, 
including the image filename. Otherwise, it specifies the complete 
path on the Unicast server.
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Examples
PQImgCtr.exe /img=\\.\imgsrv\PC12\abc.pqi

where “PC12” is the Unicast server machine name, and “abc.pqi” 
is the remote path name

PQImgCtr.exe /img=\\.\imgsrv\0.0.0.0\abc.pqi

where “0.0.0.0” is a valid IP address

/CMD Identifies the script path, which includes the script filename, and 
can be relative to the location of PQImgCtr.exe. Specifying a 
drive local letter here refers to the Unicast client machine.

Example
PQImgCtr.exe /img=\\.\imgsrv\PC12\abc.pqi 
/cmd=restore.pqs

where restore.pqs, which is assumed to contain a restore image 
script, exists in the same directory as the PQImgCtr executable.

/UPN

(Optional)

Identifies the Unicast port number that the Unicast client uses to 
connect to the Unicast Server. This must be a valid TCP/IP port 
number and must match the port number used by the Unicast 
server. If this parameter is not specified, the Unicast client 
defaults to the port number of 50137.

Example
PQImgCtr.exe /img=\\.\imgsrv\PC12\abc.pqi 
/cmd=restore.pqs /upn=51225

/UIS 

(Optional - GUI 
only)

Identifies the Unicast image server, so that you can browse to it in 
the ImageCenter interface.

Example
PQImgCtr.exe /UIS=dev-PC12

Command Line 
Switch Description
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Overview

Symantec ImageExplorer simplifies management of your image files. Working within a 
single screen, ImageExplorer gives you total control of the image files you can access. 
You can view image file contents, copy image files, copy partitions within files, restore 
individual program and data files from the image, or add password protection to image 
files.

ImageExplorer also provides description capabilities, so you can easily identify individual 
image files and partitions.

Start ImageExplorer by clicking Start > Programs > Symantec DeployCenter 5.7 > 
DeployCenter 5.7 Tools > ImageExplorer.

Symantec ImageExplorer—Main Screen

The ImageExplorer main screen is divided into three panes: Locate, Recent, and Contents. 
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Modifying Images

You can use the Copy to Image feature in ImageExplorer to copy single or multiple 
partitions to new or existing image files. When you copy a file, partition, or image, you 
also have an option to set the compression level for the resulting image, add a password to 
the image, or split the image into multiple files.

Copying Partitions to an Image File

You can drag and drop partitions from one image file to another, or you can copy 
partitions using the Edit menu. Copied partitions will not overwrite any partition already 
in an image file. Therefore, you can have several partitions with the same name or drive 
letter within one image file.

There are several methods to copy partitions or image files:

• Drag and drop the partition or image from the Recent or Locate pane onto a drive or 
folder in the Locate pane.

• Drag and drop a partition within an image file onto another image file or onto a folder 
in the Locate pane.

• Select a partition, click File > Copy to Image.

Screen area: Description:

Locate pane Displays a tree view of all the drives on your machine (local hard 
disks and network drives).

Recent pane Displays a tree view of image files you have browsed to or opened 
recently. You can clear the list of recent images by clicking Recent 
> Clear Recent Images List.

Contents Displays the contents of the selected drive, folder, image file, or 
partition.

Toolbar Provides quick access to common tasks. You can display or hide the 
toolbar using the View menu. You can also use the View menu to 
determine whether to display text labels on the toolbar buttons.

Status bar Displays a brief description of the toolbar button where the pointer 
is located. You can display or hide the status bar using the View 
menu.



Chapter 8: ImageExplorer96

• Right-click a partition, click File > Copy to Image.

• Select a partition, click Edit > Copy, move the insertion point to the new location, 
then click Edit > Paste.

The Copy to Image dialog displays the filename for the image file you are modifying (or 
allows you to type a filename for a new image file). It also allows you to split an image 
file, combine files that make up a spanned image, add a password to an image, and choose 
the compression level for an image.

What you copy: Result:

Entire .PQI image file The Copy to Image dialog appears with the 
Destination image text box filled in according to the 
currently selected drive or folder in the Locate pane.

Partition within an image 
file

If the partition is copied to another image file, the Copy 
to Image dialog appears and the partition is added to 
the image file and inherits the characteristics of the 
target image file including compression ratio, 
password, and so forth. If the partition is copied to a 
folder, the Copy to Image dialog appears and the 
partition is added to a newly created .PQI image file.
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Splitting an Image into Multiple Files

Use Split to save an existing image file across a series of removable media disks (for 
example, floppy disks, Jaz or Zip disks). You can use ImageExplorer to split image files 
after they have been created. You can also save split image files to a network drive and 
later transfer the files to removable media, such as a CD-RW.

You split an image by copying the whole image or selected partitions to a new image file 
and then splitting the new image file.

1 Copy the image file you want to split from the Locate or Recent pane into the Locate 
pane.

The Copy to Image dialog appears.

2 Under Destination image, type a path and filename for the new image file.

3 Select Split image into segments.

4 Type a maximum size for each segment of the image file.

For example, if you want to create an image file on CDs, type 670000000.

5 Specify any other options for the new image file (such as a description, a password, or 
a compression level).

6 Click Copy.

When you split an image file to a removable media device, you are automatically 
prompted for new media when media in a removable device is full.

Combining Files that Make up an Image

If you select a file that is part of a split image (an image that is split across several files) 
and copy the file to a new image file, ImageExplorer automatically combines all the pieces 
of the image in the new Destination image.

You must ensure that the Split image into segments check box is not selected, or the new 
image file will be split at the specified size instead of combined into one file.

This feature is useful if you have an image file stored on removable media, but you want 
to save it on a network directory or your hard disk.
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Adding a Password to an Image

1 Copy the image file to which you want to add a password from the Locate or Recent 
pane into the Locate pane.

The Copy to Image dialog appears.

2 Under ImageShield, click Set Password.

3 Type the password in the Password and Confirm password fields.

Passwords are case-sensitive. Store the password in a safe place, since you cannot 
copy, modify, or restore a password-protected image file without typing the 
password. You also cannot change a password for an image file without knowing the 
current password assigned to that image. Symantec does not have a workaround to 
access password-protected image files if you lose the password.

4 Specify any other options for the new image file (such as a description, a compression 
level, or a split size).

5 Click Copy.

Compressing Image Files

1 Copy the image file you want to compress from the Locate or Recent pane into the 
Locate pane.

The Copy to Image dialog appears.

2 Under Compression Level, click the level of compression you want.

3 Specify any other options for the new image file (such as a description, a password, or 
a split size).

4 Click Copy.

None No compression is usually the fastest method for saving the image 
file and is useful if storage space is not an issue. However, if you are 
saving your image file to a busy network drive or to a relatively slow 
removable media device, it may be faster to compress the image 
since there is less data to write to the file.

Low Low compression offers a 40% average compression ratio.

High High compression offers a 50% average compression ratio.
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Adding or Changing an Image File Description

1 Copy the image file you want to add a comment for from the Locate or Recent pane 
into the Locate pane.

The Copy to Image dialog appears.

2 Under Description, type comments about the image file.

Comments cannot exceed 232 characters.

3 Specify any other options for the new image file (such as a password, a compression 
level, or a split size).

4 Click Copy.

Mounting a Volume

From ImageExplorer, you can mount a volume within a backup image file by assigning it 
a drive letter that is visible from Windows Explorer. As with any other mapped drive, you 
can perform a variety of tasks on the volume such as run ScanDisk (or CHKDSK), 
perform a virus check, defragment files, copy folders or files to an alternate location, or 
simply view disk information about the volume such as used space and free space. You 
may also be able to run executable programs that exist within the mounted volume.

When a volume is mounted, you can set it up as a shared drive. Users on a network can 
connect to the shared drive and restore files and folders from within the volume.

You can mount one or more volumes at a time in ImageExplorer. The volumes will remain 
mounted even if you close and restart ImageExplorer. If you reboot the server, however, 
the volumes will be dismounted. Mounted volumes do not take up extra hard disk space.

If an NTFS volume uses EFS (Encrypted File System), the security remains intact on the 
volume when it is mounted.

It is not necessary to mount a volume to restore files or folders from within a backup 
image.

IMPORTANT! When you mount a backup image under Windows 2000, the volume will 
appear to be a read-write volume when it is actually read-only. Attempting 
to make changes may crash the machine where ImageExplorer is running. 
Any changes you make to the volume, such as deleting or copying files, 
will be lost when the backup image is dismounted.
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You cannot mount volumes under Windows 9x or Windows NT 4.0.

1 From the tree pane of ImageExplorer, select the image file (.PQI) that contains the 
volume that you want to mount.

2 Click File > Mount Volume. 

3 Select a volume name you want mounted.

4 Choose a drive letter you want associated with the volume from the Drive letter 
drop-down list.

5 Click OK.

To mount additional volumes, repeat the steps above.

The mounted volume appears in the tree pane of the ImageExplorer, and Windows 
Explorer is automatically opened to the drive letter of the mounted volume.

Folders and files in a mounted volume are marked as read-only

Dismounting a Volume

1 From the tree pane of ImageExplorer, select a mounted backup image file, then click 
File > Dismount volume.

Rebooting the computer will also dismount all volumes.
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Restoring Individual Files or Partitions

You can use ImageExplorer to restore individual files or partitions from within an image 
file. You can restore individual files or folders from spanned or compressed images 
without restoring the entire image file.

1 From the Locate or Recent pane, double-click the image file that contains the 
partition with the files you want to restore.

2 (If applicable) Type the image file password, then click OK.

3 Double-click the desired partition.

4 Select the folder or files you want to restore.

You cannot restore individual files with international characters in the filename or 
files that have NT compression. These files can only be restored when you restore a 
complete image.

5 Click File > Restore.

You can also drag a file into the desired location to restore it or right-click a file and 
choose Restore from the quick menu.

If you selected an image file that was created with an older version of Drive Image or 
ImageExplorer, a progress bar displays while the ImageExplorer expands the image 
index. To speed up the process with older image files, refer to “Working with Images 
from Previous Versions” on page 102.

6 Click To this destination, then specify the location where you want to save the 
restored files. Click the browse button to navigate to the location you want.

You can also click Restore to original path if you want to restore the folders or files 
to their original location. If the original location does not include a drive letter 
(because the partition was hidden when you imaged it), you must enter a drive letter 
for the partition before you can restore it.

7 Click Restore to restore the files.

8 When file restoration is complete, click OK.

9 Click Close to return to the ImageExplorer main window.
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Working with Images from Previous Versions

If you restore files from an image that was created with an earlier version of 
ImageExplorer (a version that was included with Drive Image Pro), you can do one of the 
following to speed up the process. Note that these procedures are optional.

• Ensure that the index file (*.PQX) for the image is saved in the same directory where 
the image is saved. If ImageExplorer finds the index file in the same directory, it can 
use the index file instead of recreating it during the restore.

• If you do not have an index file for the image, you can use ImageExplorer to copy the 
image into a new ImageExplorer image.

Verifying Image Files

Use Verify Image to determine whether an image file is valid or corrupt. ImageExplorer 
will check to see that all of the files in the image are available for you to open, the internal 
data structures in the image file match the data that is available, and the image file can be 
uncompressed and will create the expected amount of data.

This feature is useful if you have added partitions to an image and want to verify the 
integrity of the image.

1 From the Locate or Recent pane, select the image file you want to check.

2 Click File > Verify Image.

3 When the check is complete, click OK.

You can also right-click an image file, then click Verify Image from the quick menu.

Deleting Image Files

Use Delete to remove an entire image file, including all partitions, folders, and files. If you 
delete an image file that resides on your local hard disk, it is sent to the Windows Recycle 
Bin.

1 From the Locate or Recent pane, select the image file you want to delete.

You cannot delete individual partitions or selected files or folders within an image 
file.

2 Click File > Delete Image.
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3 Click Yes to continue or No to cancel.

You can also right-click on an image file, then click Delete Image from the quick menu or 
delete the image using Windows Explorer.

Displaying Information About Images

1 From the Locate or Recent pane, select the desired image file.

2 Click File > Properties, or right-click the image file and click Properties.

The following list describes each option in the Image Properties dialog.

3 Click OK to exit the dialog.

Displaying Information About Partitions

1 From the Locate or Recent pane, double-click the image file that contains the desired 
partition.

2 Select the partition you want.

Description A user-assigned comment associated with the partition.

MS-DOS name A user-assigned name for the image.

Image size The total size of the image.

Image date/time The date and time that the image file was created.

Spanned Whether the image file is spanned over several disks.

Compression Whether the selected partition is compressed or 
uncompressed. The level of compression (Low or High) is 
also specified. Low level compression yields an approximate 
40% compression rate. High level compression yields 
approximately 50%.

Password 
Protected

Whether the image is password protected.
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3 Click File > Properties, or right-click partition and click Properties.

4 Click OK to exit the dialog.

Viewing Files within an Image File

Symantec ImageExplorer enables you to view files within an image file.

1 In the Contents pane, select the file you wish to view.

You can select multiple files to view.

2 Click File > View File.

If you select an executable file (or a file with a .DLL, .COM, or .PIF extension), the 
View File command will be dimmed.

Display name A user-assigned name for the partition.

Description A user-assigned comment associated with the partition.

Drive letter The partition drive letter.

Type The file system type (for example, FAT, NTFS) used within 
the partition. 

Primary/Logical The selected partition's drive status as either primary or 
logical.

Partition size The total size of the partition. This total includes both used 
and unused space.

Used space in 
partition

The amount of used space within the partition.

Unused space in 
partition

The amount unused space within the partition.

Physical size in 
image

The actual size of the partition within the image file. This 
physical size may differ from the partition size depending 
upon the amount of used and free space within the partition 
and the compression level.
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.BAT, .CMD, and .INF files will be opened with Notepad. Files that are registered 
will be opened with the registered application. Files that are not registered will 
display the Open with dialog.

You can also view a file by right-clicking it and choosing View File or by 
double-clicking on the file.

ImageExplorer Options

You can specify a default restore path or a default size for image files. The default size is 
that size at which images will be split during a copy. This size will display in the Copy to 
Image dialog.

1 Click Tools > Options > General.

2 (Optional) Specify the full path to the default restore location.

This path is used if you do not initiate an image restoration using drag and drop or 
copy and paste.

3 (Optional) Specify the default byte size for splitting an image file.

For example, if you want to save the file to CD, you could specify a file size of 
670,000,000 bytes (650 MB) or less.

4 Click OK.

You can also specify filename extensions that will display in ImageExplorer as image 
files.

1 Click Tools > Options > Image Extensions.

2 Type the image file extension in the Extension text box.

File extensions can be up to three characters long and can contain alphanumeric 
characters. You do not need to type the period. It will be added automatically.

3 Click Add.

4 Repeat steps 2 and 3 to add more file extensions, or click OK.

All image files that match the extensions you have added to the list are displayed in 
the Locate and Recent panes.
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To remove an extension, select it from the list box, then click Remove. To erase all 
extensions you have added, click Clear. Note that *.PQI cannot be removed from the list.

Exiting ImageExplorer

1 Click File > Exit.

When you run ImageExplorer again, your previous view settings will be used.
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Overview of PXE

PXE (Pre-boot Execution Environment), a component of Intel’s Wfm (Wired for 
Management) specification, allows a computer’s PXE-compliant network card to 
download and run a virtual floppy from the network prior to booting the operating system 
on the hard disk. Because this task is performed remotely, it eliminates the need to visit the 
computer and boot it using a floppy disk.

The sequence below outlines how PXE works on a user’s computer.

1 The PXE client boots up on the user’s computer and asks the DHCP server for the IP 
address.

2 The PXE client requests a bootstrap program from the PXE server.

3 The PXE server downloads the bootstrap program to the client computer using 
MTFTP (Multicast Trivial File Transfer Protocol).

IMPORTANT! If you are attempting to access a PXE server across a router or switch 
that does not allow MTFTP to pass, the error message “Error: No boot 
file name received” is displayed. To resolve the error, make sure that 
all routers and switches are configured to allow MTFTP.

4 The PXE client runs the bootstrap program and displays a menu of available virtual 
floppies.

5 The user selects a virtual floppy program, and steps 3 and 4 are repeated to download 
and run the bootstrap program, which in turn downloads the selected virtual floppy 
program.

PXE uses the UNDI protocol to transfer the bootstrap program and virtual floppy 
program. This lets the PXE client and server to communicate and download files without 
loading any specific NIC drivers.

Overview of PXE Server

Network administrators can configure a PXE server to define network boot programs that 
users can run on their computers. Users who boot a PXE-compliant computer can select 
the programs they want to run from a menu of network boot programs, or the 
administrator can assign a boot program to a specific machine.

DeployCenter installs and configures a PXE server that provides two sample boot 
programs:
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• Drive Map Sample – This boot program will map a disk drive letter to a network 
share using the Universal Network Device Interface (UNDI) driver. This boot 
program must be modified to contain the correct network share and username in the 
AUTOEXEC.BAT and SYSTEM.INI file.

• Unicast Sample – This boot program will run ImageCenter and use the Unicast 
feature to access the image files. This is done using the UNDI driver. This boot 
program must be modified to contain the correct Unicast server name in the 
autoexec.bat file.

Installing the PXE Server

When you install the Symantec PXE server, the install program makes the following 
assumptions.

• You already have a DHCP service running on your network. PXE relies on DHCP.

• The DHCP service does not already supply PXE services. Client computers prefer the 
PXE services on DHCP over the PXE services on the PXE Server. Therefore, having 
both services makes the PXE Server ineffective. To disable PXE services on DHCP 
and use the PXE Server instead, see “Turning off DHCP's PXE Services” on page 
110.

• You are installing PXE Server on a machine that is different from the machine that 
runs the DHCP service. The installation program might not fully configure PXE 
Server if you install it on the same machine as the DHCP service. To install PXE 
Server on the same machine as your DHCP service, see “Installing PXE Server on the 
DHCP Machine” on page 110.

• The machine on which you intend to install PXE Server already has its domain or 
workgroup name set. (The PXE configuration stores the domain/workgroup name.)

• One or more client machines already have a PXE-compliant network interface card, 
so they can boot from the network.

PXE Server Folder Structure and Files

The default directory where the PXE server is installed is C:\Program 
Files\Symantec\PXE Server. Three additional files, used by the PXE server, are located in 
the subdirectory \BootImag\X86PC\UNDI.

IMPORTANT! All three files should not be moved or deleted from their location.

• LBOOT.0 -- Allows PXE clients to boot directly to the local hard disk instead of 
running a virtual floppy.
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• PXE.0 -- A generic bootstrap program used to download the virtual floppy from the 
PXE server.

• MACASSIGN.TXT -- Lists the MAC addresses and their assigned virtual floppies. 

Under this same UNDI subdirectory, there are additional folders for each virtual floppy 
used by PXE. For example, the Sample folder contains the following two files.

• SAMPLE.1 -- A virtual floppy that can be edited using Boot Disk Builder.

• SAMPLE.0 -- Used to download the virtual floppy. (This file is identical to PXE.0.)

Turning off DHCP's PXE Services

If your DHCP service currently provides PXE services, but you prefer DeployCenter's 
PXE server to control PXE client machines, you can remove DHCP’s PXE services.

Windows 2000

On Windows 2000 using Microsoft's DHCP service, you can modify DHCP with these 
netsh commands:

• netsh.exe dhcp server delete optionvalue 60
• netsh.exe dhcp server delete optionvalue 43
• netsh.exe dhcp server delete optiondef 60
• netsh.exe dhcp server delete optiondef 43

Windows NT 4.0 (Service pack 6a)

On Windows NT 4, or with non-Microsoft DHCP services, refer to that service's 
documentation for how to do the following:

• Remove DHCP's option 60
• Remove DHCP's option 43.

Installing PXE Server on the DHCP Machine

To run PXE Server and DHCP server on the same machine, you must edit your DHCP 
service. PXE and DHCP typically communicate on the same port. However, this is not 
possible if they both run on the same machine.

You should not edit your DHCP service using the methods below unless you installed 
PXE Server on the same machine as the DHCP service. You should do so if the 
installation program failed to configure your DHCP server automatically (depending on 
the version of Windows on the machine and which brand of DHCP server you are using).
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When you edit the DHCP service, it will tell the PXE client machine to "talk" to PXE 
Server on an alternate port.

Editing the DHCP Server

To ensure that the DHCP server notifies the PXE client machines to use an alternate port 
to communicate with the PXE server, do one of the following (depending on the operating 
system you are running):

Under Windows 2000

Using Microsoft’s DHCP service, edit DHCP with these two netsh commands:

• netsh.exe dhcp server add optiondef 60 "Class ID" string 0 PXEClient
• netsh.exe dhcp server set optionvalue 60 string PXEClient

Under Windows NT 4.0 (Service pack 6a)

Using Microsoft's DHCP service, edit DHCP using the DHCP Manager.

1 Click Start > Programs > Administrative Tools (Common) > DHCP Manager.

2 Double-click Local Machine from the DHCP Servers pane.

3 Select any DHCP scope, then click DHCP Options > Defaults.

4 Click New.

5 Type Class ID in the Name field.

6 Select String from the Data Type drop-down list.

7 Deselect Array.

8 Type 60 in the Identifier field, then click OK.

The DHCP Options: Default Values dialog appears.

9 Select 060 Class ID from the Option Name drop-down list.

10 Type PXEClient in the Value String field, then click OK.

11 Select any scope, then click DHCP Options > Global.

12 Select 060 Class ID from the Unused Options list box.

13 Click Add to add the option to the Active Options list box.
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14 Click OK.

15 Click Server > Exit.

On either Windows platform, if you use a non-Microsoft DHCP service, refer to that 
service's documentation to complete the following:

• Define DHCP’s option 60.
• Set option 60 to PXEClient.
• Assign option 60 to all DHCP scopes, or at least to those scopes that contain PXE 

clients.

Editing the PXE Service Using the Windows Registry

1 Run REGEDIT and locate the registry entry HKEY_LOCAL_MACHINE\Software\ 
Symantec\PXE\ProxyDhcp.

2 Double-click UseDhcpPort in the right pane window.

3 If the value is 1, change it to 0.

Teaching PXE Server That it is Not on the DHCP Machine

If, during the installation, you specified that the same machine ran the PXE Server and the 
DHCP service, but it does not, client machines will not be able to recognize the PXE 
Server. To correct the PXE Server configuration error, use REGEDIT to edit the 
appropriate registry entry.

1 Run REGEDIT and locate the registry HKEY_LOCAL_MACHINE\Software\ 
Symantec\PXE\ProxyDhcp.

2 Double-click UseDhcpPort name field in the right pane window.

3 Type 1 in the Value field.

Go to the computer’s Services list in the Computer Management window, and stop and 
restart the Symantec PXE Services.

Overview of the PXE Configuration Utility

DeployCenter includes a PXE Configuration Utility that simplifies the setup and use of 
PXE in DeployCenter, so you can easily deploy images across a network.
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• Using the PXE Configuration Utility, you can assign a virtual floppy to a specific 
MAC address. Every computer has a NIC with a unique MAC address assigned to it. 
This unique address makes it possible to identify computers on a network.

• You can assign a MAC address so that when the matching MAC address is found on 
the PXE client (the user’s computer), the assigned virtual floppy is sent directly to the 
PXE client; no menu is presented to the user. If, however, a matching MAC address is 
not found, a menu of virtual floppies is displayed, and the user can select which item 
to run. 

• You can also assign a MAC address to boot to the local hard disk; the machine will 
proceed with a normal boot of the operating system on the hard disk.

• Virtual floppies, which are added to the PXE configuration utility, can be up 1.44 MB 
or 2.88 MB. Also, the local floppy drive can be accessed inside the virtual floppy by 
using the B: drive assignment (since A: is used by the virtual floppy environment).

How Do I Create and Edit a Virtual Floppy?

You can use the Boot Disk Builder program included with DeployCenter to create a virtual 
floppy. When you build the boot disk, select the options that most closely match what you 
are trying to accomplish with the virtual floppy. See “Creating Boot Disks” on page 9.

You can use VF Editor, a utility included with DeployCenter, to edit a virtual floppy. See 
“Editing Virtual Boot Disks” on page 204.
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PXE Virtual Floppies

Use the PXE Virtual Floppies property page in the PXE Configuration Utility to add 
virtual floppies from the PXE system. 

The Virtual floppies available to PXE column lists all virtual floppies that are currently 
in use under the PXE system. The Location column identifies where on the network that 
each listed virtual floppy is located. 

Adding a Virtual Floppy to the PXE System

Before you can add a PXE virtual floppy to the menu, you must have created a virtual 
floppy using Symantec Boot Disk Builder. You cannot add a virtual floppy if one does not 
exist. For complete information on creating a virtual floppy, see the Boot Disk Builder 
Windows help file.

1 Open the PXE Configuration Utility.

2 Click the PXE Virtual Floppies tab.

3 Click Add.

4 Specify the full path to the virtual floppy, including the filename, or click the browse 
button to navigate to the network folder where the virtual floppy is stored.

5 Click OK.
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The virtual floppy is now available to the PXE system. The location of each virtual floppy 
you add is also specified in the list box. 

Removing a Virtual Floppy from the PXE System

1 Open the PXE Configuration Utility.

2 Click the PXE Virtual Floppies tab.

3 Select a virtual floppy from the list box.

4 Click Remove.

IMPORTANT! Removing a virtual floppy that is used elsewhere on a PXE menu will 
result in the following error message: "Error: Unknown virtual floppy." 
Before removing a virtual floppy, it is important to verify that other PXE 
menu items do not use the same virtual floppy.

PXE Client Menu

When a computer boots to PXE, it can optionally display a menu of all the virtual floppies 
that you have allowed a user to select. You can use the PXE Client Menu property page in 
the PXE Configuration Utility to configure or edit the PXE client menu. 

The Menu item name column lists what will appear on the PXE client's screen. The 
Virtual floppy assigned column lists the virtual floppy associated with each menu item.
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Assigning a PXE Client Menu Item to a Virtual Floppy

You can add each virtual boot disk you have made available to the PXE system (via the 
PXE Virtual Floppies property page), to the PXE client menu for a user to select.

1 Open the PXE Configuration Utility.

2 Click the PXE Client Menu tab.

3 Click Add.

4 Type the text that will represent what the user will select on the PXE client menu. 
Make sure it is descriptive of what the virtual floppy will do.

5 Select a virtual floppy from the drop-down list that you want associated with the text 
in step 4. If there are no virtual floppies to select, then you have not added one to the 
PXE system. For more information, click See Also on the Help toolbar, then click To 
add a virtual floppy to the PXE system.

When the user selects the text, the associated virtual floppy will run.

6 Click OK.

The menu text and associated virtual floppy appear in the list box.

Removing a PXE Client Menu Item

You can remove a menu item name and its associated virtual floppy from the PXE client 
menu. Removing a menu item deletes the text from the PXE client menu; it does not delete 
the actual virtual floppy.

1 Open the PXE Configuration Utility.

2 Click the PXE Client Menu tab.

3 Select a menu item you want to remove from the PXE client menu.

4 Click Remove.

5 Click OK.

Editing a PXE Client Menu Item

You can change the text of a previously created menu item name or assign a different 
virtual floppy to the menu item name.

1 Open the PXE Configuration Utility.
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2 Click the PXE Client Menu tab.

3 Select a menu item whose properties you want to edit.

4 Click Edit.

5 Change the menu item name text or assign a different virtual floppy to the menu item 
from the drop-down list.

6 Click OK.

Reordering PXE Client Menu Items

You can change the order of menu items that appear on the PXE client menu.

1 Open the PXE Configuration Utility.

2 Click the PXE Client Menu tab.

3 Select a menu item name.

4 Click Up or Down to move the menu item where you want.

Configuring the PXE Client Menu

You can edit the text prompt that is displayed at the top of the menu on the PXE client 
computer. You can also set the PXE client computer to perform a local boot if a user does 
not press any keys before the specified time-out period. This avoids having a computer 
remain at the PXE menu, waiting for a user to select a menu item.

To do this, click the check box and enter the number of seconds.

1 Open the PXE Configuration Utility.

2 Click the PXE Client Menu tab.

3 Click Configure.

4 Type the text that you want displayed at the top of the menu on the PXE client 
computer, in the PXE client menu prompt text field.

5 (Optional) To have the PXE client menu time out, select If no keys hit, time out and 
do a local boot, then specify the number of seconds you want the menu to remain 
visible.
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After the computer boots to PXE, the user will have a specified amount of time to press a 
key. When the user presses a key, they will be able to select an item from the menu. If a 
key is not pressed, the computer will automatically boot from the local hard drive.

MAC Assignment

Each computer’s NIC is given a unique MAC address. This address can be used to assign 
PXE tasks to specific computers. When a computer first contacts PXE, the PXE server 
attempts to locate the MAC address in the assignment list. If the address is found, the 
assigned virtual floppy is run. If the address is not found, the PXE client menu is displayed 
instead, and the NIC’s MAC address is added to the bottom of the MAC address 
assignment list. You can use the MAC Assignment property page to edit this address list. 

The MAC address column lists the MAC addresses; the unique address of a user's 
computer.

The Virtual floppy assigned column lists the task that has been assigned to a specific 
MAC address.

The Run Once column identifies which tasks will be run only one time before reverting to 
the option Boot to local hard disk for all subsequent PXE boots.

The order of MAC addresses is important. When searching for a matching MAC address, 
the PXE server uses the first address it finds in the list. Therefore, addresses with 
wildcards (such as ** or ..) in the MAC address field should be placed at the bottom of 
the list, and specific, non-wildcard MAC addresses should be moved to the top of the list.
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Assigning a MAC Address to a Virtual Floppy

1 Open the PXE Configuration Utility.

2 Click the MAC Assignment tab.

3 Click Add.

4 Enter the MAC address. (The cursor will automatically move to the next text field 
after two characters are entered.)

To assign an entire group of contiguous MAC addresses, use a ** or .. in place of a 
two-digit text field.

5 Select a virtual floppy task that you want assigned to the MAC address.

If there is no virtual floppy task that the assigned computer needs to run, select Boot 
to local hard disk to force PXE to boot the computer as normal.

6 (Optional) If you want the client computer to run the assigned virtual floppy task only 
one time, select Run Once.

After the client computer has booted the assigned virtual floppy, it will revert to the 
option Boot to local hard disk for all subsequent PXE boots.

7 Click OK.

The MAC address and associated virtual floppy task appear in the list box.

Editing a MAC Address

1 Open the PXE Configuration Utility.

2 Click the MAC Assignment tab.

3 Select a MAC address from the list box.

4 Click Edit.

5 Change the MAC address or assign a different task from the drop-down list.

6 Click OK.

Removing a MAC Address

1 Open the PXE Configuration Utility.

2 Click the MAC Assignment tab.



Chapter 9: Using PXE to Deploy Image Files120

3 Select a MAC address.

4 Click Remove.

5 Click OK.

Reordering MAC Addresses

The order of MAC addresses is important. When searching for a matching MAC address, 
the PXE server uses the first address it finds in the list. Therefore, addresses with 
wildcards (such as ** or ..) in the MAC address field should be placed at the bottom of 
the list, and specific, non-wildcard MAC addresses should be moved to the top of the list.

1 Open the PXE Configuration Utility.

2 Click the MAC Assignment tab. 

3 Select a MAC address.

4 Click Up or Down to move the address where you want.

Importing a List of MAC Addresses

To save time entering a range of MAC addresses, you can import a text file containing the 
MAC addresses. The Import List feature is very robust; as long as spaces, commas, tabs, 
or new lines separate each MAC address, the file will import correctly.

If the Import List file is quite large, it is recommended that you first import only two or 
three MAC addresses to ensure that it imports correctly. If there are no problems, you can 
safely import your entire list of MAC addresses.

1 Open the PXE Configuration Utility.

2 Click the MAC Assignment tab.

3 Click Import List.

4 Enter the full path and filename to the .TXT file, or click the browse button to 
navigate to the file’s location.

5 Select a virtual floppy task from the drop-down list that you want assigned to each of 
the MAC addresses in the import file.

6 Click OK.

The import file is read and the MAC addresses are added to the PXE system.
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Use Scenarios for the PXE Configuration Utility

Scenario 1: Single Virtual Floppy, Single Computer

You have one virtual floppy that you want a single computer to run prior to booting its 
operating system.

1 Create and save a virtual floppy using Boot Disk Builder.

2 Open the PXE Configuration Utility, and click the PXE virtual floppies tab.

3 Add the virtual floppy you created in step 1 to the PXE system. 

4 Click the MAC assignment tab.

5 Add the MAC address of the computer that will run the assigned virtual floppy.

Scenario 2: Single Virtual Floppy, Multiple Computers

You have one virtual floppy that you want multiple computers with contiguous MAC 
addresses to run prior to booting their operating systems.

Use the Import List feature or special syntax to define a range.

1 Create and save a virtual floppy using Boot Disk Builder.

2 Open the PXE Configuration Utility and click the PXE virtual floppies tab.

3 Add the virtual floppy you created in step 1 to the PXE system.

4 Click the MAC assignment tab.

5 Use the special syntax (** or ..) in place of a two-digit text field to specify a range 
of contiguous MAC addresses that will run the virtual floppy you assign. 

Scenario 3: Multiple Virtual Floppies (PXE menu), Multiple Computers

You want to display a menu list of several virtual floppies to multiple users and have each 
user select the virtual floppy they want to run prior to booting their operating systems. 
MAC addresses are non-contiguous.

1 Create and save virtual floppies using Boot Disk Builder.

2 Open the PXE Configuration Utility, and click the PXE virtual floppies tab.

3 Add each virtual floppy you created in step 1 to the PXE system.
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4 Click the PXE client menu tab.

5 For each virtual floppy that you create, type the text that you want a user to read on 
the PXE menu, and assign the associated virtual floppy to each PXE menu item.

6 Click the MAC assignment tab.

7 Use the Import List feature to add MAC addresses of the computers that will be 
assigned to display the PXE client menu. 
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Overview

ImageCenter may be run in one of two modes: interactive (the default) or batch mode. 
Interactive mode requires user input at discrete intervals, resulting in greater control and 
efficiency when working with one or two workstations. To run ImageCenter in interactive 
mode, you type PQIMGCTR at the DOS prompt.

Batch mode allows you to control the operation of ImageCenter with a file of script 
commands. Scripting is especially useful for system administrators when loading image 
files onto a large number of workstations, as it automates the loading process and saves 
time by eliminating the need for user intervention. 

You can also use scripting with the Windows and DOS PowerCasting executables. Note 
that PowerCasting is not supported fully with scripting. For example, if you have an image 
with five partitions, you cannot choose partitions 2 and 3 and just PowerCast those. You 
can only PowerCast a complete image file with scripting.

Command Line Switches for ImageCenter

To run in script mode, ImageCenter uses a series of command line switches. To use these 
switches, type PQIMGCTR /switch, where switch is one or more of the available 
commands. For example, to invoke the command interpreter, use the /CMD=<scriptfile> 
command. If the name of the text file containing the script commands were 
C:\SCRIPTS\LABS.TXT, you would type the following at the command line or in your 
batch file:

PQIMGCTR /CMD=C:\SCRIPTS\LABS.TXT
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IMPORTANT! Because ImageCenter is run at a DOS prompt, you are limited to 128 
characters on the command line. See /ARG below for how to get around 
this limit.

Command Line Switch Description

/? Displays all available command line switches, their 
syntax, and a short description. You can send the results 
this switch displays to a text file for future reference by 
typing "pqimgctr /? > help.txt"

/AAM (Auto-Answer messages) Don’t prompt for user input 
unless absolutely necessary. This is the default when 
running ImageCenter from a script, but not when running 
ImageCenter interactively. Message boxes that have a 
default answer will not be displayed during the creation or 
restoration of an image. See also “/PROMPT” on page 130 
and “/NMD” on page 129.

/ARG=<file> Includes additional command line arguments in a text file. 
This is useful when the amount of data required for all the 
needed switches is too long to fit on a DOS command line, 
which is limited in length. It is also useful to consolidate 
commonly used sets of switches into a single location that 
many scripts can refer to, so that all scripts can be updated 
by changing just a single file.

Each argument in the file must be preceded by either a “/” 
or “-” just as on the command line. Arguments within the 
file can be separated by a space or each can be on a 
separate line. Any line beginning with a “#” or “;” is 
ignored; they can be used for comments. The file can 
contain references to environment variables; they will be 
resolved the same as on the command line.

This switch can be used multiple times on the command 
line or even from within a file specified by a /ARG on the 
command line.

/CAS Causes every sector within a partition to be saved and 
restored. This will include all information in a partition 
including the deleted files. This option significantly slows 
down the imaging process and increases file size.

/CBS Enables bad sector checking.
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/CDRSPD=<number> Sets the CD-R write speed. This switch enables you to 
specify a slower speed to burn images to a CD if you 
encounter errors while burning images at full speed. 
<Number> indicates the speed. For example, 
/CDRSPD=8 would make an image burn at 8x.

/CEC Checks for an extra cylinder. This corrects a problem of 
the BIOS and DOS reporting different maximum cylinder 
numbers.

/CMD=<scriptfilename> Designates a script text file; the script file contains 
arguments that are passed to the program.

/CMD=RESTORE_ALL Restores all partitions in the image file to the specified 
drive. This command works in conjunction with the /DSK 
switch.

/CMD=STORE_ALL Stores all partitions on the specified drive to the file 
specified by the /IMG= switch. This command works in 
conjunction with the /DSK switch.

/CMP=None | Low | High Specifies the compression level for images. This switch is 
only available in scripting mode, not with the GUI version 
of ImageCenter

/CMT Displays the comment associated with an image file, and 
exits. You must use the /IMG switch to specify the image.

/DBG=<filename> Specifies an output filename for the debug file.

/DEL=<disknum> Where <disknum> is either a disk number or an asterisk 
(*). If a number is specified, all partitions on that disk are 
deleted during application startup. If an asterisk is 
specified, all partitions on all disks are deleted during 
application startup. The Delete switch cannot be undone, 
and will be completed even if there is a syntax error in a 
script file (specified with the /CMD switch), or if the 
specified image file cannot be opened.

The /DEL command does not wipe out the Master Boot 
Record. If you want to replace the MBR, either use the 
/MBR command to restore a MBR from an image file or 
use the /WFS command along with the DELETE ALL 
script command.

Command Line Switch Description
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/DPC Disables safety checks and allows multiple primary 
partitions or full FAT size when creating partitions, 
restoring images, hiding partitions, unhiding partitions, 
and setting partitions active. Results may be incompatible 
with some versions of Windows 9x

/DSK=<number> Specifies disk number to use for restore or save operation.

/ERR=<errorfilename> Designates an error file. Because scripts execute without 
user intervention, these files are important for checking 
errors. All of the information in the error file is also 
contained in the log file. The error file is not created if no 
error occurs.

/F4K Allows large FAT32 partitions to be created with 4 K 
clusters.

/IDE (Integrated Drive Electronics – a standard used by hard 
drives to communicate with the controller ports or cards 
that allow the hard drive to interface with the computer) 
This switch is enabled by default. If you do not want it, 
you must specifically disable it by typing “/IDE=off” on 
the command line.

/IFC (Ignores file system checks). This allows a partition with a 
known file system error (for example, cross-linked files) 
to be stored in an image. Likewise, that same partition can 
be restored if this switch is used and if during the restore 
process the partition does not need to be resized. If you use 
this switch, you may be unable to restore or boot the image 
of a partition.

/IHF (Ignore hibernation files) Decreases the amount of time 
needed to start up ImageCenter on computers with many 
partitions by skipping checks to see if the machine was 
shut down while in hibernation.

Command Line Switch Description
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/IMG=<imagefilename> Designates the path and filename for an image file. The 
STORE and RESTORE script commands will encounter 
an error if this option is not specified. If you specify an 
existing filename, and use the STORE command, the new 
image will replace the existing image. See “Accessing 
Images on Hidden Partitions” on page 138. for more 
information on how to access images located on hidden 
partitions, CD-ROM drives, and so forth.

/INFO List information about each partition, including the 
numbering used by scripts.

/LOG=<logfilename> Designates a log file. Because scripts execute without user 
intervention, log files are important for checking results.

/MBI=<number> Images the master boot record of the specified disk.

/MBR=<number> Restores an imaged master boot record to the specified 
disk.

/MFS=<span-size> Designates the maximum number of bytes, kilobytes, 
megabytes, or gigabytes that an individual image file can 
be. For example, the following are all equivalent:

/MFS=1073741824

/MFS=1048576K

/MFS=1024M

/MFS=1G

The minimum allowed value is 1048576, (and equivalents 
1024K or 1M). When the specified size is reached, the 
image file is split. By default, images are spanned when 
they reach 2 GB in size, because this is the maximum file 
size supported by DOS.

/NBS Disables bad sector checking. By default, bad sector 
checking is disabled.

Command Line Switch Description
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/NMD (No Messages Displayed) ImageCenter will never prompt 
for user input. All questions will automatically be 
answered with the default response, if any, or with “Yes” 
or “OK.”

This switch is useful for a fully unattended deployment, 
but generally the /AAM switch is preferred because of its 
ability to prompt for user input when absolutely necessary, 
such as prompting the user to insert the next CD in the 
drive.

/NOAFX Skips basic checks. During application startup, a check is 
made of the basic partition structures on disk. If a problem 
is found that can be fixed, then a prompt is displayed 
asking the user if they want to fix these problems. Using 
this switch instructs the program to skip most of these 
checks.

/NOCDR Turns off support for CD/R devices. This can be useful in 
the rare case the controller causes Image Center to hang. 

Since CDR support is initialized before the command line 
is fully parsed by the normal method, /NOCDR must be 
specified on the actual command line and will not have 
any effect if it is placed in a file specified by the 
/ARG=<filename> command line parameter.

/NRB Suppresses the normal reboot during program exit.

/NUI Runs ImageCenter without any user interaction.

Command Line Switch Description
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/OVI=0|1 Overlapped I/O. This switch should only be used when 
/IDE=ON is specified (default). This switch only affects 
image restore. It does not affect image creation. When 
/IDE is specified, ImageCenter will attempt to determine 
whether or not overlapping the I/O (Reading the PQI and 
writing the disk sectors) can be safely and efficiently 
overlapped. If you want to override the default, use this 
switch. 0 disables overlapping while 1 enables it.

Overlapping should not be enabled if the PQI file is on the 
same disk as the partition being restored, or if the PQI is 
on a second disk or CD-ROM device that uses the same 
IDE channel as the disk being restored. Overlapping, when 
appropriate, will generally improve performance, except 
when the image being restored is highly or moderately 
fragmented.

/PROMPT Always prompts for user input. This is the default for 
running ImageCenter interactively, but not when running 
ImageCenter using a script. When using a script, 
ImageCenter automatically answers questions that have a 
default response, such as asking if it should fix problems 
that it knows how to fix. Using /PROMPT lets you make 
these decisions. See also “/AAM” on page 125 and 
“/NMD” on page 129.

/PWD=<password> Designates a password that must be given to restore the 
partition’s data. The password may be either a number or a 
string. This command only works with scripting. It is 
ignored when in interactive mode.

/RAV Equivalent of Verify Disk Writes. Causes each sector 
restored to disk to be read back and compared as an extra 
security precaution. Using this parameter will significantly 
increase restore time.

/RPP Resizes partitions proportionally.

/SCO Syntax Check Only causes the syntax of each command in 
the script file to be checked without executing the 
command. This is useful when writing and debugging the 
script file.

Command Line Switch Description
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Command Line Example

To specify SCRIPT.TXT as the script file, LOG.TXT as the logfile and 
E:\IMAGES\DRIVE2.PQI as the image file, enter the following:

PQIMGCTR /CMD=SCRIPT.TXT /LOG=LOG.TXT /IMG=E:\IMAGES\DRIVE2.PQI

/SNC Disables the scripting progress Cancel button. This switch 
is only available in scripting mode, not with the interactive 
mode of ImageCenter.

/SSO Store system structures only. This creates an image file 
that contains only the file system structures and no file 
data.

/UIS=<unicast server> (Unicast Image Server) Used to specify the name or IP 
address of the unicast server. Only used when running in 
interactive mode. Not used by scripting.

/UPN=<number> (Unicast Port Number) Used to specify the number of the 
Unicast port. Default is 50137.

/VER Displays information about the version of ImageCenter 
you are running.

/VIP Check to see that data in image files you create matches 
the contents of the disk that was just imaged. You can also 
perform integrity checks on a case-by-case basis by 
selecting Verify Image Contents in the Advanced 
Options dialog. Using this option doubles the time it takes 
to create an image, since it requires two complete passes 
of the disk contents, one for the original creation of the 
image and the second to ensure that it matches the image.

/WFS Wipes the first sector after deleting all partitions when the 
DELETE ALL script command is used. This will insure 
that a fresh master boot record will be written to the 
destination disk; only meaningful when using scripting.

/ZLB Instructs ImageCenter to create compressed image files 
using an alternate compression technology. /ZLB 
generally results in images that are about 5% smaller than 
when not used. However, both saving and restoring in this 
format is slower.

Command Line Switch Description
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Command Line Switches for PowerCasting (Windows)

The following command line switches run with the Windows PowerCast Server 
(PQPCS32.EXE).

Command Line Switch Description

/? Displays all available command line switches, their syntax, 
and a short description.

/ACC=<number> Specifies the number of PowerCast clients that must attach 
before the PowerCast server will automatically start sending 
the image file.

/AUTO If you PowerCast an image file, all the partitions are 
selected automatically. When all the clients attach, 
PowerCasting begins.

/CBS Enables bad sector checking.

/CCM Changes the default Express Mode to the Custom 
Configuration Mode.

/DBG Specifies that a debug out file should be created. It will be 
named PQ_DEBUG.TXT.

/ERR=<errorfilename> Designates an error file that will be created if an error 
occurs.

/FSD=n[,m] (Full speed delay) Specifies the number of seconds (n) the 
PowerCast session should transmit at reduced speed to 
enable proper network pruning and the initial throttle value 
(m) for the session. The default value for n is zero, which 
will immediately start the PowerCast session at full speed. 
The initial throttle value (m) is optional. You can enter a 
value between 1 and 999. The default is 200. If you set a 
continuous throttle value with the /PCTHR switch, the 
/PCTHR value overrides the value of m.

/HPC Hides partitions after copying them.

/IFC Ignores file system checks.

/IMG=<imagefilename> Designates the image file that will be PowerCast. Images 
that were burned directly to CD by ImageCenter or Drive 
Image cannot be PowerCast.
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/IP=<xxx.xxx.xxx.xxx> Specifies the IP address (in dot notation) for the network 
adapter that should be used for the PowerCast session, when 
the server has multiple NIC cards.

/LOG=<logfilename> Designates a log file. Because scripts execute without user 
intervention, log files are important for checking results.

/MSN=<sessionname> Specifies the name of the PowerCast session.

/MTA=<number> Specifies the number of minutes (1 to 999) the PowerCast 
Server should wait before starting, regardless of how many 
clients have attached.

If at any time the number of clients reaches the number 
specified in the autostart client count field, the session will 
start no matter how many minutes have passed.

When the PowerCast session completes, a query will be 
made to see if any other clients are attached. If there are new 
clients, the minutes to autostart counter will be reset and the 
process will be repeated. If there are no more clients 
attached and the /AUTO switch was used, then the 
application will terminate and all windows will be closed.

/PCD=<IP-address> Specifies the IP address that PowerCast clients should use to 
discover their PowerCast server. IP address is of the form 
W.X.Y.Z, where X, Y and Z must be in the range 0-255, and 
W must be in the range 224-239. The default address is 
224.47.0.1. All of the PowerCast clients and server must use 
the same IP address for discovery. If multiple PowerCast 
servers are running, they can and should use the same IP 
address for discovery, but they must each have a unique 
session name (/MSN) and unique PowerCast session 
address (/PCS). It is recommended that if you specify the 
discovery address to the server, you also specify the session 
address (/PCS). 

IMPORTANT! If you specify the /PCD address to the server, 
you MUST use the /PCD option with all of 
the clients, specifying this same address.

Command Line Switch Description
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/PCS=<IP-address> Specifies the IP address that the PowerCast server should 
use for its multicast session. If multiple PowerCast servers 
are running, each must use a unique IP address for the 
session. The specified IP address must fall in the same range 
as IP addresses allowed for /PCD. 

If /PCS is not specified, then the server will generate a 
random address based upon the discovery address (see 
/PCD=<IP-address> above). Assuming that the discovery 
address is W.X.Y.Z, then the generated PCS address will be 
W.X.A.B where A and B are random numbers in the range 
Y <= A <= 255 and Z < B <= 255. This address will be 
unique from the session address used by any other 
PowerCast server sharing the same discovery address.

/PCTHR=<number> Enables you to reduce the speed at which PowerCast 
packets are sent, so a PowerCast session uses less 
bandwidth. You must enter a value between 1 and 999. 
Lower values have a greater delay between each packet sent. 
By default, the PowerCast session will send packets as fast 
as is possible with the hardware involved and will not 
consider network saturation as a drawback. Since saturation 
can reduce performance, moderate throttling can sometimes 
improve overall performance.

/RAV Equivalent of Verify Disk Writes. Causes each sector 
restored to disk to be read back and compared as an extra 
security precaution. Using this parameter will significantly 
increase restore time.

/RPP Resizes partitions proportionally.

/TTL=<number> Sets the Time to Live value to specify the number of routers 
a PowerCast session can pass through before it is killed. 
Enter a value between 1 and 32.

Command Line Switch Description
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Command Line Switches for PowerCasting (DOS)

The following command line switches run with DOS PowerCasting (PQPCAST.EXE). 
Switches apply to both the PowerCast client and server, unless noted otherwise. 

Command Line 
Parameter Description

/? Displays all available command line switches, their syntax, 
and a short description.

/AAM (Auto-Answer messages) Don’t prompt for user input 
unless absolutely necessary. This is the default when 
running ImageCenter from a script, but not when running 
ImageCenter interactively. Message boxes that have a 
default answer will not be displayed during the creation or 
restoration of an image. See also /PROMPT and /NMD. 

/ACC=<number> (PowerCast server only) Specifies the number of PowerCast 
clients that must attach before the PowerCast server will 
automatically start sending the image file.

/ARG Same as /ARG for ImageCenter. See page 125. 

/CBS (PowerCast server only) Enables bad sector checking.

/CEC (PowerCast client only) Checks for an extra cylinder. This 
corrects a problem of the BIOS and DOS reporting different 
maximum cylinder numbers.

/DBG=<filename> Specifies an output filename for the debug file.

/DEL (PowerCast client only) Same as /DEL for ImageCenter. 
See page 126.

/DSK=<number> (PowerCast client only) Specifies disk number to use for 
restore or save operation.

/ERR=<errorfilename> Designates an error file. Because scripts execute without 
user intervention, these files are important for checking 
errors.

/F4K (PowerCast client only) Allows large FAT32 partitions to be 
created with 4 K clusters.

/HPC (PowerCast server only) Hides partitions after copying 
them.
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/IDE (PowerCast client only) same as /IDE for ImageCenter. See 
page 127.

/IFC (PowerCast server only) Ignores file system checks. 

/IHF (PowerCast client only) (Ignore hibernation files) Decreases 
the amount of time needed to start up ImageCenter on 
computers with many partitions by skipping checks to see if 
the machine was shut down while in hibernation.

/IMG=<imagefilename> (PowerCast server only) Designates an image file. This 
option tells the PowerCast program that it is running in 
server mode and specifies the image file to be PowerCast. 
Images that were burned directly to CD by ImageCenter or 
Drive Image cannot be PowerCast. 

/INFO List information about each partition, including the 
numbering used by scripts.

/LOG=<logfilename> Designates a log file. Because scripts execute without user 
intervention, log files are important for checking results.

/MBR=<number> (PowerCast client only) Restores an imaged master boot 
record to the specified disk. 

/MSN=<sessionname> Specifies the name of the PowerCast session. Use together 
with /DSK to start PowerCasting in multicast client mode. 
Use together with /IMG to start in PowerCast server mode. 

/NBS Disables bad sector checking. By default, bad sector 
checking is disabled.

/NMD (No Messages Displayed) ImageCenter will never prompt 
for user input. All questions will automatically be answered 
with the default response, if any, or with “Yes” or “OK.”

This switch is useful for a fully unattended deployment, but 
generally the /AAM switch is preferred because of its ability 
to prompt for user input when absolutely necessary, such as 
prompting the user to insert the next CD in the drive.

Command Line 
Parameter Description
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/NOAFX (PowerCast client only) Skips basic checks. During 
application startup, a check is made of the basic partition 
structures on disk. If a problem is found that can be fixed, 
then a prompt is displayed asking the user if they want to fix 
these problems. Using this switch instructs the program to 
skip most of these checks.

/NRB (PowerCast client only) Suppresses the normal reboot 
during program exit.

/NUI (PowerCast client only) Runs ImageCenter without any user 
interaction. 

/OVI Same as /OVI for ImageCenter. See page 130.

/PCD Same as /PCD for Windows server. See page 133.

/PCS (PowerCast server only) Same as /PCS for Windows server. 
See page 134.

/PCTHR=<number> (PowerCast server only) Enables you to reduce the speed at 
which PowerCast packets are sent, so a PowerCast session 
uses less bandwidth. You must enter a value between 1 and 
999. Lower values have a greater delay between each packet 
sent. By default, the PowerCast session will send packets as 
fast as is possible with the hardware involved and will not 
consider network saturation as a drawback. 

/PPR=<partition-list> (PowerCast server only) Protect Partitions. Before 
PowerCasting begins, the client deletes all partitions on the 
target disk. This option allows the user to protect the 
specified partitions from being deleted. <partition-list> is a 
comma separated list that supports specifying of partitions 
by number, drive letter (without a colon following), or the 
words FIRST, LAST, DIAGNOSTIC, UNKNOWN or ALL. 

/PROMPT Always prompts for user input. This is the default for 
running ImageCenter interactively, but not when running 
ImageCenter using a script. When using a script, 
ImageCenter automatically answers questions that have a 
default response, such as asking if it should fix problems 
that it knows how to fix. Using /PROMPT lets you make 
these decisions. See also /AAM and /NMD. 

Command Line 
Parameter Description
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Accessing Images on Hidden Partitions

ImageCenter has the ability to read images from and write images to hidden partitions. A 
hidden partition is any partition not currently mounted by the file system. Under DOS, this 
generally means that the partition is not assigned a drive letter. To store an image to or 
restore an image from an otherwise inaccessible partition (types FAT16, FAT32 or NTFS 
only), invoke ImageCenter with the following command line option:

/IMG=\\.\disk1.part2\path\image.pqi

where the numbers after disk and part are replaced with the appropriate number drive and 
partition numbers for the desired hidden partition and the path and image strings are 
replaced with the appropriate path and file name of the PQI file on that partition. The 
numbers appearing after the disk and part portions are the same numbers that would be 
used in a script with the SELECT DRIVE and SELECT PARTITION commands. You can 
use the /INFO command line switch to get a listing of the assigned disk and partition 

/PWD=<password> Propagates the password to the client computer if there is 
one on the image.

Designates a password that must be given to restore the 
partition’s data. The password may be either a number or a 
string. 

/RAV (PowerCast client only) Equivalent of Verify Disk Writes. 
Causes each sector restored to disk to be read back and 
compared as an extra security precaution. Using this 
parameter will significantly increase restore time.

/RPP (PowerCast server only) Resizes partitions proportionally. 

/TTL Sets the Time to Live value to specify the number of routers 
a PowerCast session can pass through before it is killed. 
Enter a value between 1 and 32.

/VER Displays information about the version of PowerCasting 
you are running.

/WFS (PowerCast client only) Wipes the first sector after deleting 
all partitions. 

Command Line 
Parameter Description
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numbers. The /INFO command also displays PQAccess numbers for each partition on all 
disks, which consist of a number followed by a colon. PQAccess syntax can be substituted 
for the \\.\disk1.part2 portion of the above example as follows:

/IMG=2:\path\image.pqi

A third form allows you to use the volume label of the partition instead of a number. This 
can make your scripts more robust if each partition has a unique label, as it will always 
access the desired partition, even if the partition numbering changes. The form is:

/IMG=:VolLabel:\path\image.pqi

where the VolLabel is replaced with the actual volume’s label. Note that it has a colon both 
before and after the label.

WARNING! If you use the hidden partition forms for creating an image on a partition 
that is not hidden, you must reboot before attempting to access this partition 
from DOS, because the DOS cache may corrupt the data that was written. 
This includes having the application write the log file to this partition using 
DOS. (Log files also support being written to hidden partitions using the 
same syntax as above.)

To access a CD image, either to read from or write to, use the following command line 
option:

/IMG=\\.\pqcd#\path\file.pqi

Where # is replaced with the number of the CD-ROM drive, which is generally 0 unless 
you have multiple CD/DVD drives.

To specify an image file on a Unicast server, use one of the following command line 
options:

/IMG=\\.\imgsrv\<machine.name>\path\file.pqi

/IMG=\\.\imgsrv\<IP address>\path\file.pqi

Script Files

The script file designated in the command line contains arguments or instructions that are 
passed to the program, determining which operations are executed. 

Because the scripts execute without user intervention, use extra care when developing the 
script file. For example, if the DELETE ALL command is encountered, all the partitions 
on the currently selected drive will be deleted without any warning or confirmation 
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messages which would normally allow the user to cancel the operation. You should only 
enter one command per line; otherwise, only the first command and perhaps none of the 
commands will execute.

Variables can be used anywhere on an ImageCenter script line and mathematical 
expressions can be evaluated with the results assigned to local variables or used as 
parameters to commands. For a description on setting local variables, See “SET VAR” on 
page 170. If a local variable is not defined, but an environment variable with the same 
name exists, then the value of the environment variable will be used. 

Data Types

The following data types are supported with ImageCenter scripting. 

Data Types Example Description

<integer> 1

0x13FE

A 32-bit value. Any whole number between about 
-2,000,000,000 and 2,000,000,000. An <integer> 
cannot have a decimal point or commas. An integer 
can be specified in hexadecimal format by preceding 
the value with 0x.

<number> 1

3.15159

Any real number. All <integers> are <numbers>, but 
many <numbers> are not <integers>. For example, 
3.2 is a <number> but not an <integer>. Any place a 
<number> can be used, an <integer> can also be 
used, but you cannot substitute an <number> where 
an <integer> is required.

<string> "Hello"

'Hello'

Any text string. Strings should generally be enclosed 
in quotes. You can use single or double quotes. If 
you want to include a quote character within a string, 
use the opposite type of quote character around the 
string, as in: '"Hello," she said.'
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<var> %BAT% A local variable. At startup, each environment 
variable is imported as a local variable with the 
same name and value. However, if a local 
variable is modified, its corresponding 
environment variable is not modified. Local 
variables are used similarly to how environment 
variables are used in a DOS batch file. Variables 
are not evaluated if they are enclosed in quotes. 
However if you want to have the result of a 
variable evaluation treated as a string, then you 
can surround it by a backslash then a quote. For 
example, assuming %var% evaluates to

Hello World

then 
\"%var%\"

evaluates to
"Hello World"

If a local variable is undefined, then no substitution 
is made in the text; instead the variable name along 
with the percent symbols is left in the text. For 
example, using some of the operators defined below, 
these two expressions are equivalent:

IF \"%var%\" = "%var%" GOTO 
NotDefined

IF NOT DEFINED var GOTO NotDefined

<Boolean> true

false

Either TRUE or FALSE. The words "true" and 
"false," without quotes, can be used in a script to 
represent these values. If they are enclosed in quotes, 
then they are strings.

Data Types Example Description
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Operators

The table below describes the supported mathematical and logical operators. Unless 
otherwise noted, all operators are valid for operands of type <integer> and <number> 
only. If all operands are the same type, then the result is that same type unless otherwise 
noted. If <integer> and <number> operands are both used, result is a <number> unless 
otherwise noted. 

Operator Example Description

- -1

-(5*3) = -15

Unary negation. Change the sign of the value to the 
right of the minus sign.

~ ~0x13fc = 
0xffffec03

Bitwise negation. Invert the value of each bit in the 
<integer>.

If you want to display the result of ~0x13fc in 
hexadecimal, use the function HEX (~0x13fc) 
which results in 0xffffec03. This value is 
equivalent to -5117 decimal.

** 2**10 = 
1024

Power Operator. Raise the value to the left to the 
power of the value to the right.

* 2 * 3 = 6 Multiplication.

/ 5 / 2 = 2.5 Division. Result is always a <number>. Use “INT 
(5 / 2)” if you want an <integer> result.

% 5 % 2 = 1 

5.4 % 2.1 = 
1.2

Remainder.  x % y = x – (INT (x / y) * y). In the 
examples, 5 / 2 equals 2 with a remainder of 1. 5.4 / 
2.1 equals 2 with a remainder of 1.2
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+ 2+2 = 4

"test"+ 
"data"= 
"testdata"

"test" + 8 
= "test8"

8 + "test" 
= "8test"

Addition. Add two numbers or concatenate two 
strings or concatenate a single string and a number.

- 4 - 2 = 0 Subtraction

<< 2 << 2 = 8 Left Shift the bits of an <integer>.

>> 8 >> 2 = 2 Right shift the bits of an <integer>.

& 0xE5 & 0x7F 
= 0x65

Bitwise AND operator. Valid only for <integers>.

| 0xE5 | 0x7F 
= 0xFF

Bitwise OR operator. Valid only for <integers>.

^ 0xE5 ^ 0x7F 
= 0x9A 

Bitwise XOR operator. Valid only for <integers>.

:= set var 
greeting:= 
"hello"

Assignment operator, used with the commands 
SET VAR, GET INI and GET REG. The value to 
the right of the assignment operator can have any 
data type.

= == "hello" == 
"HELLO"

10 = 2 * 5

Comparison operator, used to compare <strings> to 
other <strings> or <numbers> to other <numbers>. 
For strings, the comparison is case insensitive, so 
"hello" is equal to "Hello". Result is a 
<Boolean>.

Operator Example Description
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!= <> "hello" <> 
"world"

11 != 2.5

Inequality operator, used to compare <strings> to 
other <strings> or <numbers> to other <numbers>. 
For strings, the comparison is case insensitive. 
Gives the opposite result from = or ==. X <> Y is 
equivalent to NOT (X == Y). Result is a 
<Boolean>.

< "a" < "b"

0.5 < 1

Less than operator, used to compare <strings> to 
other <strings> or <numbers> to other <numbers>. 
For strings, the comparison is case insensitive. 
Result is a <Boolean>.

> "aba" > 
"aac"

Greater than operator, used to compare <strings> to 
other <strings> or <numbers> to other <numbers>. 
For strings, the comparison is case insensitive. 
Result is a <Boolean>.

<= "a" <= "a"

0.5 <= 1

Less than or equal operator, used to compare 
<strings> to other <strings> or <numbers> to other 
<numbers>. For strings, the comparison is case 
insensitive. Result is a <Boolean>.

>= "aaa" >= 
"aaa"

Greater than or equal operator, used to compare 
<strings> to other <strings> or <numbers> to other 
<numbers>. For strings, the comparison is case 
insensitive. Result is a <Boolean>.

NOT (NOT TRUE) 
= FALSE

Invert the value of a <Boolean> or Boolean 
expression.

AND (TRUE AND 
FALSE)= 
FALSE

A <Boolean> that is only true if both of its 
operands are true.

OR (TRUE OR 
FALSE)= 
TRUE

A <Boolean> that is true if either of its operands 
are true.

XOR (TRUE XOR 
FALSE)= 
TRUE

A <Boolean> that is only true if one of its operands 
is true and the other is false.

Operator Example Description
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Operator Precedence

The following table describes the associativity and operator precedence of the operators 
listed in the previous section. Items on the same line have equal precedence, and 
precedence decreases as you go down. Parentheses can be used around any operator to 
force evaluation in the desired order. For example, (5 + 7) * 1024 adds five and seven 
before multiplying the result by 1024. Without the parentheses, the result would be 
different.

Functions

Functions take operands that follow the function name. The operands must be enclosed in 
parenthesis, unless otherwise noted. All function names are not case-sensitive, so SQRT, 
sqrt, and sQrT are all equivalent. 

Operators Associativity
- (negation)   ~ Right to Left
** Left to Right
*   /   % Left to Right
+   - (subtraction) Left to Right
<<   >> Left to Right
& Left to Right
^ Left to Right
| Left to Right
=   ==   !=   <>   <   >   <=   >= Left to Right
NOT Right to Left
AND Left to Right
XOR Left to Right
OR Left to Right

Function
Operand 
Type Example Description

ABS <number> ABS (-3) = 3 Absolute value of operand. The 
result is never a negative 
number.
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SQRT <number> SQRT (9) = 3 Square root of operand. Operand 
must be non-negative. Result is 
always a <number>, never an 
<integer>.

INT <number> INT (6.9) = 6

INT (-6.9) = 
-6

Integer portion of a number. 
Result is always an <integer>. 
Result is obtained by truncating 
any value after the decimal 
point.

RND <number> RND (6.9) = 7

RND (-6.9) = 
-7

RND (6.1) = 6

Round number to the <integer> 
that is closest in value.

HEX <integer> HEX (43) = 
"0x0000002B"

Convert the <integer> to a 
hexadecimal <string>. Result is 
always a <string> starting with 
"0x" followed by an eight-digit 
value.

FMIN <number>, 
<number>

or

<string>, 
<string>

FMIN (3,2) = 
2

FMIN("apple",
"orange")= 
"apple"

Result is the lower <number> of 
the two <numbers> or the lesser 
<string> of two <strings>.

FMAX <number>, 
<number>

or

<string>, 
<string>

FMAX (3,2) = 
3

FMAX("apple",
"orange")= 
"orange"

Result is the higher <number> 
of the two <numbers> or greater 
of the two <strings>.

Function
Operand 
Type Example Description
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IsNumber <number> 
or <string> 
or 
<Boolean>

IsNumber 
(%var%)

Result is a Boolean. It will be 
true if input parameter has a type 
of <integer> or <number>. 
Otherwise it will be false. Note 
that IsNumber ("15") is false, 
because the value is inside of 
quotes and is therefore a string, 
not a number. If you have a 
string that you want to make into 
a number try

SET VAR NUMBER := 
<string>

Where <string> could be an 
expression that results in a string 
type. %NUMBER% will then be 
a <number>. If you have a 
number that you want to make 
into a string, use:

"" + <number>

where <number> could be a 
numerical expression or a 
variable.

StrLen <string> StrLen 
("Hello") = 5

Returns the number of 
single-byte characters in a 
string. If a string includes UTF8 
characters, the result will 
indicate the number of bytes, not 
the number of characters. Result 
is an <integer>.

Function
Operand 
Type Example Description
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EXISTS <string> EXISTS 
"c:\boot.ini"

Checks if the specified file 
exists. Result is a <Boolean>. 
Parentheses around the file 
name are optional, but it should 
be enclosed in quotes. The file 
name can use a PQAccess drive 
number instead of a drive letter. 
For example, "1:\boot.ini" 
would refer the file boot.ini on 
the first partition of the first 
disk. Use the /INFO command 
to obtain the PQAccess drive 
numbers. To be compatible with 
DOS, you can also use the word 
EXIST instead of EXISTS as the 
name of this command.

FILESIZE <string> FILESIZE 
"c:\boot.ini"

Returns the size of the specified 
file. Result is an <integer>. 
Parentheses around the file 
name are optional, but it should 
be enclosed in quotes. The file 
name can use a PQAccess drive 
number instead of a drive letter. 
For example, "1:\boot.ini" 
would refer the file BOOT.INI 
on the first partition of the first 
disk. Use the /INFO command 
to obtain the PQAccess drive 
numbers. It is an error to call 
FILESIZE on a file that does not 
exist.

DEFINED <string> DEFINED var Returns true if the specified 
variable (specified without using 
percent signs around it) has a 
value. Result is a <Boolean>.

Function
Operand 
Type Example Description
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Queries

Queries let you obtain various values related to disks and partitions and use them in 
expressions or other calculations.

Multi-Disk Queries

These functions do not take any parameters. Function names can optionally be followed 
by an empty set of parentheses to make it more obvious that this is a function call.

Example
SET VAR total_disks := GetTotalDisks()

Function
Return 
Type Description

GetTotalDisks <integer> Returns the number of disks in the 
system.

QueryLargestUnusedSize <number> Searches all disks and finds the 
partition that has the most unused 
space in it. Returns the size of this 
space in megabytes. Returns 0 if there 
are no partitions on any disk or if they 
are all completely full.

QueryLargestUnusedDisk <integer> Searches all disks and finds the 
partition that has the most unused 
space in it. Returns the number of the 
disk that contains this partition. 
Returns 0 if there are no partitions or 
they are all completely full.

QueryLargestUnallocatedSize <number> Searches all disks and finds the largest 
free space. Returns the size of this 
space in megabytes. Returns 0 if there 
are no unallocated or free spaces on 
any of the disks.

QueryLargestUnallocatedDisk <integer> Searches all disks and finds the largest 
free space. Returns the number of the 
disk that contains this free space. 
Returns 0 if there are no unallocated 
or free spaces on any of the disks.
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Disk Queries - Currently Selected Disk

These queries use the disk selected with the last SELECT DISK command. These 
functions do not take any parameters. Function names can optionally be followed by an 
empty set of parentheses.

Example
SELECT DISK 2
SET VAR disk_size := GetDiskSize() 

Function
Return 
Type Description

GetCurrentDiskNum <integer> Returns the number of the last disk 
specified when using the SELECT 
DISK command. Returns 0 if 
SELECT DISK has not been called.

GetDiskSize <number> Returns the size of the disk in 
megabytes.

GetTotalPartitions <integer> Gets the total number of partitions on 
the disk

GetAllocatedSize <number> Gets the accumulated size of all of the 
allocated partitions on the disk.

GetAllocatedPercent <number> Returns the percentage of the disk that 
is allocated. Result will be a number 
between 0 and 100.

GetTotalUnallocatedSpaces <integer> Returns the number of free spaces on 
the disk. 

GetUnallocatedSize <number> Returns the accumulated size of all of 
the free spaces on the disk.

GetUnallocatedPercent <number> Returns the percentage of the disk that 
is unallocated. Result will be a number 
between 0 and 100.
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Partition Queries

These queries use the partition selected with the last SELECT PARTITION command. 
These functions do not take any parameters. Function names can optionally be followed 
by an empty set of parentheses.

Function
Return 
Type Description

GetCurrentPartNum <integer> Returns the number of the last 
partition specified when using the 
SELECT PARTITION command. 
Returns 0 if there is not currently a 
selected partition.

GetSelectedPartitionSize <number> Returns the size of the partition in 
megabytes.

GetUsedAmount <number> Returns the size of the used space on 
the partition in megabytes.

GetUsedPercent <number> Returns the percentage of used space 
on the partition. Result will be a 
number between 0 and 100.

GetUnusedAmount <number> Returns the size of the unused space 
on the partition in megabytes.

GetUnusedPercent <number> Returns the percentage of unused 
space on the partition. Result will be a 
number between 0 and 100.

GetPartitionLabel <string> Gets the volume label of the selected 
partition. If the partition does not have 
a label, the result will be the empty 
string. If you assign this value (empty 
string) to a variable the result will be 
undefining the variable.

IsFat <Boolean> Returns true if the partition type is 
FAT16.

IsFat32 <Boolean> Returns true if the partition type is 
FAT32.
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Free Space Query

This query uses the free space selected with the last SELECT FREESPACE command. 
This function does not take any parameters. 

IsNTFS <Boolean> Returns true if the partition type is 
NTFS.

IsHPFS <Boolean> Returns true if the partition type is 
HPFS

IsLinuxExt2 <Boolean> Returns true if the partition type is 
Linux Ext2.

IsLinuxExt3 <Boolean> Returns true if the partition type is 
Linux Ext3.

IsLinuxSwap <Boolean> Returns true if the partition type is 
Linux swap.

IsActive <Boolean> Returns true if the partition is active 
(the selected boot partition for this 
disk).

IsHidden <Boolean> Returns true if the partition is hidden.

IsPrimary <Boolean> Returns true if the partition is a 
primary partition.

IsLogical <Boolean> Returns true if the partition is a logical 
partition, located within an extended 
partition.

Function
Return 
Type Description

GetCurrentFreespaceNum <integer> Returns the number of the currently 
select free space. Returns 0 is there is 
no currently selected free space.

Function
Return 
Type Description
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Disk Queries - Specified Disk

Each of these queries takes a disk number as a single argument. The disk number must be 
an <integer> and enclosed in parentheses. Specifying a non-existent disk number will 
result in an error.

Example
SET VAR disk2_size := QueryDiskSize(2) 

Function
Return 
Type Description

QueryDiskSize <number> Size of disk in megabytes.

QueryDiskNumPartitions <integer> Total number of partitions.

QueryDiskNumFreeSpaces <integer> Total number of free spaces.

QueryDiskNumPrimaries <integer> Total number of primary 
partitions (including the extended 
partition, if there is one). The 
maximum allowed number of 
primary partitions is four.

QueryDiskTotalAllocated <number> Accumulated size of all partitions 
in megabytes.

QueryDiskTotalUnallocated <number> Accumulated size of all free 
spaces in megabytes.

QueryDiskLargestUnusedSize <number> Searches all partitions and finds 
the partition that has the most 
unused space in it. Returns the 
size of this space in megabytes. 
Returns 0 if there are no 
partitions on this disk or if they 
are all completely full.

QueryDiskLargestUnusedPart <integer> Searches all partitions and finds 
the partition that has the most 
unused space in it. Returns the 
number of this partition. Returns 
0 if there are no partitions on this 
disk or if they are all completely 
full.
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Partition Queries - Specified Disk

These functions take two arguments: a disk number and a partition number. Both numbers 
must be <integers>, separated by a comma and enclosed in parentheses. Specifying a 
non-existent disk or partition will result in an error.

Example
SET VAR disk2_part3_size := QueryPartSize(2,3)

QueryDiskLargestUnallocatedSize <number> Finds the largest free space and 
returns the size of this space in 
megabytes. Returns 0 if there are 
no free spaces on this disk.

QueryDiskLargestUnallocatedFree <integer> Finds the largest free space and 
returns the number of this free 
space. Returns 0 if there are no 
free spaces on this disk.

Function
Return 
Type Description

QueryPartSize <number> Size of partition in megabytes.

QueryPartUsed <number> Size of the used space in megabytes.

QueryPartUnused <number> Size of the unused space in 
megabytes.

QueryPartType <string> Partition type as a string. The most 
common partition types are FAT, 
FAT32, NTFS, Ext2, and Ext3.

QueryPartLabel <string> Partition volume label returned as a 
string. If the partition does not have a 
label, the result will be the empty 
string. If you assign this value (empty 
string) to a variable the result will be 
undefining the variable. 

Function
Return 
Type Description
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Free Space Queries - Specified Disk and Free Space

These functions take two arguments: a disk number and a free space number. Both 
numbers must be <integers>, separated by a comma and enclosed in parentheses. 
Specifying a non-existent disk or free space will result in an error. 

QueryPartIsLogical <Boolean> True if partition is inside an extended 
partition.

QueryPartIsActive <Boolean> True if partition is the current boot 
partition on this disk.

QueryPartIsHidden <Boolean> True if the partition has a type that is 
considered hidden. Hidden partitions 
are not seen by DOS or Win9x but can 
be seen by Windows 2000 and 
Windows XP.

Function
Return 
Type Description

QueryFreeSize <number> Size of the free space in megabytes.

QueryFreeIsLogical <Boolean> True if the free space is located inside 
an extended partition.

Function
Return 
Type Description
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Scripting Commands

You can use the scripting commands explained in this section to perform common 
imaging tasks from a command line or batch file. Script file statements are not 
case-sensitive.

Each script command must be on a separate line. (Some examples in this manual wrap to a 
second line as a result of the page size of the book only.) Blank lines and lines that start 
with ";", "#", or "//" are ignored. Therefore, lines that start with these characters can be 
used for comments.

The syntax is shown for commands that have parameters. Several special characters are 
used when describing the syntax of script file statements.

[] - Denotes an optional parameter

{}- Denotes a set of parameters, any one of which can be used.

|   - Denotes a choice among two or more options

<> - Denotes a parameter type that must be replaced with an actual value of that type.

QueryFreeCanBeLogical <Boolean> True if any of the following are true:

• Free space is located inside of an 
extended partition.

• Free space is adjacent to an 
extended partition, so the 
extended partition could be 
expanded to include the 
freespace.

• There is currently no extended 
partition on the disk, and there are 
fewer than four primary partitions 
on the disk, so an extended 
partition could be created in this 
free space.

Function
Return 
Type Description



Symantec DeployCenter 157

If no syntax is shown for a command (for example, “HIDE” on page 160), it does not 
require any parameters. 

APPEND

Syntax
APPEND "<src-file>" "<dest-file>"

Appends a file to the end of an existing file. <src-file> will be appended to the end of 
<dest-file>. The <dest-file> should already exist. Both <src-file> and <dest-file> should 
be placed in quotes. The source file, destination file, or both can be on hidden partitions. 
To specify access to a hidden partition, use the PQAccess partition number displayed 
when using the /INFO command line switch for ImageCenter. The example below would 
append the file FILE.002 on Z: (probably a CD or network drive) to the end of 
\images\image.pqi located on partition 1: (the first partition on the first drive).

Example
APPEND "Z:\FILE.002" "1:\images\image.pqi"

COPY

Syntax
COPY "<src-file>" "<dest-file>"

Copies a single file, <src-file>, to the location and name specified by <dest-file>. The 
<src-file> cannot contain wildcard characters. The <dest-file> must specify a complete 
path and filename. Both <src-file> and <dest-file> should be placed in quotes. The source 
file, the destination file, or both can be on hidden partitions. To specify access to a hidden 
partition, use the PQAccess partition number displayed when using the /INFO command 
line switch to ImageCenter. The example below copies the file network.sys from Z: 
(probably a CD or network drive) to partition 1: (the first partition on the first drive).

Example
Copy "Z:\network.sys" "1:\windows\network.sys"
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CREATE

Syntax
CREATE /FS={FAT | FAT32 | NTFS | LINUXEXT2 | LINUXEXT3 | 

LINUXSWAP | EXTENDED | UNFORMATTED} [/LABEL= "<label>"] 
[/SIZE=<number>] [POSITION={BEGINNING | END}]

Creates a partition in the currently selected unallocated space. This command is useful if 
you have deployed an image to a blank machine, but the image file does not fill the entire 
hard disk. You can create a partition to make the remaining unallocated space usable. You 
must have unallocated space on the selected hard disk to create a partition on it.

This command must be contained on a single line in an actual script file.

Example
CREATE /FS=NTFS /LABEL="Data" /SIZE=5000

Parameter Description

/FS Specifies the file system for the new partition. It can be any of the 
specified strings. There may be cases where creating with a certain 
/FS would fail. For example, you cannot create an extended partition 
when one already exists.

/LABEL Assigns a label to the new partition. Replace <label> (shown above) 
with the desired volume label. Labels must be 11 characters or fewer 
and be within quotes.

/SIZE Specifies the size for the new partition in megabytes. If you do not 
use this parameter, the size of the partition will default to the size of 
the unallocated space.

/POSITION Specifies a position within the unallocated space where the partition 
will be created. If the partition fills all of the unallocated space, this 
command does not have any effect. If you do not use this parameter, 
the partition will be created at the beginning of the unallocated 
space.
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DELETE

Syntax
DELETE [{ALL | EXTENDED}]

Deletes the specified partitions. If you do not specify any parameters, this command 
deletes the last partition(s) selected.

EXPIRES

Syntax
EXPIRES <YYYY> <MM> <DD> ["<text>"]

Causes the script to expire at the beginning of the specified day. This allows IT to 
distribute a recovery CD that has a limited life, preventing a user from restoring an old 
image when they should be using a newer image. <YYYY> is a four digit year between 
1980 and 2038. <MM> is the month, 1-12 and <DD> is the day of the month, 1-31, when 
the script will expire. The year month and day should be separated by spaces, unless the 
whole date is placed within quotes, in which case a forward slash or a minus sign may be 
used as the separator. The quotes are needed to prevent division or subtraction from 
occurring on the numbers that make up the date. <text> is an optional text message that 
will be displayed to the user if the script has expired. If <text> is not supplied, a default 
message about the script being expired will be displayed. For international users, the text 
can be in UTF8 format. 

Example
Expires '2002/12/31' 'Contact IS for a current recovery CD'

GET INI

Syntax
GET INI <varname> := [[section]] <key>

Parameter Description

ALL Deletes all partitions on the currently selected drive without having 
to select them. It is not an error to call DELETE ALL on an empty 
disk.The PROTECT PARTITION command can be used to prevent 
one of the partitions on the disk from being deleted by this 
command.

EXTENDED Deletes the extended partition; the extended partition can only be 
deleted after all the logical drives within it have been deleted.
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Sets a local variable named <varname> to a value obtained from an INI file. See USE INI 
command for a description of how to specify the INI file. The [section] portion can be 
omitted if the key is located at the beginning of the INI file before the first specified 
section. However, if the [section] portion is used, it must be enclosed in square brackets. 
Spaces are required on both sides of the ":=" symbol. The example below sets the variable 
COMPNAME to the value of the of the ComputerName key in the UserData section of the 
INI file. If this section or key is not present in the INI file, then COMPUTERNAME will 
be unset. If it previously had a value, it no longer will. You can use the IF DEFINED 
<varname> command to check the variable's status.

Example
GET INI COMPNAME := [UserData] ComputerName

GET REG

Syntax
GET REG <varname> := "<regpath>"

Sets a local variable named <varname> to a value obtained from a registry file. See “USE 
REGISTRY” on page 172 for a description of how to specify the registry file. The 
<regpath> is a relative path inside of the registry and should be enclosed in quotes. 
Forward slashes must be used as the separator character within the registry key path. 
Unlike a DOS or Windows path, backslashes are not supported. Spaces are required on 
both sides of the ":=" symbol. 

Example
GET REG COMPNAME := "ControlSet001/Control/ComputerName/ 

ComputerName/ComputerName"

If the current registry file is the Windows XP System registry, the example above will set 
the variable COMPNAME to the value of the of the specified ComputerName key (You 
must specify the ComputerName three times to get to the actual key value.) If this section 
or key is not present in the INI file, then COMPUTERNAME will be unset. If it 
previously had a value, it no longer will. You can use the IF DEFINED <varname> 
command to check the variable's status.

HIDE

Hides the currently selected partition.

MERGE INI

Syntax
MERGE INI "<file2>"
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Opens the specified INI file (<file2>, for example) and merges every section and key into 
the INI file opened using the USE INI <file> command. To clarify the example, <file> is 
the file that will be modified, not <file2>. If both files contain keys with identical names in 
the same section of their respective INI files, then the values of these keys from <file2> 
will be used as the final values of these keys in the updated <file>.

Example
USE INI "1:\sysprep\sysprep.inf"
MERGE INI "z:\more.ini"

MESSAGE 

Syntax
MESSAGE [/<button> [= [GOTO] <label>]] [/<button> = ABORT] 

"<text>"

Displays the specified message, <text> to the user. 

Example
Message "There are" GetTotalDisks "drives in this machine." 

For international users, the text can be in UTF8 format. If the /NMD switch is used, then 
the user will never see the message, otherwise the <text> will be displayed in a message 
box. If no <buttons> are specified, the user must press OK to acknowledge the message. If 
one or more <buttons> are specified and the /NMD switch is not used, then the <text> will 
be displayed in a message box that also includes each of the specified buttons. The user 
must select one of the buttons before the script will continue. If multiple <buttons> are 
specified and the /NMD switch has been used, then the script will proceed as if the user 
had selected the first specified <button>.

The following are the valid buttons: YES, NO, OK, CANCEL, ABORT, RETRY, 
IGNORE, HELP, YESALL, NOALL. Each specified <button> may optionally be 
followed by an equal sign then a <label> or the word ABORT. The word GOTO may 
optionally precede the <label>. If the user selects a <button> that is followed by the word 
ABORT, then the application will abort with error #7 (User Cancel). If the user selects a 
<button> that has a <label> in its definition, then the script will proceed at the specified 
<label>. If the selected <button> does not have a <label> or ABORT command, then the 
script will continue with the next line in the script. Note that the buttons have no intrinsic 
meaning. If the user selects the CANCEL or ABORT button, the script is not 
automatically cancelled unless the action of the button is ABORT or a GOTO that causes a 
jump to a label on the last line of the script. All of the button specifications, if any, must 
occur before <text>.
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To display quotes within a message, you must use two sets of quotes in the MESSAGE 
command. For example, the following command would display a message on-screen as 
shown below. 

MESSAGE ‘To continue, click "Yes."’

Text on screen: To continue, click "Yes."

If the message you want to display is too long to fit on a single line, you can break <text> 
into multiple strings and place the word NL (meaning new line) between the strings. For 
example, MESSAGE "FIRST LINE" NL "SECOND LINE" will display a two-line 
message. 

Example

This is an example that asks the user if he would like to create a backup before deploying 
a new image. (The message text wraps in this example only to fit the page of the manual.)

SELECT DRIVE 1
MESSAGE /YES /NO=GOTO Restore "Do you want to back up your 

system before deploying the new image?"
SELECT PARTITION ALL
SET IMAGE FILENAME "n:\backup.pqi"
STORE WITH COMPRESSION HIGH
:Restore
DELETE ALL
SET IMAGE FILENAME "n:\newimage.pqi"
SELECT FREESPACE FIRST
SELECT IMAGE ALL
RESTORE

PROTECT PARTITION

Syntax
PROTECT PARTITION {FIRST | LAST | DIAGNOSTIC | UNKNOWN | 

"<volume label>" | <drive letter> | <integer>} 

Parameter Description

<integer> Protects the specified partition by number on the currently 
selected drive. Partitions are numbered in the order of their 
starting sector number on the disk, excluding any extended 
partitions or unallocated spaces. Numbering begins with 1.
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Protects the specified partition from being deleted. Only a single partition can be 
protected. It is not an error if the specified partition does not exist.

REBOOT

Reboots the computer. Any commands following this command will not be executed.

RESIZE EXTENDED

Syntax
RESIZE EXTENDED { MAX | <number>}

<drive letter> Protects the partition assigned the specified drive letter by DOS. 
Since DOS only assigns drive letters to visible FAT partitions, 
only these types of partitions can be selected using this command.

"<Volume 
label>"

Protects the first partition with the specified volume label. For 
example, SELECT PARTITION “DATA” protects the first 
partition labeled “DATA.” If more than one partition has this label 
(including FAT32, NTFS, and HPFS partitions), only the first one 
is protected.

FIRST Protects the first partition on the selected hard disk.

LAST Protects the last partition on the selected hard disk.

DIAGNOSTIC Protects a valid partition of an unknown type that is either the first 
or the last non-free space partition.

UNKNOWN Protects a single partition of an unknown type. Searches from the 
beginning of the disk until it finds a partition of unknown type.

Parameter Description

Max Resizes to the maximum size possible. The right edge of the partition 
will be flush with end of drive or next partition, if possible.

<Number> Resizes to value specified (in megabytes). The partition will be 
resized to the next smaller cylinder boundary, so it may not match the 
MB you specify exactly.

Parameter Description
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Resizes the extended partition on the selected disk to the size you specify or to the 
maximum size possible.

RESIZE IMAGE

Syntax
RESIZE IMAGE {NO | PROPORTIONAL| <number> | MAX |MOST SPACE}

Causes the RESTORE command to resize the last selected images as directed by the 
specified parameter, during the restore operation.

RESIZE PARTITION

Syntax
RESIZE PARTITION {MAX | <Number>}

Parameter Description

NO Causes the last selected image to not be resized when the 
RESTORE command is encountered.

PROPORTIONAL Proportionally resizes the last selected image when the 
RESTORE command is encountered.

<Number> Resizes the last selected image to the specified number (in MB) 
when the RESTORE command is encountered.

MAX Resizes the last selected image to the maximum size possible. If 
this is used in a situation where the partition can take up the rest 
of the drive, it will fill up the drive.

MOST SPACE Resizes the partition with the most free (unused) space.

If you choose MOST SPACE for any partition (image) within an 
image file, that partition will get the drive’s unused space, even 
if your script directs that other partitions be resized 
proportionally or to the maximum size possible. If other 
partitions are to be resized according to a value, those partitions 
will not be considered in the MOST SPACE calculations.

Parameter Description

MAX Resizes to the maximum size possible. The right edge of the partition 
will be flush with end of drive or next partition, if possible.
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Resizes the last selected primary or logical partition to the size indicated or to the 
maximum size possible.

To resize an extended partition, you should use the RESIZE EXTENDED command.

RESTORE

Downloads all selected images into the selected free space and resizes them according to 
the Resize commands, if any.

SECTOR CHECK

Syntax
SECTOR CHECK {ON | OFF}

Enables or disables bad sector checking.

SELECT DISK

Syntax
SELECT DRIVE <integer>

<Number> Resizes to value specified (in megabytes). The partition will be resized 
to the next smaller cylinder boundary, so it may not match the MB you 
specify exactly. If you enter a value that is greater than the value 
possible on the disk, the partition will be resized to the maximum size 
possible.

Parameter Description

ON Enables bad sector checking for all restore operations following the 
command. This command provides an alternative to /CBS if you need 
bad sector checking turned off for some partitions and on for others.

OFF Disables bad sector checking for all restore operations following the 
command. This command provides an alternative to /NBS if you need 
bad sector checking turned on for some partitions and off for others.

Parameter Description
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SELECT DISK <integer> (preferred method)

Selects the drive of the number or variable specified. After this command, all other 
commands refer to the selected drive until another SELECT DISK command is 
encountered.

Examples
SELECT DRIVE 1
SELECT DISK %DATA%

SELECT FREESPACE

Syntax
SELECT FREESPACE {FIRST | LAST | NEXT | PREV | LARGEST | 

<integer>}

Selects the specified unallocated space on the currently selected hard disk. When selecting 
the largest unallocated space, it does not matter whether the unallocated space is inside or 
outside of the extended partition.

SELECT IMAGE

Syntax
SELECT IMAGE {<integer> | ALL }

Selects the specified partition in an image file. This command allows you to specify 
whether to restore a single partition with an image or all partitions contained in the image.

Parameter Description

<Integer> Selects the disk of the number specified. To select the first hard 
disk on your system, you would enter SELECT DISK 1.

Parameter Description

<Integer> Selects the specified partition by number from within the current 
image file. Numbering begins with 1.

ALL Selects all partitions within the image file.
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SELECT PARTITION

Syntax
SELECT PARTITION {<integer> | <drive letter> | "<volume 

label>" | FIRST | LAST | NEXT | PREV | DIAGNOSTIC | 
UNKNOWN | ALL}

Selects the partition specified. After this command, all other commands refer to the 
selected partition until another SELECT PARTITION command is encountered. Some 
commands, such as STORE and DELETE refer to all previously selected partitions. After 
one of these commands, the list of previously selected partitions is cleared.

Parameter Description

<integer> Selects the specified partition by number on the currently selected 
drive. Partitions are numbered in the order of their starting sector 
number on the disk, excluding any extended partitions or 
unallocated spaces. Numbering begins with 1.

<drive letter> Selects the partition assigned the specified drive letter by DOS. 
Since DOS only assigns drive letters to visible FAT partitions, 
only these types of partitions can be selected using this command.

"<volume 
label>"

Selects the first partition with the specified volume label. For 
example, SELECT PARTITION “DATA” selects the first partition 
labeled “DATA.” If more than one partition has this label 
(including FAT32, NTFS, and HPFS partitions), only the first one 
is selected.

FIRST Selects the first partition on the selected hard disk.

LAST Selects the last partition on the selected hard disk.

NEXT Selects the partition immediately following the last selected 
partition regardless of the syntax used to select that partition.

PREV Selects the previously selected partition.

ALL Selects all the partitions on the currently selected hard disk.

DIAGNOSTIC Selects a valid partition of an unknown type that is either the first 
or the last partition on the disk.

UNKNOWN Selects the first valid partition of an unknown type.
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To select partitions within an image file, you should use the Select Image command. See 
“SELECT IMAGE” on page 166.

SET ACTIVE

Sets the last partition selected as the active partition (meaning it will be the boot partition). 
The last selected partition must be a primary partition.

SET DESCRIPTION

Syntax
SET DESCRIPTION "<description>"

Using this command before a STORE command will add <description> as a comment 
inside of the PQI file that is created. <description> should be enclosed by quotes.

Example
Set Description "file includes John’s changes"

SET IMAGE FILENAME

Syntax
SET IMAGE FILENAME "<file>"

Specifies an image file. Any previously specified image file will no longer be used with 
the script commands that follow. The newly specified file does not need to exist if you are 
doing a STORE command to create a new image file, but must exist if you will be reading 
from the file using a command such as RESTORE. The image filename should be 
specified in the same way that it would be specified for the /IMG command line switch. 
The name of the file should be placed in quotes.

Example
Set Image Filename "z:\myimage.pqi"

SET INI

Syntax
SET INI [[section]] <key> := <value>

Creates or modifies a setting in an INI file. The specified key in the specified section of 
the INI file will be set to the specified value. The [section] portion can be omitted if the 
key is located at the beginning of the INI file before the first specified section. However, if 
the [section] portion is used, it must be enclosed in square brackets. Spaces are required on 
both sides of the ":=" symbol. The example below sets the ComputerName key in the 
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UserData section of the INI file to the value of the COMPNAME variable. If the UserData 
section is not present in the INI file, it will be added to the end of the file. If the 
ComputerName key is not present in the UserData section of the INI file, it will be added 
to this section.

Example
SET INI [UserData] ComputerName := %COMPNAME%

SET PASSWORD

Syntax
SET PASSWORD "<password>"

Specifies the password to use when creating or restoring an image. The specified 
password replaces any previously specified password, including any password specified 
using the /PWD command line switch. This command is generally used along with the 
SET IMAGE FILENAME command to specify a new password to be used with the new 
image file. The password should be placed in quotes.

Example
SET PASSWORD "incubus"

SET REG

Syntax
SET REG "<regpath>" := <value>

Sets a registry key to the specified value. See “USE REGISTRY” on page 172 for a 
description of how to specify the registry file. The <regpath> is a relative path inside of 
the registry and should be enclosed in quotes. Forward slashes must be used as the 
separator character within the registry key path. Unlike a DOS or Windows path, 
backslashes are not supported. Spaces are required on both sides of the ":=" symbol.

For this command to work, all of the following must be true:

• The registry key must already exist.

• The new value must be of the same type as the current value.

• The new value must not take up more space than the old value.

• The key type must be REG_SZ, REG_EXPAND_SZ, REG_DWORD, 
REG_DWORD_BIG_ENDIAN or REG_BINARY.
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Note that the computer name cannot be changed simply by setting the key described in the 
example for GET REG, because the computer name is stored in numerous places in the 
registry and all locations need to be changed. Remember that modifying the registry can 
be very dangerous, even using Microsoft's tools such as regedit.

SET VAR

Syntax
SET VAR <varname> := <value>

Sets a local variable named <varname> to the specified value. Value can be a string or a 
numeric expression. If an existing variable has the specified name, its value will be 
replaced with the new value. Any variable set or modified by this command will only 
remain set until ImageCenter exits. This command cannot be used to set or modify 
environment variables that other programs in a DOS batch file can then access. Spaces are 
required on both sides of the ":=" symbol. You should not use function names, such as Get 
PartitionLabel, for the names of variables.

When you set a variable value as a string, the string must be in quotes, or the variable may 
not display correctly. For example, the following commands would display "Date is 4" 
because 12 divided by 3 is 4. 

SET VAR DATE := ’12/1/03’
MESSAGE "Date is " %DATE%

The following commands would display the "Date is 12/1/03" correctly.

SET VAR DATE := ‘12/1/03’
MESSAGE "Date is " \"%DATE%\"

To set a variable value as a string that includes quotation marks, you must use two sets of 
quotation marks in the command. For example, the following commands would display a 
message on-screen as shown below. 

SET VAR INSTRUCT := ‘To continue, click "Yes."’
MESSAGE "%INSTRUCT%"

To continue, click "Yes."
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STORE

Syntax
STORE [WITH COMPRESSION {OFF | LOW | HIGH}]

Stores selected partitions with the compression level indicated. If you do not set a 
compression parameter, the /CMP command line switch setting will be used. If /CMP is 
not set either, then the image will be created with no compression.

UNHIDE

Unhides the currently selected partition. This command is useful if you are running 
Windows NT or Windows 2000 and want to have multiple visible primary partitions. 
Without this command, ImageCenter automatically hides all but the boot partition.

USE INI

Syntax
USE INI "<file>"

Provides access to a Windows INI file. The file can be on a hidden partition not visible to 
the DOS program, such as a newly restored partition. To specify access to a hidden 
partition, use the PQAccess partition number displayed when using the /INFO command 
line switch to ImageCenter. 

Only a single USE command can be active at a time. See the “SET INI” on page 168, 
“GET INI” on page 159, and “MERGE INI” on page 160 for more information about 
reading from and writing to the specified INI file.

USE NONE

Closes any previously opened INI or registry file and flushes any modified data to disk.

Parameter Description

OFF Stores selected partitions with no compression.

LOW Stores selected partitions with low compression.

HIGH Stores selected partitions with high compression.
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USE REGISTRY

Syntax
USE REGISTRY {SOFTWARE | SYSTEM | "<file>"}

Provides access to a windows registry hive. The registry must be on the currently selected 
partition. (See “SELECT PARTITION” on page 167.) If <file> is used, it should not 
include a drive letter or PQAccess partition number, and the backslash must be used as the 
path separator. 

The SOFTWARE option is a shortcut for accessing the registry file 
"\windows\system32\config\software" or "\winnt\system32\config\software".

The option will check for the registry file in both places.

The SYSTEM option is a shortcut for accessing the registry file 
"\windows\system32\config\system" or "\winnt\system32\config\system".

The SOFTWARE and SYSTEM options load the portion of the registry that corresponds 
to the HKEY_LOCAL_MACHINE/SOFTWARE and HKEY_LOCAL_MACHINE/SYSTEM 
respectively. Therefore to access a key such as:

HKEY_LOCAL_MACHINE/SYSTEM/ControlSet001/Control/ 
ComputerName/ComputerName/ComputerName

after opening the SYSTEM registry hive, you would only specify

/ControlSet001/Control/ 
ComputerName/ComputerName/ComputerName

If the specified file is not found, an error will be returned. Use the IF EXISTS <file> 
scripting commands if there is a chance that the file is not present and you want to search 
for it in multiple locations. Note that you will need to prepend the drive letter to the 
beginning of the filename because the EXISTS command does not look for the file on the 
currently selected partition, but requires a full path.

Only a single USE command can be active at a time. See the “SET REG” on page 169 and 
“GET REG” on page 160 for more information about reading from and writing to the 
specified registry file.

USE SYSPREP

Identical to USE INI '1:\sysprep\sysprep.inf', so that the sysprep.inf file on 
the first partition on the hard disk can be modified.
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VERIFY IMAGE

Validates that the image file, specified by the /IMG command line parameter or the SET 
IMAGE FILENAME script argument, is not corrupt.

Conditional Scripting Commands

You can use the Label, IF, and GOTO commands to control the flow of your script file.

LABEL

Syntax
:<Label>

You can use the Label command together with the GOTO command for conditional script 
flow and iteration.

A Label command begins with a colon (:) in the first character of the line and is followed 
by the label name. A label can be up to 20 characters in length and cannot include spaces. 
All characters are considered significant. 

A label can be defined anywhere in a script file. You should not use function names, such 
as GetPartitionLabel, for the name of a label.

Example
:Backup

GOTO

Syntax
GOTO <label>

The Goto command transfers control to the label specified. Do not include the colon (:) 
before the label name in the Goto command. If the specified label is not found in the script 
file, an error is generated and script file processing is terminated.

Example
GOTO END
...
:END
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IF

Syntax
IF <expression> GOTO <label>

The If command evaluates the expression and if it is TRUE, it transfers control to the 
specified label. If the conditional text is true, the Goto command is executed. If the 
conditional text is false, control passes to the next line in the script.

Examples
IF IsFAT32 GOTO CONVERT
...
:CONVERT

IF GetTotalDisks() < 2 GOTO FirstDisk
...
:FirstDisk

Debugging Scripts

ImageCenter parses each script two times. During the first pass, it processes each line, in 
order, ignoring any GOTO statements. During this pass, it does not perform any of the 
specified actions; it simply makes sure that the script does not contain any syntax errors. If 
no syntax errors are found, then the actions specified by the script are performed during 
the second pass.

Because no partition changes are made during the first pass, functions such as 
QueryPartSize or GetPartitionLabel may not refer to the partitions that they would 
actually refer to when the commands are executed. Therefore, all functions that reference 
disks, partitions or freespaces return dummy values that are of the appropriate type, but 
are not the actual values. Also, local variable assignments that are made during the syntax 
check are discarded, so that variables do not have values that may represent dummy 
values, but instead must be assigned correct values during the second pass.

Parameter Description

<Expression> Any expression or statement that results in a value of TRUE 
or FALSE.

<Label> A marker you have assigned to a certain part of a script file. 
See “LABEL” on page 173.
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Syntax checking during the first pass is relaxed somewhat on lines that contain variables, 
because the values of these variables might be different when the actual script is 
evaluated, or the line may never be executed if a preceding line contains and IF DEFINED 
statement and skips the line in question if the variable is undefined.

During both passes, if a log file has been specified with the /LOG=<file> option, then each 
line is written to the log file as it is processed. During the first pass, each line is preceded 
with the text Syntax Checking-->while during the second pass each line is preceded 
with the text Running-->. Image Center also displays each of these lines in the GUI.

The line displayed may not be identical to the text in the script file. When the script parser 
reads a line from the script file, it first makes all variable substitutions and replaces all 
backslash quote characters (\) that appear in the text, not within quotes. This is the text 
that is displayed in the GUI and recorded in the log file.

Next, any mathematical or logical expressions are evaluated. If the evaluation results in 
any changes to the line, such as changing "2 + 2" into "4", then a new line is generated 
with the result. During the second pass, this new line is also output to the log file, preceded 
by the text =========>. This line is not displayed in the Image Center GUI. The 
command on this line is then executed.

If you are having a problem where the syntax check is failing and you cannot figure out 
why, you can run the script with the /SCO option (Syntax Check Only). When run with 
this option, only the syntax checking first pass of occurs. However, the line resulting from 
expression evaluation is output to the log file during the first pass rather so you can see the 
results of this expression evaluation. This allows you to see the actual text that is causing 
the syntax error. Note that any functions that the script calls, such as QueryPartSize, do not 
actually perform the action, since the partition that you want to check may not yet exist. 
Instead all of these functions return a random value typical of the type of value they would 
really return. Therefore, when you use the /SCO, do not be concerned that the results do 
not match the actual values you would expect for your machine.

For descriptions of any error codes, go to “Error Messages and Solutions” on page 228

Script File Examples

Scenario 1: To store all the partitions on drive 2 to the file, E:\IMAGES\DRIVE2.PQI:

PQIMGCTR /CMD=SCRIPT.TXT /IMG=E:\IMAGES\DRIVE2.PQI
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SCRIPT.TXT file contents:

SELECT DISK 2 
SELECT PARTITION ALL 
STORE

Scenario 2: To store partition 3 from drive 1, and partitions 1, 4, and 5 from drive 2 to the 
file, E:\IMAGES\DRIVES.PQI and have the image file split up into multiple files each 
650 MB so each can be transferred to a CD-ROM:

PQIMGCTR /CMD=SCRIPT.TXT /IMG=E:\IMAGES\DRIVES.PQI 
/MFS=650M

SCRIPT.TXT file contents:

SELECT DISK 1 
SELECT PARTITION 3 
STORE 
SELECT DISK 2 
SELECT PARTITION 1 
SELECT PARTITION 4 
SELECT PARTITION 5 
STORE

Scenario 3: To restore all the images in the file, E:\IMAGES\DRIVES.PQI, to the first 
free space on drive 2:

PQIMGCTR /CMD=SCRIPT.TXT /IMG=E:\IMAGES\DRIVES.PQI

SCRIPT.TXT file contents:

SELECT DISK 2 
SELECT FREESPACE FIRST 
SELECT IMAGE ALL 
RESTORE

Scenario 4: To restore the first two images in the file, E:\IMAGES\DRIVES.PQI, to the 
largest free space on drive 1 and resize them both proportionally:

PQIMGCTR /CMD=SCRIPT.TXT /IMG=E:\IMAGES\DRIVES.PQI

SCRIPT.TXT file contents:

SELECT DISK 1 
SELECT FREESPACE LARGEST 
SELECT IMAGE 1 
RESIZE IMAGE PROPORTIONAL 
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SELECT IMAGE 2 
RESIZE IMAGE PROPORTIONAL 
RESTORE

Scenario 5: To restore the first two images in the file, E:\IMAGES\DRIVES.PQI, to the 
last free space on drive 1 and resize them to 500 MB each. (The image was encrypted 
using the password 12345678.):

PQIMGCTR /CMD=SCRIPT.TXT /IMG=E:\IMAGES\DRIVES.PQI 
/PWD=12345678

SCRIPT.TXT file contents:

SELECT DISK 1 
SELECT FREESPACE LAST 
SELECT IMAGE 1 
RESIZE IMAGE 500 
SELECT IMAGE 2 
RESIZE IMAGE 500 
RESTORE

Scenario 6: To delete all existing partitions on drive 2 and then restore all the images in 
the file, \IMAGES\DRIVES.PQI located on the system’s CD-ROM drive, to the free space 
(the image was encrypted using the password HELLO):

PQIMGCTR /CMD=SCRIPT.TXT /IMG=\\.\PQCD0\IMAGES\DRIVES.PQI 
/PWD=HELLO

where the zero in PQCD0 is a numerical zero.

SCRIPT.TXT file contents:

SELECT DISK 2 
DELETE ALL 
SELECT FREESPACE FIRST 
SELECT IMAGE ALL 
RESTORE

Scenario 7: To restore the first four images in the file, E:\IMAGES\DRIVES.PQI, to the 
last free space on drive 1, and then resize the first image to 500 MB, keep the second the 
same size, and resize the third and fourth images to proportionally take up the remaining 
free space:

PQIMGCTR /CMD=SCRIPT.TXT /IMG=E:\IMAGES\DRIVES.PQI
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SCRIPT.TXT file contents:

SELECT DISK 1 
SELECT FREESPACE LAST 
SELECT IMAGE 1 
RESIZE IMAGE 500 
SELECT IMAGE 2 
RESIZE IMAGE NO 
SELECT IMAGE 3 
RESIZE IMAGE PROPORTIONAL 
SELECT IMAGE 4 
RESIZE IMAGE PROPORTIONAL 
RESTORE

Scenario 8: To start the ImageCenter DOS PowerCast Server, then start a PowerCast 
session named SESSION_1 and an image file named E:\ IMAGE_1.PQI:

PQPCAST /MSN=SESSION_1 /IMG=E:\IMAGE_1.PQI

To start a PowerCast client, then connect to a PowerCast session named SESSION_1 and 
restore the current image to drive 1:

PQPCAST /MSN=SESSION_1 /DSK=1

Scenario 9: To install a new operating system to every machine on the network. If a 
machine currently has an NT based operating system with an NTFS partition, restore XP. 
If a machine currently has a 9x based operating system with a FAT32 partition, restore 
ME. Many of the systems may have more than one partition. It is important that you leave 
all other partitions except the first partition intact. Restore the correct image and resize the 
partition to fill the available space. Make sure that each system has a fresh master boot 
record. The password to the image is "mysecret", the network drive letter is G:, and the 
image is NewOS.pqi. NewOS.pqi has a Windows XP, NTFS partition and a Windows Me, 
FAT32 partition.

Pqimgctr /cmd=g:\script.txt /img=g:\NewOS.pqi /rpp /wfs 
/pwd=mysecret /log=g:\log.txt

Script.txt file contents:

Select drive 1
Select partition 1
If IsNTFS Goto WindowsXP
If IsFAT32 Goto WindowsMe
MESSAGE /ABORT=GOTO END "Error Computer has unexpected 

partition type"
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:WindowsXP
Delete all
Select freespace first
Select Resize Image Max image 1
Restore
Goto End

:WindowsMe
Delete all
Select freespace first
Select Resize Image Max image 2
Restore
Goto End

:End

Scenario 10: To restore an image of two partitions to either a) a single hard disk with both 
partitions, or b) two hard disks with a partition restored to each drive:

Pqimgctr /cmd=g:\script.txt /img=g:\image.pqi

Script.txt file contents:

If GetTotalDisks<2 GOTO OneDisk
GOTO TwoDisks

:OneDisk
SELECT DISK 1
DELETE ALL
SELECT FREESPACE FIRST
SELECT IMAGE ALL
RESIZE IMAGE PROPORTIONAL
RESTORE
GOTO END

:TwoDisks
SELECT DISK 1
DELETE ALL
SELECT FREESPACE FIRST
SELECT IMAGE 1
RESIZE IMAGE MAX
RESTORE

SELECT DISK 2
DELETE ALL
SELECT FREESPACE FIRST



Chapter 10: Command Line Switches and Scripting Commands180

SELECT IMAGE 2
RESIZE IMAGE MAX
RESTORE

:END

Scenario 11: Restore an image of a Windows 2000 partition to take up 50% of the drive 
and create a second partition that is a logical NTFS partition labeled MyData on drives 
that are bigger than 10 GB, but not to restore on drives that are smaller:

Pqimgctr /cmd=script.txt /img=\\.\disk2.part2\ntfs.pqi 
/log=a:\log.txt 

Script.txt contents:

SELECT DISK 1
If GetDiskSize()>=10000 GOTO BigEnough
MESSAGE /ABORT=ABORT "Err: Computer’s Disk is too small"

:BigEnough
delete all
select freespace largest
select image 1
resize image GetDiskSize()/2
restore

select freespace largest
create /FS=extended
select freespace largest
create /FS=ntfs /label="MyData"

select drive 1
select partition 1
set active

Scenario 12: Upgrade a computer from Windows 2000 to XP, preserving the computer 
name. If the script can’t determine the computer’s previous name, it will use the value of 
the environment variable COMPNAME. If that variable is not set, it will abort without 
making changes to the computer. This script assumes that the Windows XP image has 
been SysPrep’ed.

PqImgCtr /cmd=script.txt /img=n:\winxp.pqi

Script.txt Contents:

SELECT DISK 1
SELECT PARTITION 1
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IF NOT EXISTS "1:\WINNT\System32\Config\System" GOTO 
CheckCompName

USE REGISTRY SYSTEM
GET REG OldName := ControlSet001/Control/ComputerName/ 

ComputerName/ComputerName
USE NONE
#Make sure that we were able to obtain
#the computer’s current name. Otherwise, don’t
#modify the value of COMPNAME
IF NOT DEFINED OldName GOTO CheckCompName
SET VAR CompName := %OldName%
:CheckCompName
IF DEFINED CompName GOTO Restore
MESSAGE /ABORT=ABORT "Error: Unable to determine 

appropriate Computer Name"
:Restore
DELETE ALL
SELECT IMAGE 1
RESIZE IMAGE MAX
RESTORE
USE SYSPREP
SET INI [UserData] ComputerName := %CompName%
USE NONE
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Preparation

If you are upgrading to a new hard drive, refer to “Using ImageCenter with SCSI Hard 
Disks” or “Using ImageCenter with Drive Overlay Software” on page 205 if needed.

It is strongly recommended that you perform the following steps before upgrading to a 
new hard drive or using ImageCenter to copy disk to disk.

• Create a set of ImageCenter rescue diskettes. See “Creating Rescue Diskettes under 
Windows” on page 32.

• Before running ImageCenter, use a disk utility program such as ScanDisk or Norton’s 
Disk Doctor to identify and repair any errors on your hard drive.

• Verify that the destination drive or partition is the same size or larger than the source 
drive. You can copy a partition or drive from a larger to a smaller partition or drive. 
However, there must be enough unallocated space on the smaller destination to 
accommodate the used space on the larger source.

If you are copying from one partition to another partition on the same hard disk, go 
directly to the steps outlined under “Procedure” on page 185.

IMPORTANT! If you are using ImageCenter to copy a Windows NT partition, refer to 
“ImageCenter and Windows NT/2000/XP” on page 38 for information 
about the BOOT.INI.

Setting Up a Dual Hard Disk System

1 Get the manufacturer’s installation guides for both drives.

The installation guides provide information on installing the drives, setting up the 
BIOS, and changing the jumper settings. If you do not have access to these guides, 
contact the hard drive manufacturers directly. Most drive manufacturers maintain 
sites on the Internet that offer setup information.

2 Turn off the computer’s power.

3 Discharge static electricity by touching a grounded metal object such as a metal filing 
cabinet.

IMPORTANT! Do not allow static electricity to contact the inner parts of your 
computer. Static electricity can damage or destroy your computer’s 
electronic components.

4 Remove the computer’s cover.
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5 Determine which drive you want to be master and which drive you want to be slave, 
then follow the manufacturer’s instructions to change the jumper settings on your 
hard drives accordingly.

6 Attach the interface cable and the power supply cable to the second drive.

7 Mount the second drive.

8 Start the computer and enter its Basic Input/Output System (BIOS) Setup program 
before the computer completes startup.

This is usually accomplished by pressing <DEL>, <F1>, or <F2>, according to the 
prompt that appears at the bottom of your screen during initial startup.

9 If the BIOS Setup program includes an Auto-Detect option, select it to detect both 
the master and slave drives.

If there is no Auto-Detect option, you may be required to enter the specific number of 
heads, cylinders, and megabytes of the drives. This information is usually printed on 
the drive’s outside cover. If it is not, contact the drive manufacturer.

10 If ImageCenter lists a drive size that is much smaller than its actual size, redetect the 
drive in the BIOS.

Computer BIOSs made before 1994 usually do not support the EIDE standard and 
cannot address hard drives larger than 504 MB. Hard drives larger than 504 MB 
typically include software such as OnTrack Disk Manager, Maxtor Max-Blast Disk 
Manager, or Micro House EZ-Drive which allow computers to see larger hard drives. 
Follow the destination drive manufacturer’s instructions to install any software 
included with the drive. If the size is still reported incorrectly, contact the drive 
manufacturer for assistance with the drive overlay software.

11 Save your BIOS settings and restart your computer.

Procedure

The Disk to Disk feature copies partitions directly from one place to another without 
creating an image file.

It is not necessary to format your destination partition or to partition your hard drives 
before performing a Disk to Disk copy. ImageCenter automatically performs both these 
functions.

1 At the ImageCenter main screen, click Disk To Disk.
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The Select Source Drive screen appears.

2 Select the disk or disks that include partitions you want to copy, then click Next.

At any point prior to actually copying partitions, you can click Back to change your 
settings.



Symantec DeployCenter 187

3 If there are multiple partitions on the source drive, select the source partition you wish 
to copy, or click Select All to select all partitions. Skip this step if the Select Source 
Partitions screen does not appear. 

You may need to scroll to view all the partitions in the list. The first column in the 
partition list shows the physical hard disk where the partition is located.

A check appears to the left of selected partitions. To deselect partitions, click again on 
a partition or click Select None to deselect all partitions at once.

4 Click Next.

5 Select the destination drive that includes the partitions or unallocated space where 
you want the copied partitions to be stored, then click Next.
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6 Select the destination partition or unallocated space, then click Next. 

You may need to scroll to view all the partitions in the list. If there is more than one 
hard disk, the first column in the partition list shows the physical hard disk where the 
partition is located.

IMPORTANT! To copy partitions, the destination partition or drive must have 
unallocated space equivalent to the total used space of the selected 
source partition. If you copy to a partition that already includes data, 
the existing data will be replaced.

7 If the destination partition or unallocated space is not large enough to accommodate 
the partition you wish to copy, or if you are copying the partition to a larger drive and 
want to set a specific size for the partition rather than use the proportional resize 
option, you can click Resize Source Partitions to specify a different size for the 
copied partition. If you do not want to resize the source partition, go to step 12.

8 Click Resize Source Partitions.
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The Resize Partitions window appears. 

The Selected Source Partitions group box displays the partition you selected to 
copy. The screen also displays the destination size, current size of selected partition, 
and remaining free space in the destination.

9 Click Resize. (If you do not want to make changes, click Cancel.)

10 In the New Size field, type the size for the partition (in MB), then click OK.

The size you enter must be equal to or larger than the Minimum Size and less than or 
equal to the Maximum Size displayed in the dialog.

Since partitions must end on a cylinder boundary, ImageCenter rounds the New Size 
up to the nearest cylinder boundary.

NTFS partitions require some unused space to facilitate resizing and cannot be 
resized below the master file table (MFT), so the minimum size may appear larger 
than is necessary to accommodate the data in the partition.

11 Click OK, then click Accept.

Later, when you copy the partition, ImageCenter resizes it.

12 Click Next.

If you selected an existing partition as the destination, a prompt will appear reminding 
you that the existing partition will be deleted before copying. 
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ImageCenter does not delete the partition until you click Finish on the Ready to 
Copy Disk to Disk screen.

13 If the unallocated space on the destination drive is greater than the space required to 
copy the selected partition and you did not choose to resize previously, the Resize 
Options dialog appears. Click the option you want, then click OK.

14 ImageCenter displays all the information you have entered to this point. To alter any 
settings, click Back.

15 (Optional) To set options such as disabling file system error-checking or hiding 
partitions after copy, click Advanced Options. For more information, see “Advanced 
Options” on page 191.

Copying multiple logical partitions can cause the drive letters of subsequent partitions 
to change. This may make the computer unbootable or cause applications to fail.

16 Click Finish to begin copying the selected partition.

The Copying Disk To Disk dialog tracks the progress. Upon completion, the 
following message appears: “Selected partitions copied successfully. Would you like 
to view the results?”

17 Click OK to return to the ImageCenter main screen.

If you ever want to replace the active partition with a hidden backup partition (for 
instance, if you lose data from your C: partition), run ImageCenter Disk To Disk again. 
Select the hidden partition as the source and the active partition as the destination. After 
ImageCenter completes the copying process, it prompts you to set an active partition. 
Select the newly copied partition.

Select this option: To do this:

Automatically resize 
partitions 
proportionally to fit

Allow ImageCenter to automatically expand the 
partitions in equal proportions to occupy the destination 
drive’s remaining unallocated space.

Leave remaining 
unused space

Leave any remaining unallocated space unused on the 
destination drive after the partitions are copied.

Resize partitions 
manually to fit

Display the Resize Partitions window where you can 
manually set the size of the partitions to fit in the 
destination drive’s remaining unallocated space. (See 
step 8 for additional information about the Resize 
Partition window.)



Symantec DeployCenter 191

Advanced Options

The Disk to Disk Advanced Options dialog appears when you click Advanced Options 
at the Ready To Copy Disk To Disk screen.

Select this: To do this:

Source Options

Check for File 
System Errors

Clear the Check for File System Errors check box if you want 
to disable error checking.

If you have already used a disk utility program such as 
ScanDisk to check your hard disk for errors, it is not necessary 
to have ImageCenter check for file system errors. Clearing 
Check for File System Errors saves time in copying the 
partitions. If you did not run a disk utility program before 
loading ImageCenter, leave the Check for File System Errors 
check box selected.

Disable 
SmartSector 
Copying

ImageCenter’s SmartSector technology speeds up the copying 
process by only copying clusters and sectors that contain data. 
However, in some cases, such as high-security environments, it 
may be desirable to copy all clusters and sectors in their 
original layout, whether or not they contain data.

If you wish to copy both used and unused clusters and sectors, 
click Disable SmartSector Copying. Disabling SmartSector 
copying increases processing time.

Hide Source 
Partitions After 
Copy

Hiding the source partition will ensure that your drive letters do 
not change when you reboot your computer. It can also avoid 
problems caused by having two identical operating systems 
visible when you reboot.

You can use this option to copy an operating system to a new 
disk and hide the original partitions. The new partitions will be 
active. You can set the new drive to master and the old drive to 
slave, reboot and test the new operating system with the old 
drive still in place in case something goes wrong.
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Destination Options

Skip Bad Sector 
Check

This is selected by default to save time in copying the 
partitions. Although most drives do not have bad sectors, the 
potential for problems increases during the lifetime of the hard 
drive. If you have an older hard drive, it is wise to enable 
bad-sector checking by clearing the Skip Bad Sector Check 
box.

Verify Disk Writes Click Verify Disk Writes if you want to enable DOS disk write 
verification.

Disk write verification is not critical to safely copy files. 
Enabling disk write verification can slow the copying process 
dramatically.

Hide Destination 
Partitions After 
Copy

Some operating systems only allow one primary partition to be 
visible (bootable) at a time. If you are copying a primary 
partition and you do not want to make that partition your 
bootable partition, the Hide Destination Partitions After 
Copy box should be selected.

If you are using your secondary hard drive as a complete 
backup of your primary drive, selecting Hide Destination 
Partitions After Copy preserves all the secondary drive 
information without changing any drive letters. When the 
computer boots up, a drive letter will not be assigned to the 
hidden hard drive. For additional information about hiding 
partitions, see “Hiding Partitions” on page 196.

Select this: To do this:
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Overview

The Tools drop-down menu on the ImageCenter main screen lets you manually perform 
some common partition-management tasks that ImageCenter automatically performs 
when it processes image files or when it copies partitions. The Tools menu gives you 
access to these useful features without requiring you to create or restore image files or 
copy partitions.

Displaying Drive Information

The Display Drive Information option lets you view information about the partitions on 
your current hard drive.

• Drive letters
• Volume (partition) labels
• Color-coded volume (partition) types
• Status (active or hidden partition)
• Partition size
• Used MB in partitions
• Free MB in partitions
• Primary or logical drive

To display drive information,

1 At the ImageCenter main screen, click Tools > Display Drive Information.

2 Select the drive you want to view from the Physical Drives drop-down list.

3 Select the partition from the partition list.

Drive Information Displayed on the Screen (Partition Map)

Several ImageCenter dialogs include a partition map that shows the partitions on your 
hard disk. If the selected hard disk includes logical partitions, they are shown within an 
extended partition. Partitions are color coded to indicate the file system type each uses. 
For example, dark green indicates a FAT32 partition. In addition, each partition is shaded 
to show used and unused space within the partition.

The partition map also shows unallocated space (space not assigned to any partition).
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There are triangle indicators on the partition map to mark the 2 GB boot code boundary 
and the 1024 cylinder limit. The boundary markers can help you as you restore image files 
or set a new partition active. If your operating system requires the boot code to be within 
the first 2 GB of the hard disk, for example, you can tell at a glance if the partition is 
located in a place that will make it bootable.

Creating or Resizing Partitions

You can use the Create command in an ImageCenter script to create a partition in 
unallocated space on your hard disk. For details about the Create command, see page 158.

If you do not have unallocated space on your hard disk, you can create space by deleting a 
partition with ImageCenter or resizing existing partitions with a product like Norton 
PartitionMagic. You can also use the Resize Partition command in an ImageCenter script 
file to resize partitions. See “RESIZE PARTITION” on page 164.

Creating Extended Partitions

If you create an image of a primary partition and want to restore it as a logical partition, 
you must first have an extended partition on your hard drive.

It is not necessary to manually create an extended partition when you restore an image of a 
logical partition. ImageCenter automatically creates an extended partition if one does not 
already exist.

1 At the ImageCenter main screen, click Tools > Create Extended Partition.

The Create Extended Partition window appears.
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2 Select an unallocated space from the partition list.

If there is no unallocated space on your computer, you must delete an existing 
partition to create unallocated space. 

3 Click Create.

ImageCenter creates an extended partition in the selected free space.

4 Click Close to return to the ImageCenter main screen.

Resizing Extended Partitions

You can resize an extended partition using a product like Norton PartitionMagic, or you 
can use the Resize Extended command in an ImageCenter script file. See “REBOOT” on 
page 163.

Hiding Partitions

The Hide/Unhide feature allows you to protect partitions from unwanted user access. You 
can also hide a partition to prevent having multiple visible, primary partitions on a system 
where they could make your computer unbootable. Hidden partitions are not accessible 
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because they are not assigned drive letters when you boot your computer. If you unhide a 
partition, it is assigned a drive letter the next time you boot your computer and becomes 
accessible again.

Before hiding and unhiding partitions, be aware of the following restrictions.

• Hiding or unhiding a partition can cause the drive letters of subsequent partitions to 
change. This may make the computer fail to boot or cause applications to fail.

• If your hard drive contains more than one primary partition, only one is visible by 
default. When you use the Set Active Partition feature, ImageCenter unhides the 
selected primary partition and automatically hides all other primary partitions. See 
“Setting the Active Partition” on page 200.

• Because a hidden partition is not bootable or accessible, if you hide the partition 
where ImageCenter is installed, you must re-install ImageCenter on your new active 
(bootable) partition to run it again.

To hide/unhide partitions,

1 At the ImageCenter main screen, click Tools > Hide/Unhide Partitions.

The Hide Partitions window appears. 

2 Click the partition you want to hide.



Chapter 12: Common Partition Management Tasks198

Normally when you select a visible partition, the Hide button becomes available. If 
the button is not available, the partition can’t be hidden.

3 Click Hide to hide the selected partition.

The partition status changes to “Hidden.”

Unhiding Partitions

1 Click a hidden partition. 

Normally when you select a visible partition, the Unhide button becomes available. If 
the button is not available, the partition can’t be unhidden.

2 Click Unhide to unhide the selected partition.

The partition status changes to “None.”

3 Click Close to return to the ImageCenter main screen.

4 Click Exit to exit ImageCenter.

5 Reboot your computer.

Deleting Partitions

This feature deletes existing partitions to create unallocated space on your hard drive. Be 
aware that deleting existing partitions destroys any data they contain.

1 At the ImageCenter main screen, click Tools > Delete Disk Partitions.

The Delete Partitions window appears.
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2 Click the partition you wish to delete.

You may need to scroll to view all the partitions on your machine. 

3 Click Delete, or to delete all partitions click Delete All.

The Delete Partition dialog appears. 

4 Type OK, then click OK. 
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ImageCenter deletes the partition and displays the message: “Volume <volume 
name> was deleted successfully.”

5 Click Close to return to the ImageCenter main screen.

Setting the Active Partition

The Set Active Partition feature allows you to make a primary partition the active 
(bootable) partition. Under Windows 9x, only one primary partition can be active at a 
time. To be bootable under most operating systems, a primary partition must be located on 
the first (master) drive, and it must contain an operating system. When your computer 
boots, it scans the partition table of the first drive to find the active partition, then boots 
from that partition.

WARNING! Before you set an active partition, be sure it is bootable. If it is not bootable 
or if you are not sure, locate the boot disk you created when you installed 
ImageCenter. If you restart your computer and it does not boot normally, 
you must boot from the floppy disk, run ImageCenter from the program disk 
you created during ImageCenter install, and set a different partition active. 
Refer to “Drive Information Displayed on the Screen (Partition Map)” on 
page 194 for explanations of the ImageCenter screen that may also help you 
determine if your partition is bootable.

1 At the ImageCenter main screen, click Tools > Set Active Partition.

The Set Active Partition window appears.
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2 Select a primary partition that is not currently active.

3 Click Set Active.

The status of the selected partition changes to “Active.” Other primary partitions on 
the drive are hidden. Under Windows NT or Windows 2000, if you wish to maintain 
multiple visible primary partitions, you can unhide the other primary partitions. You 
can also unhide partitions using the Unhide scripting command. See page 171.

4 Click Close.

5 Click Exit to exit ImageCenter.

6 Reboot your computer.





203

A P P E N D I XA
Additional Tasks
Editing Virtual Boot Disks

Using ImageCenter with SCSI Hard Disks

Using ImageCenter with Drive Overlay Software

Using ImageCenter on a Notebook Computer

Using ImageCenter with a Castlewood ORB Drive

Using International Keyboards

Finding Jumper Settings

Using DeployPrep
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Editing Virtual Boot Disks

You may wish to modify a virtual boot disk to include custom information. Be aware that 
Symantec cannot support customized virtual boot disks. However, you can modify the 
virtual floppy with Symantec VF Editor, which is located on the DeployCenter CD.

1 Click Start > Programs > Symantec DeployCenter 5.7 > DeployCenter 5.7 Tools 
> VF Editor. 

2 Open the virtual floppy file. 

3 Drag the file you wish to change to your desktop, then right-click it and choose Edit.

4 Make any changes you want.

5 Save the file, and exit the editor.

6 Drag the edited file back into the VF Editor window.
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7 Click Yes to overwrite the current file.

8 Exit Symantec VF Editor.

Using ImageCenter with SCSI Hard Disks

To use ImageCenter on a SCSI hard drive, you must have a SCSI controller card that 
supports software Interrupt 13. Most SCSI controller cards let the user enable software 
Interrupt 13 support in the BIOS through the card. If your SCSI controller card does not 
allow you to set it to use software Interrupt 13, ImageCenter will not work on drives 
attached to your SCSI adapter. Contact the manufacturer of the SCSI adapter to determine 
if your adapter can support software Interrupt 13. As a general rule, if FDISK can be used 
to partition the drive, you can use ImageCenter.

Using ImageCenter with Drive Overlay Software

Drive overlay software, such as Disk Manager or EZ-Drive, is needed if the system has an 
older BIOS and the disk copy is being made from IDE to IDE or IDE to SCSI. 

If copying SCSI to SCSI, the older BIOS does not come into play because SCSI has its 
own translation mechanism. 

This section provides information on both IDE and SCSI hard drive installations. The 
following are scenarios which outline, step-by-step, the installation procedures for a 
variety of system configurations.

Scenario 1
• The system has a BIOS that does not support large drives.

• The source drive is an IDE that is supported by the BIOS. It does not have a drive 
overlay program.

• The destination drive is an IDE drive that is not supported by the BIOS and needs to 
have a drive overlay program to be recognized by the older BIOS.

Steps

1 Install the destination drive as the master and the source drive as the slave and run the 
auto-detect in the BIOS.

2 Restart the computer with the drive overlay boot disk.
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3 Install the drive overlay program to the destination drive that is now set as the master 
(check with manufacturer).

4 Restart the computer again, allowing the drive overlay program to load.

5 Put your ImageCenter bootable diskette in your diskette drive (A:).

6 In the drive overlay boot menu, select the option to boot from a floppy disk.

7 Make sure that ImageCenter is showing the correct size for each drive and the correct 
order for the copy sequence.

8 Finish the copy process.

Scenario 2
• The system has a BIOS that does not support large drives.

• The source drive is an IDE drive that the BIOS does not support and a drive overlay 
program is loaded. 

• The destination is a SCSI drive and will not need a drive overlay program.

Steps

1 Leave the source drive set as the master.

2 Install the SCSI drive with the lowest SCSI ID in the SCSI chain.

3 Run the BIOS auto-detect and make sure it recognizes the IDE drive.

4 Run the SCSI BIOS to make sure the SCSI drive is recognized correctly.

5 Restart the computer and allow the drive overlay program to load. 

6 Put your ImageCenter bootable diskette in your diskette drive (A:).

7 In the drive overlay boot menu, select the option to boot from a floppy disk.

8 Make sure that ImageCenter is showing the correct size for each drive and the correct 
order for the copy sequence.

9 Finish the copy process.
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Scenario 3
• The system has a BIOS that does not support large drives.

• The source drive is an IDE drive that a drive overlay program has been loaded on.

• The BIOS has been upgraded to support larger drives.

• The destination drive is a large SCSI drive.

Steps

1 Leave the source drive set as the master.

2 Install the destination drive and set it as drive 0.

3 Run the BIOS and auto-detect the drives.

4 Make sure that LBA is off for the source drive.

5 Run the SCSI BIOS to make sure the SCSI drive is recognized correctly.

6 Restart the computer and allow the drive overlay program to load. 

7 Put your ImageCenter bootable diskette in your diskette drive (A:).

8 In the drive overlay boot menu, select the option to boot from a floppy disk.

9 Make sure that ImageCenter is showing the correct size for each drive and the correct 
order for the copy sequence.

10 Finish the copy process.

Scenario 4
• The system has a BIOS that does not support large drives.

• The source drive is an large IDE and a drive overlay program is installed.

• The BIOS has been upgraded to support larger drives.

• The destination is a Large IDE drive.

Steps

1 Set the source drive as the master.

2 Set the destination drive as the slave.
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3 Run the new BIOS and auto-detect the drives.

4 Make sure that LBA is turned on for the destination drive and off for the source drive.

5 Restart the computer and allow the drive overlay program to load. 

6 Put your ImageCenter bootable diskette in your diskette drive (A:).

7 In the drive overlay boot menu, select the option to boot from a floppy disk.

8 Make sure that ImageCenter is showing the correct size for each drive and the correct 
order for the copy sequence.

9 Finish the copy process.

Using ImageCenter on a Notebook Computer

To make PCMCIA slots on a notebook computer active for use with ImageCenter, you 
must load the correct drivers in DOS. Be aware that Symantec Technical Support does not 
support the process of setting up PCMCIA drivers in DOS.

1 Determine the correct card services DOS driver for your hardware.

The driver is supplied by the hardware manufacturer. It may be called card services, 
card-bus services, CardWare, or another name chosen by the manufacturer. Consult 
the hardware documentation or contact the manufacturer if you do not know which 
driver is required.

2 Add a statement to your CONFIG.SYS file to load the card services driver.

For example, DEVICE=PCMI80CL.SYS.

There may be additional switches to configure the device. The hardware manufacturer 
can provide detailed information.

3 Add a statement to your CONFIG.SYS file to load the NIC or SCSI driver you need.

For example, DEVICE=C:\3COM\EL589ND4.SYS.

Using ImageCenter with a Castlewood ORB Drive

To use a Castlewood ORB drive with ImageCenter, the drive must be correctly configured 
in the computer BIOS so that DOS can assign it a drive letter and read and copy large files 
to and from the drive. ImageCenter recognizes the ORB drive as removable media only if 
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the computer BIOS can be configured to recognize the drive as removable media. For 
additional information about using ImageCenter with a Castlewood ORB drive, go to 
service.symantec.com and query “ORB.”

Refer to your ORB drive owner’s manual, or contact Castlewood Systems, Inc. 
(www.castlewood.com or help@castlewood.com) for more information about 
configuring the ORB drive for use under DOS.

Using International Keyboards

When you use the ImageCenter rescue disks, you may lose the ability to use your 
keyboard the way you are accustomed to or to view extended characters properly. The 
ImageCenter rescue disks include the files you need to resolve these problems.

If you use an international keyboard or character set, you must edit the AUTOEXE2.BAT 
and CONFIG.SYS files on the rescue disks.

1 The following lines are remarked in the AUTOEXE2.BAT file. Delete the REM from 
the beginning of the line, and replace the variables xx and yyy with the keyboard 
code and character set code page for your language.

MODE CON CP PREP=((yyy)EGA.CPI)
MODE CON CP SEL=yyy
KEYB xx,yyy

xx = two-letter keyboard code (for example, US or FR)
yyy = character set code page (for example, 437)

2 Save the AUTOEXE2.BAT file.

3 The following line is remarked in the CONFIG.SYS file. Delete the REM from the 
beginning of the line, and replace the variable yyy with the character set code page 
for your language.

DEVICE=DISPLAY.SYS CON=(EGA,yyy,)

4 Save the CONFIG.SYS file.

5 Reboot from the first rescue disk.

http://www.castlewood.com
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Finding Jumper Settings

To find the jumper settings for hard disks, consult your hard disk installation guide or 
contact your hard disk manufacturer directly. In most cases, the hard disk manufacturer's 
web site will contain the information you need to install the hard disk correctly.

Another valuable resource is the web page, www.thetechpage.com. In addition to listing 
the most common hard disk manufacturers, this site provides the jumper settings for every 
hard disk ever made. Note that Symantec is not responsible for the content on this web site 
and cannot guarantee that the web site addresses will not change.

Using DeployPrep

DeployPrep is a wizard that combines the SID (Security ID) function of Microsoft's 
SysPrep (system preparation) tool with the image creation ability of Symantec 
ImageCenter to give you a complete cloning solution for deploying Windows 2000 or 
Windows XP systems throughout an enterprise.

You can run DeployPrep under Windows 2000 Professional and Windows XP. Symantec 
does not support using DeployPrep on Windows 2000 Server. Be aware that Microsoft 
does not support the use of DeployPrep.

How Does DeployPrep Work?

The DeployPrep wizard runs the Microsoft Setup Manager to help you create an “answer 
file” that is used by the SysPrep tool. (On platforms that do not have the Setup Manager, 
you must create the answer file manually using a text editor such as Notepad.) The answer 
file defines how your target machine will be set up. Depending on the answers you give, 
the setup can run unattended or with minimal input from the workstation user.

Next, you use DeployPrep to review and test your settings in the answer file. For example, 
you can test your answers to determine how automated the target setup is. If you find 
problems in the answer file, you can go back and edit the settings.

Finally, DeployPrep commits your answer file settings to SysPrep, then runs ImageCenter 
from a boot disk so you can create the source image. For additional information about 
SysPrep, see your Microsoft documentation.

Microsoft may have a version of SysPrep that is newer than the version included on your 
Windows CD. If you need new features that are included in updated versions of SysPrep, 
you should run DeployPrep, which will prompt you for the Windows CD and copy 
SysPrep to the \SysPrep folder on the same drive that contains your Windows operating 

http://www.thetechpage.com


Symantec DeployCenter 211

system. Then download the new version of SysPrep from www.microsoft.com/ 
windows2000/downloads/tools/sysprep/default.asp, and copy the new version of 
SysPrep into the SysPrep folder, overwriting the older version.

http://http://www.microsoft.com/windows2000/downloads/tools/sysprep/default.asp
http://http://www.microsoft.com/windows2000/downloads/tools/sysprep/default.asp
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A P P E N D I XB
Setting Up Removable Storage 
Devices
Using Removable Media with Network Clients

Iomega Drivers

Magneto-Optical Disk Drives

SyQuest Drivers

List of ASPI Managers and Supported Adapters

This appendix describes removable media device drivers included with DeployCenter and 
how to manually install them on a hard drive or diskette.

The DeployCenter install program installs and configures the drivers for removable 
storage devices. This information is provided for those who want to manually configure 
these drivers or alter the standard configuration.



Appendix B: Setting Up Removable Storage Devices214

Using Removable Media with Network Clients

If you are using a Jaz or Zip parallel port device with a network client, be aware that 
loading a parallel port device driver with a network client installed will cause the system 
to hang. To successfully install the device driver for the parallel drive, reboot the system 
without loading the network client.

Iomega Drivers

Iomega provides a driver loader program that allows you to load drivers from the 
AUTOEXEC.BAT file. Each time the Iomega driver program loads, it must also load an 
ASPI manager to communicate with the Zip or Jaz drive. The DeployCenter install 
program copies a large set of ASPI managers to the DRIVERS directory for SCSI, IDE, 
and Parallel Port interfaces.

The Iomega driver program tries to load each ASPI manager until it finds one that 
matches. If it does not have to use this trial-and-error process to find the correct ASPI 
manager, it can load more quickly. (If you have a non-Iomega SCSI driver, you must load 
the ASPI manager manually.)

Iomega has not provided a DOS driver for their Zip drives that attach to a USB (Universal 
Serial Bus) port. Consequently, you cannot create or restore image files to a Zip drive that 
is attached to a USB port.

You can access a document, “Using Drive Image with Iomega Removable Drivers,” at the 
Symantec support web site. Go to service.symatec.com, and query “Iomega.” This 
document is available in English only.

Editing Your GUEST.INI File

If you use only one or two specific host adapters, you may want to edit the GUEST.INI 
file and remark (using the REM command) the ASPI managers you do not need. This way 
only the ASPI managers you normally use will be loaded and tested.

1 From the DRIVERS directory where you installed ImageCenter, locate the 
GUEST.INI file and open it using Notepad in Windows, DOS EDIT, or any other 
ASCII text editor.

2 Find the ASPI manager line for the Iomega driver that supports your drive. For 
example, if you routinely use an Iomega PC1616 adapter, use the line that reads 
ASPI=ASPI1616.SYS.
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The following table lists the supported Iomega adapters and their corresponding ASPI 
managers. 

3 Add a REM at the beginning of each ASPI manager line you do not want to load.

For example, in a case where the Zip or Jaz drive is connected to an Iomega PC1616 
adapter, you would remark all ASPI manager lines except ASPI1616.SYS:
REM ASPI=ASPIPPM1.SYS /INFO FILE=NIBBLE.ILM SPEED= 1
REM ASPI=ASPIIDE.SYS /INFO
REM ASPI=ASPI8DOS.SYS /D
REM ASPI=ADVASPI.SYS
REM ASPI=ASPIPC16.SYS INFO
ASPI=ASPI1616.SYS /SCAN /INFO

4 Save the changes to the GUEST.INI file and exit the text editor. If you are using a 
word processor, be sure to save the file as ASCII or DOS text.

If you later need to use an ASPI manager which has been remarked, edit the 
GUEST.INI file again and remove the REM command at the beginning of the ASPI 
manager line.

ASPI Manager Reference

Detailed reference information on the ASPI managers used by the Iomega driver program 
is located in the electronic Installation Manual (MANUAL.EXE) on the Iomega 
installation diskette.

1 For either Windows or DOS, go to a DOS prompt, type A:, then press <Enter>.

Iomega Adapter ASPI Manager

Jaz jet PCI (PC/Mac model) ADVASPI.SYS

Jaz jet (PC-only model) ASPI8DOS.SYS

Jaz jet ISA ASPIPC16.SYS

Jaz Traveller ASPIPPM1.SYS

Parallel Port Zip drive ASPIPPM1.SYS

Zip zoom SCSI Accelerator ASPIPC16.SYS

Zip Card PCMCIA SCSI adapter ASPIPC16.SYS

Zip IDE drive ASPIIDE.SYS

PC1616 adapter ASPI1616.SYS

PC1600 adapter ASPIPC16.SYS
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2 Type MANUAL, then press <Enter>.

Assigning Specific Drive Letters for Iomega Drives

To specify the first drive letter you want the Iomega drive to use, add the LETTER= 
option to the command line. For example, if you type GUEST.EXE LETTER=G, then G 
will be assigned to the first supported drive it finds.

If you have more that one Iomega drive, each additional drive will receive a drive letter 
following G in alphabetical order. (When supporting more than one drive, drive letters are 
assigned in order of SCSI ID number, from lowest to highest.)

For more information about Iomega drives, refer to the install diskettes that came with 
your Iomega product or the Iomega web site www.iomega.com.

Magneto-Optical Disk Drives

The 3.5-inch Magneto-Optical (MO) drive is available with either a SCSI or ATAPI 
interface. Separate DOS device drivers are supplied for each interface type. The device 
driver supports the FAT (File Allocation Table) file system, read/write, and disk change 
status.

The SCSI device driver requires a SCSI host adapter card and its matching ASPI manager 
software. For more information, see the “List of ASPI Managers and Supported Adapters” 
on page 218 and your SCSI host adapter documentation.

The 3.5-inch Magneto-Optical disks are available in several capacities.

The volume format may be Super floppy, AT Hard disk, or NSR format. The driver 
automatically detects the volume format and assigns logical drive letters (such as D:). If 
no valid formats or partitions are detected, the device driver identifies the disk as 
unformatted. See the driver documentation supplied with the product for additional 
information about formatting MO disks.

Installation of Magneto-Optical Drivers

The ATAPI MO device driver is loaded in the CONFIG.SYS file using the following 
command:

DEVICE[HIGH]=(path)\MODISKAP.SYS [/P][/Ii][/Rr]

The SCSI MO device driver is loaded in the CONFIG.SYS file using the following:

DEVICE[HIGH]=(path)\ASPIXXX.SYS
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DEVICE[HIGH]=(path)\MODISK2.SYS [/P][/Ii][/Rr]

ASPIXXX.SYS represents the ASPI manager that matches your SCSI host adapter.

Optional Switches

/P

Pauses screen messages after the driver has been loaded and initialized. Press any key to 
continue the operation. Use this option to check the messages displayed by the driver.

/Ii ATAPI driver

Only the device connected to port IDE i is mounted. Otherwise, all ports are scanned MO 
devices. 

i is defined as:

1 = Primary Master
2 = Primary Slave
3 = Secondary Master
4 = Secondary Slave

/Ii SCSI driver

Only the SCSI device with ID i is mounted. Otherwise all SCSI IDs are scanned. To also 
specify the host adapter number, enter /Ih:i (h is the host adapter number and i is the 
SCSI-ID). To specify multiple devices, use the “+” character as a delimiter. For example: 
/I0:1+1:2

/Rr

Reserves the specified number of logical drive letters (r=1 to 10) for a single drive. 
Otherwise, a single drive letter is reserved. The number of reserved drive letters is 
independent of the number of disk partitions. The driver can access only as many 
partitions as the number of reserved drive letters.

If the inserted disk contains more partitions than specified by the /r option, as many drive 
letters are assigned to the disk drive as there are defined partitions. If the disk has fewer 
partitions than the number of drive letters reserved, an error occurs only when the driver 
attempts to access the additional drive letters.
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LASTDRIVE

The CONFIG.SYS last drive command does not affect the drive letter assignment in the 
MO disk drive. If the driver assigns a drive letter higher than the one specified by the 
LASTDRIVE command (default is E:), the CD drive cannot be accessed. To enable access 
to the CD drive, specify a larger value in the LASTDRIVE command.

If the following conditions exist, the device driver will not be loaded into memory and the 
message “Driver not loaded” will display.

• No ASPI manager loaded
• Cannot find MO drive (with or without a disk inserted)
• Driver already loaded

IMPORTANT! The SMARTDRV cache is turned off by default for MO disk drives. If you 
attempt to write data to a write-protected disk while the SMARTDRV 
write cache is on, you will need to reset the computer.

You can read more about Magneto-Optical disk drivers from the install diskettes that came 
with the product and from the Fujitsu web site www.fujitsu.com.

SyQuest Drivers

Symantec does not supply, configure, or support SyQuest devices or drivers with 
ImageCenter.

List of ASPI Managers and Supported Adapters

The following is a list of several popular ASPI managers and the cards they support. 
ImageCenter will use the ASPI manager you install to support your SCSI card.

ASPI8DOS.SYS

PCI Bus

Adaptec AHA-2910A/2910B
Adaptec AHA-2930A/2930B
Adaptec AHA-2940/2940AU/2940W/2940U/2940UW
Adaptec AHA-2944W/2944UW
Adaptec AHA-3940/3940U/3940W/3940UW
Adaptec AVA-2904, AVA-2902E/I
Adaptec AIC-7850/7855/7860/7870/7880 based SCSI host adapters
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Jaz jet (PC-only model)

ASPI7DOS.SYS

EISA Bus

Adaptec AHA-1740/1742/1744
Adaptec AHA-1740A/1742A
Adaptec AHA-2740/2742/2740T/2742T
Adaptec AHA-2740A/2742A/2740AT/2742AT
Adaptec AHA-2740W/2742W
Adaptec AIC-7770 based SCSI host adapters

VL BUS

Adaptec AVA-2825
Adaptec AHA-2840VL/2842VL
Adaptec AHA-2840A/2842A

ASPI4DOS.SYS

ISA Bus

Adaptec AHA-1540B/1542B
Adaptec AHA-1540C/1542C
Adaptec AHA-1540CF/1542CF
Adaptec AHA-1540CP/1542CP
Microchannel Adaptec AHA-1640

ASPI2DOS.SYS

ISA Bus

Adaptec AVA-1502P/AP
Adaptec AVA-1505
Adaptec AVA-1515
Adaptec AHA-1510/1520/1522
Adaptec AHA-1510A/1520A/1522A
Adaptec AHA-1510B/1520B/1522B
Adaptec AHA-1530P/1532P
Adaptec AVA-1502AE/AI, AVA-1505AE/AI, AVA-1505AES
Adaptec AIC-6260/6360/6370 based SCSI host adapters
Adaptec AVA-1502AE/AI, AVA-1505AE/AI, AVA-1505AES
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PCMCIA Bus

Adaptec SlimSCSI (APA-460 & APA-1425/50/50A/60/60A)

MCAM18XX.SYS

PCI Bus

Adaptec AHA-2920/2920A

MA160.SYS

If needed, add this adapter to the ASPI manager lines in your GUEST.INI or 
LDSQSCSI.BAT files.

ISA Bus

Trantor T160
Microchannel Trantor T260

MA348.SYS

If needed, add this adapter to the ASPI manager lines in your GUEST.INI or 
LDSQSCSI.BAT files.

Parallel Port Trantor MiniSCSI Plus (T348)
Adaptec MiniSCSI Plus (APA-348)

MA358.SYS 

If needed, add this adapter to the ASPI manager lines in your GUEST.INI or 
LDSQSCSI.BAT files.

Parallel Port Trantor MiniSCSI EPP (T358)
Adaptec MiniSCSI EPP (APA-358)
Adaptec MiniSCSI EPP (APA-358A)

ASPIIDE.SYS

IDE

SCSI to IDE ASPI Manager
Zip IDE drive

ASPIATAP.SYS

SCSI to ATAPI ASPI Manager
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ASPIPPM1.SYS and ASPIPPM2.SYS

SCSI to Parallel Port Zip Drivers
Jaz Traveller

ASPIEDOS.SYS

Adaptec AHA-1740/1742/1744 (in Enhanced Mode only)

ASPIPC16.SYS

PC1600 adapter Zip Zoom SCSI Accelerator
Adaptec APA-1460 and other AIC-6260/5360 based adapters
Jaz jet ISA adapter
Zip zoom SCSI Accelerator
Zip Card PCMCIA SCSI adapter

ASPI1616.SYS

PC1616 adapter and other NCR-53C406A based adapters

ASPI2930.SYS

AHA-2930 adapter
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Accessing Your CD Drive

If you need to access your CD drive from ImageCenter, you will need to add the command 
in the CONFIG.SYS file to load your CD driver. You will also need to add the command in 
the AUTOEXEC.BAT file to load the CD extensions.

1 At the DOS prompt, change to the directory of the CONFIG.SYS you want to edit. 
For example, if you are editing the CONFIG.SYS on a boot diskette, type drive: 
(where drive is the drive letter of the boot diskette), then press <Enter>.

2 Type EDIT CONFIG.SYS and press <Enter> to start the DOS Editor and retrieve 
the CONFIG.SYS file.

3 Add either the DEVICE or DEVICEHIGH command. For example, type one of the 
following:

DEVICE=[drive:][path]filename [dd-parameters]

DEVICEHIGH=[drive:][path]filename [dd-parameters]

where [drive:][path]filename specifies the location and name of the CD device driver 
and [dd-parameters] specifies any command-line information the device driver 
requires.

You may want to use DEVICEHIGH if you need to conserve conventional memory.

For more information on your device driver, consult the documentation that came 
with your CD drive.

4 Click File > Save to save the file.

5 Click File > Open and retrieve the AUTOEXEC.BAT file.

6 Add the command line MSCDEX.EXE.

7 Click File > Save to save the file.

8 Click File > Exit to exit the editor.

Bootable CD

The DeployCenter CD is bootable. If your system fails, you can boot from the CD to get a 
command prompt.
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Increasing Windows NT Server Speed

If your Windows NT server slows dramatically when running ImageCenter, the server 
may be trying to cache the whole image file in memory. With one or more clients on the 
network trying to restore images, the server fills up its RAM with the image files. With 
very little RAM left to handle further requests, the server slows down.

Microsoft suggests that you add more RAM to the server. You can also add the 
/MFS=100000000 switch to the command line when starting the ImageCenter executable. 
This limits each image file size to around 100 MB. This will help because each file is 
closed after moving to the next file, and Windows NT can reuse the memory cache. The 
Windows NT server no longer tries to cache the whole image file in memory. The 
downside is that your images will be split into many segments, making them more 
difficult to manage.

ATA66 and ATA100 Controllers

If ImageCenter runs slowly and your system has a UDMA ATA66 or ATA100 controller, 
your system may need a UCMA enabler to load from the config.sys file. Contact the 
controller manufacturer or motherboard manufacturer for details.

Resolving Check Errors

ImageCenter checks the integrity of a partition very thoroughly prior to creating an image 
file or copying a partition. These checks are substantially the same as those made by the 
operating system's CHKDSK, SCANDISK, or AUTOCHK utility.

If you receive a Check error message for any partition, after backing up your hard drive, 
run your operating system's CHKDSK program on that partition. CHKDSK usually shows 
the same problems as ImageCenter. (If you are using Windows NT CHKDSK, DO NOT 
use the /F switch on the initial run.)

Run SCANDISK if you have MS-DOS 6.x or Windows 95. 

The DOS CHKDSK program does not detect problems in Extended Attributes.

If CHKDSK (or SCANDISK) does not show the same errors that ImageCenter shows, 
contact Symantec Technical Support. If the CHKDSK (or SCANDISK) program and 
ImageCenter detect the same errors (which is usually the case), run CHKDSK with the /F 
switch to fix the problem. 
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After running CHKDSK /F, run CHKDSK without the /F switch to make sure the partition 
is free of errors.

ImageCenter also checks a partition after restoring it. If this check fails, report the 
problem to Symantec Technical Support. The problem is usually a minor file system error 
that CHKDSK /F can correct without data loss. For more extensive errors, you may need 
to restore your files from a backup copy.

Resolving Partition Table Errors

In some cases, Symantec technical support can help you fix partition table errors without 
data loss. Check with them first before proceeding to the following steps.

To resolve some partition table errors, you must create new, error-free partition tables.

1 Make sure you have no viruses. See “Partition Tables and Viruses” on page 226.

2 Back up the data on the affected partitions.

3 Delete the partitions.

4 Recreate the partitions.

5 Restore the contents of the partitions. 

Partition Tables and Viruses

If partition changes made under one operating system are not reflected under the other, 
and vice versa, it is possible that a master boot record (MBR) virus is present.

Use a virus check utility that can detect the latest viruses. If a virus is found, data loss is 
likely. If a virus is found, perform the following:

1 Before removing the virus, run ScanDisk or CHKDSK under each of the operating 
systems to evaluate the integrity of the partition. 

2 Back up the files from any partition that passes the Check operation.

3 After backing up the files from all operating systems, remove the virus.

4 Run ScanDisk or CHKDSK under each of the operating systems again.

5 Delete and recreate any partitions which fail the check. 
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6 Reinstall the operating systems.

7 Restore the backup files as necessary.

Generating Diagnostic Reports with PARTINFO

PARTINFO, a Symantec utility program included on the DeployCenter CD, generates a 
report showing the contents of your hard disk partition table. 

1 Boot the computer to DOS.

2 Change to the directory that includes PARTINFO.EXE.

3 You have several options for running PARTINFO. 

Symantec support technicians may request a report from PARTINFO to help you resolve 
any problems with Symantec ImageCenter.

Troubleshooting the PXE Server

This section addresses the following situations:

• Client machine does not prompt for network booting at start-up.

• User chooses network booting at start-up, but the client machine cannot find the PXE 
server.

• Client’s network boot shows a menu, but it is not the expected menu.

To do this: Do this:

To display partition 
information on your screen

Type PARTINFO, then press <Enter>.

To send a report directly to 
your printer

Type PARTINFO >LPT1 or PARTINFO 
>PRN, then press <Enter>.

To save the report as a text file 
on a floppy disk

Type PARTINFO >A:\PARTINFO.TXT, then 
press <Enter>.
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Client machine does not prompt for network booting at start-up.

Either the machine does not have a PXE-compliant network card, or the BIOS does not list 
network booting before booting from disk in the boot sequence. Check your hardware and 
BIOS for the correct settings.

User chooses network booting at start-up, but the client machine cannot find 
PXE Server.

This occurs if you installed the PXE server on the same machine that provides your 
network's DHCP service. This happens if you failed to tell the installation program that 
the PXE Server machine is also running DHCP; or you did, but the install program could 
not automatically adjust the DHCP configuration to make it compatible with a PXE server 
running on the same machine. To make these two services co-exist on the same machine, 
see “Installing PXE Server on the DHCP Machine” on page 110.

This problem could also occur if you told the installation program that you were installing 
the PXE server on the same machine as DHCP, but the machine did not have a DHCP 
service running. The installation would have changed PXE server’s configuration, but it 
could not change DHCP. You must adjust the PXE server’s registry setting, so it does not 
conflict with the DHCP service. See the first part of “Teaching PXE Server That it is Not 
on the DHCP Machine” on page 112.

Client’s network boot shows a menu, but it is not the expected menu.

If you have more than one PXE server on the same network, the client can choose which 
server menu to display. You should consider removing one of the servers and combining 
the menus and boot programs from one server into the other.

DHCP servers can act as PXE servers too, and clients will always choose PXE menus 
from DHCP servers first (if available) over those from non-DHCP servers. Unless you are 
intentionally using your DHCP servers’s PXE capabilities, you may want to disable them. 
See “Turning off DHCP's PXE Services” on page 110.

Error Messages and Solutions

If you encounter an error not included in this section of the manual, check Symantec’s web 
site, http://service.symantec.com.
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Miscellaneous Errors (3–38)

#3 Not enough memory 

The DOS ImageCenter executable running under DOS requires a minimum of 
400KB of memory in the first 640KB of the computer's address space 
(conventional memory) and 16 MB of total memory. 

#8 Could not allocate/deallocate DOS real mode memory 

The DOS ImageCenter executable running under DOS requires some memory in 
the first 1MB of the computer's address space. (ImageCenter uses a DOS 
extender.) If not enough memory is available, ImageCenter cannot access the 
hard drive. 

#23 Unsupported version of operating system

The operating system versions that are required to run ImageCenter are listed 
under “Symantec DeployCenter System Requirements” on page 6.

#36 DPMI Server error

ImageCenter DOS executables use a DOS extender. This error indicates a failure 
during a call made from ImageCenter through the DOS extender (to DOS or to 
the BIOS). The DOS extender may be in conflict with other programs that use 
extended memory. DOS would load the conflicting programs from your 
CONFIG.SYS or AUTOEXEC.BAT file during the normal boot sequence.
You may be able to resolve this problem by pressing <F8> while booting DOS. 
After DOS boots and starts to read the commands from your CONFIG.SYS and 
AUTOEXEC.BAT files, DOS will ask if you want to execute each command. 
When you see commands that load device drivers or TSR programs that you 
think might be conflicting with the ImageCenter DOS extender, answer N (no) to 
tell DOS not to execute that command (not to load that software into memory). 
You will often be able to find a program configuration that will enable 
ImageCenter (the DOS extender) to run without error.

Disk Access Errors (40–56)

Errors 40-56 indicate that ImageCenter cannot access your hard disk; these errors are 
often reflect hardware problems. Some problems have simple solutions; for other 
problems, the only solution is to replace the hard drive. When possible, ImageCenter 
detects errors before any changes have been made, so you can back up your data before 
replacing the hard drive.
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#45 CRC Error in Data

This error means that either the source or destination drive has physical problems. 
Often, running ScanDisk, CHKDSK, or another hard drive diagnostic utility will 
fix this problem.
If the error still occurs after you have done this, try one of the following: 

• Update to the current version of the product you are using.

• If you have two IDE hard drives on your system that are sharing the same 
cable, try putting the drives on separate cables.

• If the error is the result of a corrupt file, you can identify the affected file by 
running ImageCenter from the command line prompt using the /DBG switch 
and sending the results to a text file. When the error is reported again, the 
name of the file that was being read at the time the error occurred is written to 
the text file. Once you have identified the corrupt file, replace it with a good 
backup copy of the file if possible.

#49 Write fault 
#50 Read fault 

ImageCenter is unable to read or write from a specific sector on the hard drive. 
There are a number of possible causes of this error:

• If your PC beeps or displays a black box in the middle of the screen, virus 
protection is enabled in your computer's BIOS. Disable virus or boot sector 
protection in the BIOS.

• A virus protection application (which may be a TSR or DLL program) is in 
use. Disable the application before using ImageCenter.

• There is a bad sector on the hard drive. (This is usually the case with only older 
hard drives.) Run a thorough SCANDISK on the hard drive to perform a 
surface scan to verify the existence of bad sectors. If your drive has bad sectors, 
we recommend you replace it. You may be able to use ImageCenter, or you 
may need to back up your files using another method.

• You have set up disk mirroring with PC-Tools. Disable disk mirroring.

• Your caching controller card is not set up properly.

Partition Table Errors (100–199)

Errors in the 100-199 number range are partition table errors. For general information 
about solving this type of error, see “Resolving Partition Table Errors” on page 226.
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#100 Partition table is bad

The master boot record (MBR) can contain, at most, one extended partition, and 
each extended partition boot record (EPBR) can contain, at most, one link to 
another EPBR. This error occurs when a partition table violates the foregoing 
rule. Since any modifications ImageCenter makes may decrease the amount of 
data that is recoverable from the hard drive, ImageCenter will not recognize any 
of the hard drive's partitions. You must create new, error-free partition tables to 
resolve your problem. See “Partition Tables and Viruses” on page 226.

#104 No sectors in partition

No partition should contain zero sectors. Delete the partition before using 
ImageCenter. 

#105 Partition starts on wrong boundary
#106 Partition doesn't start with sector one

The hard-disk partition table contains erroneous values. ImageCenter expects 
FAT, NTFS, and HPFS partitions to begin and end on the boundaries used by 
FDISK. If they do not, the disk may be partially corrupted. In this circumstance, 
if ImageCenter were to make any modifications it might cause the loss of data. 
Therefore, ImageCenter will refuse to recognize any of the hard drive's partitions. 
To resolve this problem, see “Resolving Partition Table Errors” on page 226.

#107 Partition begins after end of disk

This error can occur when you are running ImageCenter on a hard drive that uses 
more than 1,024 cylinders. Under DOS, ImageCenter is restricted by the BIOS 
1,024 cylinder limit. If any partitions extend beyond the limit, ImageCenter 
cannot safely operate on the hard drive.
This error can also occur if a partition erroneously extends beyond the physical 
end of the hard drive. This may happen if the hard drive has been used on a 
different computer or with a different hard-disk controller or if BIOS settings 
have been changed. Be advised that the physical geometry of the hard drive may 
differ from the logical geometry assigned to the hard drive by the operating 
system.

#108 Partition doesn't end at end of cylinder

See error #105.

#109 Partition ends after end of disk

See error #107.
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#110 Partition table number of sectors is inconsistent

The hard-disk partition table contains two inconsistent descriptions of the number 
of sectors on the hard drive. This error is serious if both DOS and another 
operating system use the hard drive. Because DOS uses one description and other 
operating systems may use the other, data loss is likely once the partition is 
almost full. To resolve this error, see “Resolving Partition Table Errors” on page 
226.

#111 Logical partition starts outside Extended

The hard-disk partition table contains erroneous values. All logical partitions 
must be totally contained within the extended partition. To resolve this error, see 
“Resolving Partition Table Errors” on page 226.

#112 Logical partition ends outside Extended

See error #111. 

#113 Partitions overlap

The hard disk partition table contains erroneous values. If data partitions overlap, 
writing to one may destroy data in another.
If a primary partition overlaps the end of the extended partition, but does not 
overlap any logical partitions within the extended partition, the problem can be 
remedied by patching the partition table. Only qualified individuals should 
attempt this repair! An incorrect patch could destroy all data on the hard drive! 
In most instances, you should resolve the problem as explained in “Resolving 
Partition Table Errors” on page 226.

#116 Partition table Begin and Start inconsistent

The hard-disk partition table contains two inconsistent descriptions of the 
partition's starting sector. This error can occur if the operating system reports a 
hard-disk geometry that is different than the geometry in use when the partition 
table was written. Possible causes of the hard-disk geometry changing are: 

• Different operating systems (for example, DOS and Windows) report different 
hard-disk geometries.

• You boot from a diskette that loads a different driver than is loaded when you 
boot from the hard drive.

• The hard drive or controller has been changed.

• The BIOS has been upgraded.

• The BIOS LBA setting has been changed.
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• There is a partition table virus present on the hard drive.
In most instances, you should resolve the problem as explained in “Resolving 
Partition Table Errors” on page 226. You can also use a virus scanning program 
to remove any partition table virus. Data loss is possible if the number of heads or 
sectors per track has changed since you first created your partitions.

#120 The logical drive chain is incompatible

This error occurs under some OSs when logical partitions are not chained 
together in the expected order. DOS, Windows 95, and Windows NT require that 
logical partitions be chained together in ascending order. Some other operating 
systems do not require this. For example, some versions of the Linux FDISK 
utility chain logical partitions together in the order they are created.

WARNING! This error message identifies a dangerous situation; using the DOS 
FDISK in this situation can cause loss of one or more partitions. 

For solutions to this problem, see the instructions in “Resolving Partition Table 
Errors” on page 226. 
If you decide to back up your data and recreate your partitions, you may have to 
use the same partitioning program that you used to create the partitions to delete 
them.

#121 The first sector of the drive cannot be read

The first sector of the hard drive (cylinder 0, head 0, sector 1) contains the master 
boot record (MBR) and the primary partition table. ImageCenter cannot make 
changes to this hard drive because an error occurred when it read the first sector. 
See error #50 for information on resolving this error.

#122 A bad sector was found in the current or new partition area

The partition cannot be moved safely because there is a bad sector in the new or 
current partition area. When you see this error message, the move operation will 
be aborted before any corruption can occur. Try moving the partition to a 
different place. If your hard drive has bad sectors, we recommend that you 
replace the hard drive.

Check Errors (500–599)

Check errors occur when ImageCenter checks the integrity of a partition. For useful 
general information about resolving these errors, see “Resolving Check Errors” on page 
225.
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#500 Subdirectory is corrupted

This error message reveals the name of the corrupted subdirectory. Back up the 
contents of that directory and its subdirectories. You can then delete the corrupted 
subdirectory.

#501 Cross-linked files were found

ScanDisk or CHKDSK should be able to find these errors and correct them.

#506 Not enough free space on partition to shrink

Some free space (which is dependent on the hard drive's current contents) is 
required to resize a partition smaller. Delete unneeded and duplicate files in the 
partition, then attempt the operation again.

#508 As specified, the operation does not change the partition

You have entered a value that is the same as or (when rounded to the required 
cylinder boundary) rounds to the same as the partition's present value. Enter a 
larger change.

#509 A bad sector was detected in the current or new FS area

In order to perform the resize operation that you requested, ImageCenter 
attempted to expand the file system area. However, the program found a bad 
sector in the new area. Try moving the partition before you resize it. No 
corruption will occur when you encounter this error.

#510 The version of the file system is not supported

An updated version of ImageCenter is required to operate on this new version of 
the file system. Visit service.symantec.com for information about updated 
versions of ImageCenter.

NTFS Check Errors (1500–1699)

Errors 1500-1699 are NTFS-specific error messages. In this context, “attribute” does not 
mean read-only, hidden, system, and so on. Rather, “attribute” means one of a file’s data 
streams. Check errors occur when ImageCenter checks the integrity of a partition. For 
useful general information about resolving these errors, see “Resolving Check Errors” on 
page 225.

#1501 Wrong version of NTFS

The partition was created using a version of the NTFS file format that 
ImageCenter cannot work with.



Symantec DeployCenter 235

#1503 Bad NTFS cluster size

The NTFS cluster size must be 512, 1,024, 2,048, or 4,096 bytes.

#1512 Restart record mismatch

The two restart entries in the journal file are different. This may happen if 
Windows NT is not properly shut down. To fix this problem, restart Windows NT 
and shut it down using the Shut Down command.

#1516 Partition improperly dismounted

The partition dirty flag is set in a restart record in the journal file. This error may 
have been caused by a power failure or system crash while the Windows NT 
operating system was writing the partition. Reboot Windows NT and execute 
CHKDSK /F to repair the damage.

#1527 Bad update sequence number

A buffer contains mismatched update sequence numbers. This error may have 
been caused by a power failure or system crash while the Windows NT operating 
system was writing to the partition. Reboot Windows NT and execute CHKDSK 
/F to repair the damage.

#1529 Information mismatch in directory entry

A file attribute stored in a file record is different from the attribute stored in its 
directory entry. If this error is in a system file (file 0-10), Windows NT's 
CHKDSK program will not fix it, but Windows NT will rebuild the root directory 
on the partition the next time the operating system is started.

#1538 Can't find contiguous space to move

The partition does not contain enough contiguous free space to hold the new copy 
of a file that must be contiguous. You will normally encounter this error when 
you use the Resize option to resize a partition smaller.

#1539 File size mismatch

The size of a system file (file 0-10) recorded in its file record does not match 
either the size recorded in its directory entry in the root directory or the size of its 
data stream.

#1544 External attribute list in external attribute

An external file record has an external attribute list.
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#1545 File attributes out of order

The attributes in a file must appear in order of increasing numeric type.

#1546 Attribute neither resident nor nonresident

The attribute resident flag has a value other than resident or nonresident.

#1547 Wrong run limits

A run has more clusters than the difference between its highest and lowest 
cluster.

#1548 File table has fewer than 16 entries

The file table must have at least 16 entries.

#1549 File table has more than 4 billion entries

The file table must have fewer than 4 billion entries.

#1644 Bad system file sequence number

A system file has a bad sequence number. System files must have a sequence 
number from 0 to 10. A partition with this problem may pass a run of Windows 
NT's CHKDSK program, but Windows NT will not mount the partition the next 
time the operating system is started.

#1647 Error in root directory index

There is an error in the root directory's index. Running Windows NT's CHKDSK 
program will not fix this problem, but the Windows NT operating system will 
automatically rebuild the root directory on the partition the next time it is started.

#1654 File system smaller than partition

This is an informational message only that indicates there may be wasted space 
on your hard disk. However, your data is not in danger, and you do not need to do 
anything to correct the error.

Miscellaneous ImageCenter Error Messages

#1701 Disk not empty 

Used in scripting. The DELETE ALL command failed to delete all the partitions 
on the drive.

#1800 Partition not open

Attempted operation on a partition in an improperly opened image file.
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#1801 Partition not found

Did not find requested partition in image file.

#1802 Corrupt bundle

Image file header information is not valid.

#1803 Bundle read only

Attempted to delete or write to a partition in the image file which was opened in 
read-only mode.

#1804 No bitmap Image

File contains no partition bitmap.

#1805 Write failed 

Error encountered while writing image to file. This error usually occurs when 
ImageCenter runs out of space in the partition to which it is writing an image file.

#1806 Out of memory

Out of memory.

#1807 Compression

Error encountered while compressing or decompressing image file data.

#1808 Buffer too small

Buffer too small to read in partition bitmap.

#1809 No more free space

No more free space available to process remaining partitions.

#1810 Err open failed

Could not open image file.

#1811 Err read failed

Could not read from image file.

#1822 No partitions selected

This error is returned during script file execution when a partition is not selected 
before a query for partition information.
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#1830 Scripting Halted By Error

This error can be reported if, during a scripted restore, the image that is being 
restored is also open in ImageExplorer. 

#1839 Invalid Parameters at end of line

Verify that the command line parameters (switches) you used are valid. 

#1842 Button Already Specified

The script message command contains multiple references to same button. 

#1843 Script Argument Type

The argument to the script function is an invalid type.

#1844 Script Argument Invalid

The argument to the script function has an invalid value. 

#1845 Script Arguments Don’t Match

Both arguments to the script function must be of the same type. 

#1846 Script Unknown Parameter

The parameter to the script command is invalid.

#1847 Script Missing Parameter

The script command expects an additional parameter.

#1856 Cannot save image on this partition

You cannot save an image file to a partition that is included in the image file. For 
example, if you are imaging your C: and D: partitions, you cannot save the image 
to either of those partitions. If you are imaging an entire hard disk or system, you 
must either create a separate partition for the image file or save the image file to 
external media.

#1900 Err invalid drive number

The script contains an invalid drive number.

FAT Check Errors (2000–2099)

Check errors occur when ImageCenter checks the integrity of a partition. For general 
information about resolving these errors, see “Resolving Check Errors” on page 225.
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#2001 FAT copies are not identical

Run ScanDisk to fix this error. This problem may also be caused by a virus. Run 
a virus checker and remove the virus if possible.

#2005 One or more lost clusters were found

Run ScanDisk or CHKDSK to fix this error. 

#2012 Formatted FAT file system too big for partition

This error can be caused by the following circumstances:

• The number of sectors in the partition is larger than 65,536, and the 
bsHugeSects field of the boot sector (“Big total number of sectors” in Norton's 
DISKEDIT utility) shows that there are more sectors in the partition than the 
partition table shows.

• The number of sectors in the partition is less than 65,536, and the bsSects field 
of the boot sector (“Total sectors on disk” in Norton's DISKEDIT utility) 
shows that there are more sectors in the partition than the partition table shows.

This situation can result in data loss when the FAT file system tries to use space 
outside the partition that does not exist or that belongs to another partition. Since 
file data may exist outside the partition boundary, you cannot fix the problem by 
simply patching the boot sector.
To correct the error, back up all data on the partition, delete the partition, recreate 
the partition, and restore the data. Alternately, it has been reported that you can 
use Norton Disk Doctor to fix this problem.

#2013 A component of FAT geometry is bad

This error can be caused by the following circumstances:

• The number of clusters on the hard drive is greater than the FAT limits allow. 
This can result from bad values in the boot sector for the number of sectors, 
FATs, root entries, reserved sectors, and sectors per cluster.

• The number of sectors in the FAT is not large enough to hold the number of 
clusters present on the hard drive.

A qualified consultant may be able to fix the hard drive by performing simple 
patches. Alternately, you can back up the data on the partition, delete the 
partition, recreate the partition, and restore the files.
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A P P E N D I XD
Symantec Technical Support
Symantec Technical Support maintains support centers globally. Technical Support’s 
primary role is to respond to specific queries about product feature and function, 
installation, and configuration. The Technical Support group also authors content for our 
online Knowledge Base. The Technical Support group works collaboratively with the 
other functional areas within Symantec to answer your questions in a timely fashion. For 
example, the Technical Support group works with Product Engineering and Symantec 
Security Response to provide alerting services and virus definition updates.

Symantec’s maintenance offerings include the following:

• A range of support options that give you the flexibility to select the right amount of 
service for any size organization

• Telephone and Web-based support that provides rapid response and up-to-the-minute 
information

• Upgrade insurance that delivers automatic software upgrade protection

• Global support that is available 24 hours a day, 7 days a week worldwide. Support is 
provided in a variety of languages for those customers that are enrolled in the 
Platinum Support program

• Advanced features, including Technical Account Management

For information about Symantec’s Maintenance Programs, you can visit our Web site at 
the following URL:

www.symantec.com/techsupp/ent/enterprise.html 

Select your country or language under Global Support. The specific features that are 
available may vary based on the level of maintenance that was purchased and the specific 
product that you use.



Appendix D: Symantec Technical Support242

Contacting Technical Support

Customers with a current maintenance agreement may access Technical Support 
information at the following URL:

www.symantec.com/techsupp/ent/enterprise.html 

Select your region or language under Global Support.

Before contacting Technical Support, make sure you have satisfied the system 
requirements that are listed in your product documentation. Also, you should be at the 
computer on which the problem occurred, in case it is necessary to recreate the problem.

When you contact Technical Support, please have the following information available:

• Product release level

• Hardware information

• Available memory, disk space, NIC information

• Operating system

• Version and patch level

• Network topology

• Router, gateway, and IP address information

• Problem description:

• Error messages and log files

• Troubleshooting that was performed before contacting Symantec

• Recent software configuration changes and network changes

Licensing and registration

If your Symantec product requires registration or a license key, access our technical 
support Web page at the following URL:

www.symantec.com/techsupp/ent/enterprise.html. 

Select your region or language under Global Support, and then select the Licensing and 
Registration page.
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Customer service

Customer service information is available at the following URL:

www.symantec.com/techsupp/ent/enterprise.html

Select your country or language under Global Support.

Customer Service is available to assist with the following types of issues:

• Questions regarding product licensing or serialization

• Product registration updates such as address or name changes

• General product information (features, language availability, local dealers)

• Latest information about product updates and upgrades

• Information about upgrade insurance and maintenance contracts

• Information about Symantec Value License Program

• Advice about Symantec's technical support options

• Nontechnical presales questions

• Issues that are related to CD-ROMs or manuals

Maintenance agreement resources

If you want to contact Symantec regarding an existing maintenance agreement, please 
contact the maintenance agreement administration team for your region as follows:

• Asia-Pacific and Japan: contractsadmin@symantec.com

• Europe, Middle-East, and Africa: semea@symantec.com

• North America and Latin America: supportsolutions@symantec.com
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Additional enterprise services

Symantec offers a comprehensive set of services that allow you to maximize your 
investment in Symantec products and to develop your knowledge, expertise, and global 
insight, which enable you to manage your business risks proactively. Additional services 
that are available include the following:

To access more information about Enterprise Services, please visit our Web site at the 
following URL:

www.symantec.com

Select your country or language from the site index.

Symantec Early Warning 
Solutions

These solutions provide early warning of cyber attacks, 
comprehensive threat analysis, and countermeasures to 
prevent attacks before they occur.

Managed Security 
Services

These services remove the burden of managing and 
monitoring security devices and events, ensuring rapid 
response to real threats.

Consulting services Symantec Consulting Services provide on-site technical 
expertise from Symantec and its trusted partners. 
Symantec Consulting Services offer a variety of 
prepackaged and customizable options that include 
assessment, design, implementation, monitoring and 
management capabilities, each focused on establishing 
and maintaining the integrity and availability of your IT 
resources.

Educational Services These services provide a full array of technical training, 
security education, security certification, and awareness 
communication programs.
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Glossary
ATA
A standard used by hard drives to communicate with the controller ports or cards that 
allow the hard drive to interface with the computer. Before ATA, there were numerous 
incompatible methods for interfacing hard drives to computers. ATA simplifies this 
process, thus reducing the cost of developing and purchasing related hardware. ATA is the 
proper term for Integrated Drive Electronics (IDE).

ATA-2
ATA-2 is the common name for a new, enhanced IDE standard. This standard is still 
evolving and has not yet been submitted for approval as an official standard.

Batch Mode
Switches in a normally interactive program that prepare it to receive non-interactive 
command input.

BIOS (Basic Input/Output System)
The BIOS is the program code stored in a PC-compatible ROM to boot the computer and 
provide basic services such as low-level hard drive access.

Client Computer
In a PowerCast session, the computer that downloads an image file from the server and 
restores it to a destination partition or free space on its hard drive.

Cloning 
Copying a hard drive to an image file or destination disk to create an exact duplicate.

Destination
The destination hard drive is the drive that is copied to during a copy or restore operation.

Disk
A hardware device to store data. A disk contains a Master Boot Record and partitions.

EIDE (Enhanced Integrated Drive Electronics)
A marketing program that promotes certain features of ATA-2.

Extended Partition
One of the four primary partitions on a hard drive can be an extended partition. Extended 
partitions do not directly hold data; rather, you can create an unlimited number of logical 
partitions within the extended partition to store data. An extended partition cannot be the 
active partition.
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FAT File Allocation Table
File system used by DOS, Windows 95/98, NT and sometimes OS/2 to store and retrieve 
files and directories.

FAT32
FAT32 is the file system used by updated versions of Windows 95 (version 4.00.950B or 
above and Windows 98). FAT32 is an enhancement of the FAT file system and is based on 
32-bit file allocation table entries, rather than on the 16-bit entries the FAT file system 
uses. As a result, FAT32 supports much larger volumes (up to 2 terabytes).

GB (Gigabyte)
1,073,741,824 bytes.

IDE
See ATA.

Image
An image is a snapshot of a drive’s partitions that can be used to back up a system, install 
a new hard drive, or configure a new system.

Jumper 
Metal prongs and a circuit completion cap on the outside of a hard drive. You can remove, 
reposition, and then replace the cap to create various jumper settings such as Master and 
Slave.

HPFS
High Performance File System, an alternative to a FAT file system which is used by OS/2.

Interactive Mode
An operation mode where the program's responses alternate with user commands, each 
being dependent upon the other.

LBA (Logical Block Addressing)
1) In EIDE, a means of specifying sector addresses by replacing CHS values with a single 
linear 28-bit number. 2) Generically, a one-dimensional address of a hard-disk sector; 
contrast with CHS.

Linux
Linux Ext2 file system was developed for the Linux operating system (a free-ware version 
of the UNIX operating system). Linux Ext2 file system supports a maximum volume size 
of 4 terabytes.
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Logical Drive
A contiguous area inside an extended partition that can be used by the operating system to 
store and retrieve files.

Master 
The first hard drive on an IDE hard drive controller.

MB (Megabyte)
1,048,576 bytes.

Multicasting
The ability to create a session and simultaneously send an image file from the server to 
one or more networked clients.

NetBIOS
A high level Network programming interface which is supported by lower level network 
protocols such as IPX/SPX and TCP/IP.

NetWare
The Novell NetWare network operating system uses the NetWare file system, which was 
developed specifically for use by NetWare servers.

NTFS New Technology File System
An alternative to FAT and HPFS file systems used by Windows NT\2000\XP.

Partition
An uninterrupted area on a disk, defined in the Master Boot Record. Every partition 
contains a specific file system such as FAT, FAT32, HPFS, or NTFS.

PowerCasting 
see Multicasting

Primary Partition
A partition referenced in the Master Boot Record partition table. Four primary partitions 
can exist on a hard drive. One of these may be an extended partition. Only one primary 
partition on a drive may be active at time. Data and applications are often placed on a 
logical partition inside an extended partition. This enables the data to be accessed by all 
primary partitions.

Restore
Downloading an image file to a destination drive.
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Slave
The second hard drive on an IDE hard drive controller.

Script File
A series of instructions, usually in text file format, written to be passed to a program 
running in batch mode.

Server
In a PowerCast session, the computer that creates the session and sends the image file to 
one or more networked client computers.

Source
The source hard drive is the drive from which the image is made.

Spanned Image
An image file that has been created in two or more segments so that it can be placed on 
media that is smaller than the image itself.

Unallocated Space
Space on a hard disk that is not assigned to any partition.

Volume
This user guide uses the term volume interchangeably with partition.
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1810 error  65,  69
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A
accessing CD drive  224
adapters for ASPI managers  218
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copying disk to disk  191
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DOS PowerCast Server  71
restoring images  58
Windows PowerCast Server  72

arguments in script files  138
arrows displayed on partition map  194
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reference  215
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B
bad sectors, checking for  192
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batch mode

running ImageCenter in  123
scripting  138

BIOS, computers with older  205
boot code boundary  49
Boot Disk Builder

adding NICs to the network adapter list  19
consolidating NICs in the network adapter list  21
creating boot disks for PowerCasting  74
creating DOS boot disks  9
creating Unicast boot disks  86
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installing Microsoft Client files before using  10
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NetWare  11
no network  25
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PowerCast Client boot disks  73
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TCP/IP  15
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boot diskettes
creating  9
creating for PowerCasting  74
creating for Unicasting  86
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creating rescue diskettes for ImageCenter  32
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PowerCast, booting with  82
TCP/IP  15
TCP/IP, creating additional  19

boot executable program, creating  23
bootable CD  224
bootable partitions  49
booting to a network menu to run automated tasks  27

C
card-bus services, enabling for use with ImageCenter 

 208
Castlewood ORB drive  208
CD, accessing drive  224
CD-R support  40
check errors  228,  233

NTFS  234
checking for file system errors  44,  191
checking image integrity after creating an image  45
CHKDSK  225
client operations, PowerCasting  68
clients

restoring images to multiple  59
using network with parallel port devices  7

cloning Windows workstations with ImageCenter  39
command line switches  124

PowerCasting (DOS)  135
PowerCasting (Windows)  132
Unicast client  90

command line, PowerCasting from  73
common partition management tasks  193
compressing image files  42,  98
compression level  42
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configuring hardware  38
copying disk to disk  183

advanced options  191
resizing partitions  188

creating
boot disks  9
extending partitions  195
partitions  195

creating a drive letter for a backup  99
creating image files  37,  40

advanced options  44
on a network drive  34
on CD-R  40
scenarios  44
verifying image integrity  45

creating or restoring images to a network drive 
(preparation)  33

creating PowerCast boot diskettes manually  77
customer support  241

D
decreasing time needed to copy  192
deleting

image files  102
partitions  198
PXE client menu items  116

deleting MAC addresses for PXE task  119
Dell diagnostic partitions  36
deploying an image to a single machine  83
deploying image files with PXE  107
deploying Windows 2000 systems  35,  210
DeployPrep  210
device drivers, installing  7
devices, using parallel port with network  7
DHCP server

editing  111
specifying that PXE server is not the same 

machine  112
diagnostic partitions, Dell  36
diagnostic reports, generating with PARTINFO  227
disabling SmartSector copying  44,  191
disk access errors  228,  229
disk, copying  183
diskettes, creating image files on  45
disks, creating DOS boot  9
dismounting volumes  100
displaying drive information  194

DOS boot disks
creating for PowerCasting  74
integrating with the Microsoft RIS boot menu  27
NetWare  11
no network  25
TCP/IP  15

DOS drivers, loading for PCMCIA cards  208
DOS files to support NDIS drivers, obtaining  19
DOS, running ImageCenter from (using rescue 

diskettes)  32
DOS, specifying version to use for boot disk  14,  18, 

 26
downloading, see restoring image files
Drive Image File Editor

See ImageExplorer
drive letters

assigning for Iomega  216
assigning to a backup  99
not assigned when running from rescue diskettes  

32
drive overlay software  205
drivers

installing for removable devices  7
removable storage devices  213
SyQuest  218

drives
displaying information  194
older computer BIOS  205

E
editing

MAC addresses in PXE tasks  119
PXE client menu items  116
PXE service  112

editing files  93,  107
EMM386  40
errors  228

1810  69
962  174
check  233
disk access  229
FAT check  238
miscellaneous  236
partition tables  230

examples
creating image files  44
see also scenarios

executable that reboots using virtual boot disk  23
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extended partitions, creating  195

F
FAT check errors  228,  238
fifth partition (Dell)  36
File Editor

See ImageExplorer
files

managing  93,  107
restoring individual  101
viewing from within an image file  104

FireWire CD-R drives  40
formatting diskettes with Boot Disk Builder  29
free space, leave remaining  190
frequently asked questions  224
Fujitsu drivers, installing  7

G
glossary  245
GUEST.INI, edit  214

H
hard disks

jumper settings  210
SCSI  205

hardware requirements See system requirements
help, ImageCenter  7
hidden partitions, creating images on  41
hidden partitions, restoring images from  51
hiding partitions  196

after copying  192
HPFS check errors  228

I
IDE CD-R drives  40
image files

compressing  42,  98
creating  37,  40
deleting  102
hardware configurations  38
maximum size before splitting  42
restoring  47
restoring from CD  48
spanning media  43
verifying  102

ImageCenter
batch mode  123

partition management  193
preparing to run  39
running  33

ImageExplorer  93,  107
dismounting volumes with  100
mounting volumes with  99
password protection  98
preferences (options)  105
system requirements  94
verifying images with  102

ImageShield  45,  98
information, displaying for drives  194
installing

DeployCenter  6
Microsoft Client files  10
PXE server  109
PXE server on the DHCP machine  110
removable device drivers  7
see also restoring image files
uninstalling  7

international keyboards  209
Iomega drivers  214

ASPI managers  215
assigning drive letters  216
cannot see Zip drive attached to USB port  214
editing GUEST.INI  214
installing  7

J
Jaz drivers  214

cause ImageCenter to hang  214
jumper settings  210

K
KEYB.COM  209
keyboard, navigating ImageCenter from the  34
keyboards, international  209

L
laptop computers, using ImageCenter on  208
leave remaining free space  190
Linux, creating a bootable partition  50
Linux, running DeployCenter under  36
load DOS reference diskette  14,  18,  26

M
MAC address assignment (PXE)  118
MAC addresses
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assigning to virtual floppies  119
editing for PXE tasks  119
importing a list into the PXE Configuration Utility 

 120
removing  119
reordering for PXE  120

Magneto-Optical drives  216
Magneto-Optical drives, installing drivers for  7
management tasks

image files  93,  107
ImageExplorer  93,  107
partitions  193

manually resizing partitions  190
markers on partition map  194
master boot record included in images  38
maximum size for image files (before splitting)  42
MBR included in images  38
menu items, adding PXE  116
menu, PXE  115
menu, Tools  194
messages, displaying with a script  161
Microsoft Client files, installing  10
Microsoft networking files, installing for Boot Disk 

Builder  19
Microsoft RIS integration  27
MO drives  216
MO drives, installing drivers  7
mounting volumes  99
mouse, navigating ImageCenter without a  34
multicasting

see PowerCasting

N
NetWare boot disks  11
network client, using with parallel port devices  7
network drives, accessing from ImageCenter  34
network drives, creating boot disks to access  10
network pruning during PowerCasting  73
NIC drivers

for PCMCIA cards  208
PowerCasting on Token Ring network  60

NICs
adding to adapter list in Boot Disk Builder  19
consolidating in adapter list in Boot Disk Builder  

21
deleting from adapter list in Boot Disk Builder  23

notebook computers, using ImageCenter on  208

NTFS check errors  228,  234
NTFS partitions, creating images on  41
NTFS partitions, restoring images from  51
NTFSINI.EXE  39

O
ODI/MLID NIC driver, PowerCast boot disks with  

80
online help  7
operator precedence (scripting)  145
optical disk drives  216
ORB drive  208
order of MAC addresses in PXE, changing  120
overlay software on older computers  205

P
parallel port CD-R drives  40
parallel port devices, network client  7
PARTINFO program  227
partition map  194
partition table errors  230
partition table errors, resolving  226
partitions

bootable  49
common management tasks  193
creating  195
deleting  198
hiding  196
hiding after copying  192
information displayed on screen  194
making bootable (setting active)  200
resize manually  190
resizing  53,  164,  188
resizing automatically to fit available space  190
setting active  200
table errors  228

passwords
adding to image files  45,  98
entering to restore image  50

PCMCIA cards, using with ImageCenter  208
peer-to-peer networks  34
performance, improving ImageCenter  33
port devices, using with network client  7
PowerCast client, GUI  68
PowerCast server

DOS  63
Windows  66
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PowerCast TTL  72
PowerCasting  59

advanced options (DOS server)  71
advanced options (Windows server)  72
allowing for proper network pruning during 

PowerCast session  73
client operations  68
command line operation  73
command line switches (DOS)  135
command line switches (Windows)  132
creating boot disks manually  77
creating boot disks with ODI/MLID NIC driver  

80
error 1810  65,  69
NIC driver for Token Ring network  60
reducing bandwidth used by session  134,  137
restoring images to multiple clients  59
routing through Windows NT  62
running PowerCast server from DOS  63
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